ADOBE® CREATIVE CLOUD®

JAVASCRIPT TOOLS GUIDE

Al

Adobe



© 2013 Adobe Systems Incorporated. All rights reserved.
Adobe® Creative Cloud® JavaScript Tools Guide for Windows' and Macintosh’.

NOTICE: All information contained herein is the property of Adobe Systems Incorporated. No part of this publication
(whether in hardcopy or electronic form) may be reproduced or transmitted, in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written consent of Adobe Systems Incorporated.
The software described in this document is furnished under license and may only be used or copied in accordance with
the terms of such license.

This publication and the information herein is furnished AS IS, is subject to change without notice, and should not be
construed as a commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or
liability for any errors or inaccuracies, makes no warranty of any kind (express, implied, or statutory) with respect to this
publication, and expressly disclaims any and all warranties of merchantability, fitness for particular purposes, and
noninfringement of third party rights.

Any references to company names in sample templates are for demonstration purposes only and are not intended to
refer to any actual organization.

Adobe, the Adobe logo, Acrobat, After Effects, Creative Suite, Dreamweaver, Fireworks, Flash, Flex, Flex Builder, lllustrator,
InCopy, InDesign, and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

Apple, Mac, Macintosh, and Mac OS are trademarks of Apple Computer, Inc., registered in the United States and other
countries. Microsoft, and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United
States and other countries. JavaScript and all Java-related marks are trademarks or registered trademarks of Sun
Microsystems, Inc. in the United States and other countries. UNIX is a registered trademark of The Open Group.

All other trademarks are the property of their respective owners.

If this guide is distributed with software that includes an end user agreement, this guide, as well as the software
described in it, is furnished under license and may be used or copied only in accordance with the terms of such license.
Except as permitted by any such license, no part of this guide may be reproduced, stored in a retrieval system, or
transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written
permission of Adobe Systems Incorporated. Please note that the content in this guide is protected under copyright law
even if it is not distributed with software that includes an end user license agreement.

The content of this guide is furnished for informational use only, is subject to change without notice, and should not be
construed as a commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or
liability for any errors or inaccuracies that may appear in the informational content contained in this guide.

Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA.



Contents

1 Introduction .......cciiiiiiiiiiiiiieeeeeeeeeternnceccccsssccccssssssssnneees 9
EXtENAS it OV VIEW .ottt e e e e ettt et 9
EXamPle COde . .o e e e 9
Development and debugging tools ........o.viiiiiiinii i 10
Cross-platform file-system acCess . ....vvviiir e e e e 10
User-interface developmenttools ...t it 10
Interapplication communication and messaging .........couvriiiiiiiiniiinenennn.. 10
External communication ........oiiuiin i i e e e 11
External shared-library integration ..ot e 11
Additional utilities and features ............oiuiiiiiiiniiiin i 11
Scripting for specific applications ..ot e 12
1) 2= 1 10 o IR 1 o) 2 12
JavaScriptvariables ... ... e e 12

2 The ExtendScript Toolkit .......ccciiiiiiiiiiiriiieeerncsccssscsscennees 13

Configuring the ToolKit WINdOW . ..ottt e eee 13
PaNEl MENUS ..o e e 14
DOCUMENT WINAOWS .ottt ettt ettt et e et e e e e e ieaeaenans 15
Lo ] o - L3 16
DHAlOgS .ttt e 16

Y= 1=t g o T o 17
The Scripts panel and favorite script locations ...........cooiiiiiiiiiiiiiii e, 17

The SCHiPt EdItOr .ottt e e e e e et e e e e 18
Navigation @aids . ......c.iuiuin i e e 19
L@ o |1 T - [ -3 PP 22
SArChI NG N tEXt .« ottt e e e e e e e i 24
SYNEAX MAFKING .ttt et e e 26

Debugging in the TooIKit ... ..ot e i e et ettt it e e et 27
Selectingadebuggingtarget ... ....oiiiiiiiii i e e 27
The JavaScript CONSOle ... .o e e e 28
Controlling code eXeCULiON ... . ittt e e e e 29
Visual indication of execution states ..........coiiiii ittt eieinnenenas 30
Setting breakpoints ... ...o.iuie i e e e 31
Evaluation in help tips . ..o v i e e e 33
Tracking data ..ot 33
The call stack ..o e e 34

Code profiling for optimization ...t e e 35

Inspecting 0bjeCct MOdeIS ... .ot e e e e e 36

3 File System Access ......coeiiiiiiieieireinecesaceenecesascanaccsnscanss 39

Using File and Folder objects ........ooouiniiiiii i e ettt 39
SPECfYING PathS ...t e 39
UNICOE /0 .ttt e e e e e 43



File error handling .......ooiii i et e e e 43
File aCCESS BITOr MESSAGES .\ ittt ittt ettt et et ettt e e et e et et e et ieaeetanennanans 44
File- and Folder-supported encoding Names ............ouiuiuiriririiiieenenenenenenenensn 45
Additional @NCodiNgs ... ..iniiii i e e 45
o1 T o] o) =T o 47
o110 e] o) =T f o 13 4 { U Lt o) - 47
File Class Properties . .....oueui it et e et e 48
File class fUNCLIONS ... ..o e e e 48
File Object properties ... ...ouvuiuir i e e 49
File object fUNCLIONS .. .oe it e e et 51
o] To 1= g o] o) =T 56
Folder object CONStIUCTOrS ...ttt ettt e e eieens 56
Folder class Properties . .......ouiniiriiie et et et et 56
Folder class fuNCLioNS ... ... oot ettt 58
Folder 0bject properties ... ...t e e e e 59
Folder object fUNCLIONS . ... .ot ettt eea 59

User-Interface TOOIS ... vvvieitirieeeeeeeeeeeeseseeosseseasessseanasnsenees 82

Code examples for ScriptUl .. ... .o e e e e e e e 62
ScriptUl programming model . ... e 63
Creating @ WINAOW ... ou e e e e e e e e e 63
CONtaINEr ElEMENTS .ttt ettt e e e e e et e e 64
WINOW JayouUL ... e e e e e e e 64
Adding elements to CONTAINEYS ... .ttt ittt e et 65
REMOVING ElEMENTS ..ottt e e e e e e 67
TYPES OF CONTIOIS ..ottt e e e e e e e e e et 67
L0} 01 =[] -3 PN 67
User-interface CoNtrols ... ...o.iuii i ettt 68
DiSPlaying IMages ..ottt e e e e e e e 72
Creating multi-column lists . ....oo i e e 73
Promptsand alerts ..........o.ouiuiuiniiiit ittt 74
Modal dialogs . ..o e 74
Size and 10cation ObJECTS ... . oe i e 76
Size and [0Cation ObJECL LYPES ... ve vttt ettt 76
DraWing OB eCtS ..ottt e 77
ResoUrce speCifications .. ....ou. i e e e 78
USING r@SOUICE SEIINGS . . . ettt ettt e e e e ae i enenes 79
Defining behavior with event callbacks and listeners .............ccoiiiiiiiiiiiiiinnnenen.. 80
Defining event-handler callback functions .............ccooiiiiiiiiiiiiiiiiiiiian.s. 81
SIMUIAtING USEr BVENTS ..ttt e e et e et e e et eiaanans 82
Registering event listeners for windows or controls .............c.coiiiiiiiiiinin... 82
How registered event-handlersarecalled ... 84
Communicating with the Flash application......... ... i e 85
AUTOMAtIC IaYOUL . .. ettt e e 86
Default layout behavior ...... ... 87
AULOMAtIC layOUt PrOPEITIES ..o v vttt ettt ettt e e et et eaaans 87

Custom layout-manager eXample . .......ii it 95



The AutoLayoutManager algorithm ........ ..ot 97
Automatic layout reStriCtIONS ... vu vttt e e et e 98
Managing control titles ... ... i e e 98
Title alignmentand orientation ... e 929
Title character width and justification .......... ..o 101
Tl trUNCAtION ottt e e e e e 102
Margins around the title and graphicobject ............ccoi i 103
Localization in ScriptUl 0bJectS ... ..t i e e e e e 103
Variable valuesin localized strings ..........cooiuiiiiii it 104
Enabling automatic localization .............cciiiiiiiiiii i 104
SCriptUl ObJeCt rEfEIENCE .ottt e e 105
1Yol 1o { U 1 - 3 105
ScriptUl Class ProPerties .. ov i e e e e 105
ScriptUl class fUNCHIONS .. ..ot e e ettt 107
ENvironment ObJeCT ..o vt 108
(@07 301 03 Vo] o T8 'e] ] o 1= o« 1=y 00 108
WINAOW Class .ottt e e e e e e e s 110
Window class Properties . ......oiuiii i e e e e 110
Window class fUNCLIONS ... ..ot i it eaens 111
WiNAOW 0BGt . ..o e 112
Window object CONSTrUCTOr ...t e 112
Window object properties . ... ..o.vuiri i e 113
L@00] o) t= Y[ V= g o] 0] o1 =Y o {[=-J P 115
Window object funCtions . ..o e 118
Window event-handling callbacks ... 122
L@ a1 1 7e] o] o 1Tt {3 123
Control 0bject CONSIIUCTONS ... .i.tt i e et et e e e aeenes 123
Control types and creation Parameters ..........oveeenenenen oo enenenenenennnnns 124
Control 0bject ProPerties . .....vuir it e e et e e 135
Control object fuNCtioNS ... . et e e 142
Control event-handling callbacks ..........cooi i 147
DrawState OB JECt ..ttt e 148
Event handling .. ..o i e 149
UIEVENt base Class . .....vuiuini i e et 149
KeyboardEvent Object . ....o. it e e 151
MOUSEEVENT ObJECt ..\ttt ettt e 153
Keyboard state ObJeCt ... ..ottt e 155
Graphic customMization ObJECES .. ..o\ttt e e e e e 155
ScriptUIGraphics ObJECT ..o vttt e e et e 155
ScriptUIBrush 0bject ..o e e 161
SCHPtUIFONT ODJECT ..ttt e e e et et 161
ScriptUlImage object . ..o e 162
ScriptUIPath 0bject ..o e e e 162
SCriPtUIPEN 0bjeCt ...t e e 163
CUSTOM @lEeMENT Class ...ttt ettt et e e e e 163
LayoUutManager ODJECT ...ttt e 165
AutolLayoutManager object CONStIUCLOr .....o.vntn ittt eenennns 165

AutolLayoutManager object properties ..........oeeeiiininii i 165



AutolLayoutManager object funCtions .........coviiiiiiiiiii i 165

Interapplication Communication with Scripts ............cciviiieeinnee... 166

ComMmMUNICAtIONS OVEIVIEW ...ttt ettt ettt et e e et e e e i aeenns 166
Remote function calls ....... ..ot e 166
Messaging frameWorK . .. ..ot e 166
Identifying @applications . ........oouiuiiiit i e 167

Cross-DOM fUNCLIONS . ... vttt ettt e e e e e e e e eeeeeianaanas 167
Application-specific exported functions .............coiiiiiiiiiiiiiiiiiiiiia. 167
Startup folder [0Cations . ... e 168
Cross-DOM APl ref@renCe . ..ottt ettt e 168

Communicating through messages . ... ..ot et e 170
SENAING MBS AGES vttt ettt et e ettt ettt e ettt et e et 170
RECEIVING MESSAGES ..ttt ittt ettt et ettt e e 172
Handling unsolicited messages ... ...ouvuviiivine i 172
Handling responses from the message target .........covviiiiiiiiiniiiiininiiennnn. 173
Passing values between applications ............cooiiiiiiiii it 176

Messaging framework APl reference ... ...oovuvriiii i 179

BridgeTalk Class ... .oii e e 179
BridgeTalk class properties ........o.vuviviiiiiniiit ittt 180
BridgeTalk class functions ...........ouiiiiiiiiii et 181

BridgeTalk message 0bject . ....o.inini i e e e e e 185
BridgeTalk message object cONStruCtor ... .....vvviiii it i e e eana 185
BridgeTalk message object properties ...........vuviiininininiiii i iiiiiiananas 186
BridgeTalk message object callbacks ... 187
BridgeTalk message object functions ............cooviiiiiiiiii it 189

Y eI Vo g Yo = o T el T =T 190

Application and namespace SpPecifiers ......... ..ot 191
Application speCifiers ... ... e 191
NaMESPACE SPECIHTIEIS ..\ttt ettt ettt e e 193

External Communication TOOIS .....cceviiirereeeenececeeeccccccnceseness 194

Yo el ] o] ) =T PO 194
Chat server samPle . ... e e e 195
Socket Object referenCe . ... e 197

Integrating External Libraries ........ccovvviiiiiiiiiiiiiiiiccceennsnness. 200

Loading and using shared libraries ....... ..o i e e i 200
EXternalObject ObJeCt .. ..u it e e e 201
ExternalObject CONSTIUCTON .. .u ittt et e e e e e e ieaeaens 201
ExternalObject class properties ..........o.vuviiiiirnin it 202
ExternalObject class function ... ...t i e 202
ExternalObjectinstance function ...t 202
Defining entry points for direCt aCCess . .....vuvnin i e 203
Additional fUNCLIONS ... .ttt e e e e e e 203
Library initialization .........o.iuiuii it 204

Library termination .........o.ieiiini e 205



Defining entry points for indireCt aCCess ........vuinin it e 206
Shared-library function APl .. ... . i e 206

IS 01 o oo A 1 (8 (| =T3P 213

8 ExtendScript Toolsand Features .......cccciiviiecennncsccsnsccccsnseesss 216
Dollar (§) O JECt ..ttt e 216
Dollar ($) ObjJeCt PrOPEItiES . ...ttt ettt e e e 216

Dollar ($) object fUNCLIONS ... .ottt ettt e e 218
ExtendScript reflectioninterface ........ ..ot 221
Reflection 0bject . .....ouie i e 221
ReflectionInfo ObjJeCt ....ovou it e 222
Localizing EXtendSCript StNgS .. oviniet it ettt 224
Variable values in localized strings .........coiiiiiii i 224
Enabling automatic localization .......... ... 224

LOCalE NAMIES .ttt e 225

Testing 10calization ... ...o.iuii i e e e e 226

Global localize fuNCtioN ... .o ii et e e e e e e 226

User notification dialogs . ....oo.oninin i i e 227
Global alert fUNCLiON ... . . i e e e e e e 227

Global confirm function ... ... i 228

Global prompt funCtion ... ... i e 229
Specifying measurement Values .........o.iuiiitiiie ittt e et e 230
UnitValue object .. ..o 230
Converting pixel and percentagevalues ...........ccoiiiiiiiiiiii i, 231
Computing with unitvalues ... i e 232
PrePrOCESSOr AIirECHIVES .t vttt ettt et ettt et ettt et e e 233
Operator overloading . ......ouiu it e 235

9 Integrating XML into JavaScript ........ccoevtiiiiiernecceccsnccscsssnesss 237

B T €1 0 ] o)=Y o 237
Accessing XML €lements ... .ouvuiit ittt e et 238
Accessing XML attributes . ..o .vu ettt e e e 239
VieWing XML Objects . ..o i e e 239
Modifying XML elements and attributes .............coviiiiiiiiiiiiiiiiii i 240
Deleting elements and attributes ..ot i e 241
Retrieving contained elements ...... ..ot 241
Creating and acCesSiNg NAMESPACES . ..t tvt ettt ettt eet et eeneneeeaeenenns 242
Mixing XML and JavaScript .. ..onuiriii et et e 244
QI 1 O 244

XML ObjJeCt REfOIENCE ... v ettt e e e e e ettt 246
XML OOt ettt e et e e e e 246
GIobal fUNCHIONS ..o e e 254
QNAME O Lt Lttt e e e e e e 255
NamMESPACE ObJECT .ottt e e e e e e 255

10 Scripting Accessto XMP Metadata .........cceieieennnnccennccccessneeess 257

Accessing the XMP scripting APl ... .ot e e e et e et 257
Using the XMP scripting APl ... .o e e et e 258



XMPSCript 0bject refereNCE ... .o e e e e 261
XMPAIasINfo 0bjeCt . ..ot e e 262
XIMPCONSt OBDJECT .ttt e e e e e e e e e e e e 262
XM P DateTimMeE OOt . ottt ettt ettt e e e e e e e e s 265
1Y 1 T o) =T o 267
XMPFIlelnfo 0bject . ..o e e e e 271
XIMPIErator ODJECT .. e ettt e e e et e e 272
XIMPMeELa ObJCt .ottt e e e e e e e 272
XMPPacketinfo object ... ..o e 287
XIMPProperty ObjJeCt ..ottt e e e 287
XMPULIIS ODJECT . .ttt e e e e e e e 288

11 Porting GuUide ...ooiviiiiiiienniieeeroeeseeessssscesssssscssssssscsnnnnns 294



1

Introduction

JavaScript is a platform-independent scripting language that you can use to control many features and
automate many tasks in Adobe® applications. Scripting is easier to learn and use than many other kinds of
programming, and provides a convenient way of automating repetitive tasks or extending applications to
provide additional tools for other users.

» If you are new to scripting, see Adobe Creative Suite: Introduction to Scripting, which introduces basic
scripting concepts and describes different scripting languages that are available, including JavaScript.
JavaScript and other scripting languages are object-oriented, and this book also describes the basic
concepts of object-oriented programming and document object models.

» Each application that supports JavaScript also provides an application-specific Scripting Guide that
introduces the object model for that application, and reference material for the objects. This
document provides information about the JavaScript features, tools, and objects that are common to
all Adobe applications that support JavaScript.

» This document does not teach JavaScript. If you are familiar with scripting or programming in general,
but unfamiliar with JavaScript, see publicly available Web resources and documents, such as:

D> The public JavaScript standards organization web site: www.ecma-international.org

D> JavaScript: The Definitive Guide, David Flanagan, O'Reily Media Inc, 2002. ISBN 0-596-00048-0
D> JavaScript Bible, Danny Goodman, Hungry Minds Inc, 2001. ISBN 0-7645-4718-6
D> Adobe Scripting, Chandler McWilliams, Wiley Publishing, Inc., 2003. ISBN 0-7645-2455-0

NoTE: Check for updated versions of this document at Adobe Developer Center,
http://www.adobe.com/devnet/scripting.

Adobe provides an extended implementation of JavaScript, called ExtendScript, that is used by many
Adobe applications that provide a scripting interface. In addition to implementing the JavaScript
language according to the ECMA JavaScript specification, ExtendScript provides certain additional
features and utilities.

This document describes JavaScript modules, tools, utilities, and features that are available to all
JavaScript-enabled Adobe applications.

NOTE: Some modules, and features of some modules, are optional. Check the product documentation for
each application for details of which modules and features are implemented.

The Adobe ExtendScript SDK, which contains this document, also contains a set of code samples that
demonstrate how to use features of ScriptUl, interapplication communication, and external
communication. This book refers to these samples by name for illustration of concepts and techniques.

You can download the SDK from Adobe Developer Center, http://www.adobe.com/devnet/scripting/.



http://www.adobe.com/devnet/scripting/
http://www.adobe.com/devnet/scripting/
http://www.ecma-international.org
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The samples are located under the ExtendScript SDK root directory:

SDKroot/Samples/javascript/ sample scripts
SDKroot/Samples//javascript/resources/ resources, such asimage or flash files

For help in developing, debugging, and testing scripts, Adobe provides the ExtendScript Toolkit, an
interactive development and testing environment for ExtendScript, which is installed with all
JavaScript-enabled applications. For complete details, see Chapter 2, “The ExtendScript Toolkit.”

ExtendScript also provides global objects that support development and debugging:
» Aglobal debugging object, the Dollar ($) object.

» Areporting utility for ExtendScript elements, the ExtendScript reflection interface.

For complete details, see Chapter 8, “ExtendScript Tools and Features.”

Adobe ExtendScript defines File and Folder classes that simplify cross-platform file-system access. These
classes are available to all applications that support a JavaScript interface.

For complete details, see Chapter 3, “File System Access.”

Adobe provides the ScriptUl module, which works with the ExtendScript JavaScript interpreter to provide
JavaScript scripts with the ability to create and interact with user interface elements. It provides an object
model for windows and user-interface control elements within an Adobe application. For complete details,
see Chapter 4, “User-Interface Tools.”

In addition, ExtendScript provides:

» Global functions for localization of display strings; see “Localizing ExtendScript strings” on page 224

» Global functions for displaying short messages in dialog boxes; see “User notification dialogs” on
page 227.

» An object type for specifying measurement values together with their units; see “Specifying
measurement values” on page 230.

ExtendScript provides a common scripting environment for all Adobe JavaScript-enabled applications,
and allows interapplication communication through scripts.

Different levels of communication are provided through the cross-DOM and the messaging framework.

» Cross-DOM functions are a limited set of basic functions common across all message-enabled
applications, which allow your script to, for example, open or print files in other applications, simply by
calling the open or print function for that application.
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>

In addition to the basic set of common functions, some applications provide more extensive sets of
exported JavaScript functions to other applications.

The interapplication messaging framework is an application programming interface (API) that allows

extensive control over communication between applications. The API allows you to send messages to
other applications and receive results, and to receive messages sent by other applications and return
results. Typically the data passed between applications are JavaScript scripts. However, the messaging
framework is extensible. It allows you to define different types of data to send between applications,

and to specify how they are handled.

For complete details, see Chapter 5, “Interapplication Communication with Scripts.”

ExtendScript offers tools for communicating with other computers or the internet using standard
protocols. The Socket object supports low-level TCP connections.

For complete details, see Chapter 6, “External Communication Tools.”

You can extend the JavaScript DOM for an application by writing a C or C++ shared library, compiling it for
the platform you are using, and loading it into JavaScript as an Externalobject instance. A shared library
is implemented by a DLL in Windows, a bundle or framework in Mac OS, or a SharedObject in UNIX.

For complete details, see Chapter 7, “Integrating External Libraries.”

ExtendScript provides these utilities and features:

>

JavaScript language enhancements:

D> Tools for combining scripts, such as a #include directive. See “Preprocessor directives” on
page 233.

D> Support for extending or overriding math and logical operator behavior on a class-by-class basis.
See “"Operator overloading” on page 235.

For complete details, see Chapter 8, “ExtendScript Tools and Features.”

JavaScript compilation, through the ExtendScript Toolkit. See Chapter 2, “The ExtendScript Toolkit.

XML integration: ExtendScript defines the xmL object, which allows you to process XML with your
JavaScript scripts. For complete details, see Chapter 9, “Integrating XML into JavaScript.”

Scripting support for XMP metadata manipulation: XMPScript provides a JavaScript API for the Adobe
XMP Toolkit. For complete details, see Chapter 10, “Scripting Access to XMP Metadata.”
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On startup, all Adobe JavaScript-enabled applications execute JSX files that they find in their startup
directories; some of these are installed by applications, and some can be installed by scripters. The policies
of different applications vary as to the locations, write access, and loading order.

In addition, individual applications may look for application-specific scripts in particular directories, which
may be configurable. Some applications allow access to scripts from menus; all of them allow you to load
and run scripts using the ExtendScript Toolkit.

For details of how to load and run scripts for any individual application, see the JavaScript Scripting Guide
for that application.

A scriptin a startup directory might be executed on startup by multiple applications. If you place a script in
such a directory, it must contain code to check whether it is being run by the intended application. You can
do this using the appName static property of the BridgeTalk class. For example:

if ( BridgeTalk.appName == "bridge" ) {
//continue executing script
}

If a script that is run by one application will communicate with another application or add functionality
that depends on another application, it must first check whether that application/version is installed. You
can do this using the BridgeTalk.getSpecifier () static function. For example:

if ( BridgeTalk.appName == "bridge-2.0" ) {
// Check to see that Photoshop is installed.
if ( BridgeTalk.getSpecifier ("photoshop", 10)) {
// Add the Photoshop automate menu to the Adobe Bridge UI.
}

}

For details of interapplication communication, see Chapter 5, “Interapplication Communication with
Scripts.”

Scripting shares a global environment, so any script executed at startup can define variables and functions
that are available to all scripts. In all cases, variables and functions, once defined by running a script that
contains them, persist in subsequent scripts during a given application session. Once the application is
quit, all such globally defined variables and functions are cleared. Scripters should be careful about giving
variables in scripts unique names, so that a script does not inadvertently reassign global variables
intended to persist throughout a session.



The ExtendScript Toolkit

The ExtendScript Toolkit provides an interactive development and testing environment for ExtendScriptin
all JavaScript-enabled Adobe applications. It includes a full-featured, syntax-highlighting text editor with
Unicode capabilities and multiple undo/redo support. The Toolkit is the default editor for ExtendScript
files, which use the extension .jsx.

The Toolkit includes a JavaScript debugger that allows you to:

» Single-step through JavaScript scripts (JS or JSX files) inside an application.
» Inspect all data for a running script.

» Setand execute breakpoints.

When you double click a JSX file in the platform’s windowing environment, the script runs in the Toolkit,
unless it specifies a particular target application using the #target directive. For more information, see
“Selecting a debugging target” on page 27 and “Preprocessor directives” on page 233.

Tip: When you have completed editing and debugging your JavaScript script, you can choose to save it as
a binary file (with the extension JSXBIN), using File > Export as Binary. The script loader recognizes both
source code and compiled code. Any application can execute a compiled script. If an application
recognizes the execution of compiled JavaScript, it lists JSXBIN files along with JSX files in any list of
available scripts.”

The ExtendScript Toolkit initially appears with a default workspace arrangement, containing a default
configuration of tabbed panels and Script Editor document windows contained in a parent frame. The
arrangement is highly configurable, through the Window menu, the context menus of individual panels
and panel groups, or directly using drag and drop.

n Fle Edit Wiew Debug Profle  Window Help | ‘ DEFAULT ~ EE

== [Extendscript Tookit c55 =l [main =l PR > VY A 'é G JAVASCRIPT CONSOLE
Document [i 8 =l 55 scmmrs Panels
. 2
Wi ndOWS 3 function StairStepButtionLayout (container) { this.initSelf{container); 9 BREAKPDINTS
4 i Define its "'method’ functions .
5 function SSEL_initSelf (container) { this.container = container; =2 CALL STACK
& Bfunction S5l _layout() { —
; ::: \?\?lpdﬁ:, O left = 0; | %] DaTA BROWSER
9 var vspacing = 10, hepacing = 20; () FUNCTIONS
10 B for (i=0; i < this.container.children.length; i++) {
11 var child = this.container children[i];
1z if (typeof child.layout 1= "undefined")
13 Nl child is a container, call ity layout method
14 child.layout.layout();
15 child.size = child.preferredSize;
16 child.location = [left, top];
17 width = left + child.size.width;
hlz] top += child.size.height + vspacing;
19 left += hspacing;
20 oY
21 this.container preferredSize = [width, top - vspacing];
22 i
2? i tsch methads o Objsct's et _'LI
4 »

[ Line 1 Calumn 1

13
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You can, for example, adjust the relative sizes of the panels by dragging the separators up or down, or right
or left, and can rearrange the groupings. To move a tabbed panel, drag the tab into another pane.

If you drag a tab so that the entire destination group is highlighted, it becomes another stacked panel in
that group. If you drag a tab to the top or bottom of a group (so that only the top or bottom bar of the
destination group is highlighted), that group splits to show the panels in a tiled format.

» You can dock the entire panel group to different edges of the Toolkit window.
» You can collapse the entire panel group, then expose individual panels.
» You can open and close, or collapse and expand individual panels, regardless of the dock state.

» You can undock individual tabs or the entire control panel, making them floating panels. Floating
panels can be docked to each other, or can be independent.

There are predefined configurations, called workspaces, suitable for various uses, and you can save your
favorite configurations as workspaces. See “Workspaces” on page 16.

Panel groups have a context menu, which you invoke with a right click in the tab or on the background of
the title bar. These menus have panel-control commands, including Close Panel and Close Group to hide
the individual panel or entire group.

Right click in top bar for panel-group menu

Close Panel
Close Group
Minimize Group

SCRIPTS

Favarites

j I Samples

%] ActionScriptDerno.js: -
5 AlertBoxBuilderl jsx

i AlertBoxBuilderz, jsx

i BridgeMenuTester,jsx

#] BridgeTest.jsx

J Eridoe_SnpaddMenultemn, js=

3| ColorPicker jsx

¥ ColorSelectar, jsx

&) Emailwithattachment . jsx hd Refresh

Collapse ta Icons
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» You can also show or hide specific panels by toggling them on or off in the Window menu. Use the
Window menu to show a hidden panel, or to bring a floating panel to the front.

» Use Window > Hide panels to close all of the panels.

Some panels also have a flyout menu, specific to that panel, which you access through the menuicon in
the upper right corner. The JavaScript Console has a right-click menu that allows you to copy and paste
text.

The individual panels are discussed in detail in the following sections.



CHAPTER 2: The ExtendScript Toolkit Configuring the Toolkit window 15

When you open scripts or text files, each file appears in its own Script Editor document window. By default,
the document windows are docked; that is, shown as tabbed panes in the main window. However, like the
panels, you can drag any document window out of the frame to make it an independent floating window.

If you are displaying more than one document, and you have undocked one or more of them, you can
choose to show the document windows in tiled or cascade style—that is, side by side in the main window,
or overlapping in the main window. To do this, choose Window > Tile Documents or Window > Cascade.

You can edit or run scripts in multiple document windows simultaneously. The current document window
is highlighted and has the input focus. You can select another document window by clicking in it, or you
can switch between them with the commands Window > Next document and Window > Previous
document. The default keyboard shortcuts for these commands are F6 and SHIFT-F6; you can change these
using the Keyboard Shortcuts page in the Preferences dialog (Edit > Preferences).

NoTE: Because you can run scripts in the same application simultaneously, you should be careful not to
interrupt the processing of one script with another. For example, if one script opens a modal dialog in
Photoshop, and you run another script that targets Photoshop while the dialog is still open, the second
script is likely to generate an error.

A button in the upper right corner of the document window allows you to split that window.

B u B>y J"‘( = Split document button Second view of document
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When the window is split, the second window is another view of exactly the same source. Any changes
you make in the text, breakpoints that you add, and so on, appear simultaneously in both windows. The
copy is, by default, positioned to the right of the original, docked window, as shown. However, if you use
CTRL-click to split the window, the second appears below the original.

For more information about the document windows and the Script Editor, see “The Script Editor” on
page 18.
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The Toolkit saves the current layout when you exit, and restores it at the next startup. It saves and restores
the open documents, the current positions within the documents, any breakpoints that have been set, and
other preferences that have been set in the Preferences dialog.

4

>

The Startup page in the Preferences dialog (Edit > Preferences) offers a choice of whether to open a
blank document window, no document window, or display a previously opened document on startup.

The Tookit defines a number of workspace configurations that are suitable for specific usage types. To
choose a predefined or user-defined workspace, use the workspace menu that drops down from the
upper right corner of the Toolkit. When you choose a workspace, its name appears here. You can also
add and remove workspaces from this menu.

| (DEFAULT x| — & % .
Create new Workspace. ..

REITII:IVE current I'."'."I:II"kSI:IEII:E \ Current WOI’kSpace name appearS in thIS Space

Debugging

v Default
Development
Ernphy

Spruce

You can save any configuration as a named workspace, using the Create new Workspace menu
command, or the Add button on the Workspaces page in the Preferences dialog (Edit > Preferences).

You can remove workspaces you have defined, either individually using the menu or the Workspaces
page in the Preferences dialog, or all at once using the Default button at the bottom of the Workspace
page.

The Keyboard Shortcuts page in the Preferences dialog (Edit > Preferences) allows you to set or
modify keyboard shortcuts for all menu commands. There is a warning if you assign a key combination
that is already in use. If you assign the combination to a new command, it is removed from the
previous command.

You can restore all preferences to their default values by holding the SHIFT key down while the Toolkit
loads.

Some dialog windows offer the option “Don’t show again”. If you select this option, the Toolkit remembers
the choices made in this dialog, and next time it would appear, makes the same choices without showing
the dialog.

» To make these dialogs display again, click Reset Dialogs on the User Interface page in the Preferences

dialog (Edit > Preferences).
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You can open multiple scripts (or text files, including programs in other languages). You can find and open
scripts in a number of ways:

» Use File > Open to bring up the platform-specific file browser.
Choose from recently opened files using File > Recent files.
Create a new script using File > New JavaScript.

Drop files from the Explorer or the Finder onto the Toolkit to open them in a document window.

vV v v Vv

For JavaScript scripts in trusted locations (the user-script folders of installed Adobe applications), a
double-click on the file runs it in the target application or in the Toolkit. For script files in other
locations, you must confirm that you want to run the script.

» Search for scripts containing particular text using Edit > Find and Replace. You can search in a
particular document window, among all scripts open in document windows, or among scripts
associated with an application, or kept in favorite locations. See “Searching in text” on page 24.

» Use the Scripts panel to display and open scripts made available by loaded Adobe applications, or
those kept in favorite locations.

The Scripts panel offers a list of debuggable scripts, which can be JS or JSX files or (for some applications)
HTML files that contain embedded scripts.

You can display a list of scripts made available by a particular target application. Select the target
application in the leftmost drop-down list; the available JavaScript engines for that application become
available in the right-hand list.

When you select a target application, the Toolkit offers to open that application if it is not running, then
displays the scripts which that application makes public. Select a script in this panel to load it and display
its contents in a new document window, where you can modify it, save it, or run it within the target
application.

When you choose the target Favorites, the right-hand list shows the default favorite script location, and
any other favorite locations that have been defined. You can create your own list of favorite script locations
using the flyout menu.

u flyout menu
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The favorite script locations that you define are also available to the Find and Replace dialog; see
“Searching in text” on page 24.

You can also examine and set favorite locations using the Favorites page of the Preferences dialog (Edit >
Preferences). Use the Add, Modify, and Remove buttons to edit the list of folders.

x
Startup ~afMly Documentsfadobe Scripks
User Interface C:\Documents and Settings) Judy Boga
Documents
Foriks and Colors
Debugging
Help
Keyboard Shorteuts
Workspaces
Create New Favorite x|
Filker
| * jsx
| =]
[~ Recursive Folders [ Ignore Files starting with a dot
oF; I Cancel I
4 | i
Add... Modify I Remove |
Default | OF I Cancel
Adobe Scripts folder

On first launch, the Toolkit creates a folder named Adobe Scripts in the user's Documents folder. The
Default favorite in the Scripts panel displays the contents of this folder.

When double-clicking a JSX file, the Toolkit normally acts as an invisible security filter. Before actually
launching the file, a security dialog asks if it is OK to execute the script. The Toolkit treats the user's
Documents/Adobe Scripts folder, however, as a trusted location; when you double-click a JSX file in that
folder, the Toolkit does not display the security alert.

The Script Editor is a full-featured source code editor for JavaScript. You can open any number of Script
Editor document windows; each displays one Unicode source code document.

The Script Editor offers many useful and powerful text editing and navigation features. Some are intended
specifically for use with JavaScript, while others are useful for all kinds of text editing. Features include:

» Navigation aids and options applicable to any kind of text, and specific code navigation for JavaScript;
see “Navigation aids” on page 19.

» General editing and coding support such as undo-redo, and specific JavaScript coding support such
as syntax checking; see “Coding aids” on page 22.
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>
4

A full-featured text search tool that can search in multiple files; see “Searching in text” on page 24.

Syntax marking (color and font styles for specific syntactic structures) for JavaScript and for many
other computer languages. The marking styles are configurable; see “Syntax marking” on page 26.

You can configure the Script Editor to display text with various features that help you track the structure of
your code, or that help you move around in the file. It also offers mouse and keyboard shortcuts for specific
types of cursor movement and text selection.

View options

The Script Editor offers a number of viewing options that aid in code navigation, including the following:

>
>

Automatic line numbering. View > Line Numbers toggles numbering on and off.

A collapsible tree view of code, where you can open or close logical units of the structure, such as
comments or function definitions. View > Code Collapse toggles the tree view on and off.

A line-wrapping mode, where there is no horizontal scroll bar, and lines are wrapped at word breaks.
View > Word Wrap toggles line-wrapping on and off.

Syntax marking, which uses color and font styles to highlight specific syntactic structures. View >
Syntax Highlighting allows you to turn syntax marking off, or set it to mark a particular language,

JavaScript or many other computer languages. The marking styles are configurable; see “Syntax
marking” on page 26.

You can set the default values for any of these states using the Documents page of the Preferences dialog
(Edit > Preferences).

Function finders

The Functions panel, and the flyout menu at the top right of the document window, both offer lists of
functions defined in the current document. When you select a function in either list, the document jumps
directly to that function definition in the code.
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Bookmarks

The Edit > Bookmarks menu allows you to set and clear navigation points in your text. The F2 function

key is the default shortcut key for the bookmark commands:

» Toggle the bookmark for the current line using CTRL-F2.

» Move the cursor to the next bookmark with F2, or to the previous one with SHIFT-F2. The bookmarks
wrap, so that the first follows the last.

P Use SHIFT-CTRL-F2 to clear all bookmarks in the current text.
When you navigate to a bookmark in a collapsed section of code, that section automatically opens.

Bookmarks are marked with a blue, right-pointing arrow at the left of the line (to the right of the line
number if it is shown). This is the same place where a breakpoint is marked with a dot (see “Setting
breakpoints” on page 31). If you have both a breakpoint and a bookmark set in the same ling, the blue
arrow is superimposed on the breakpoint dot.
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Mouse navigation and selection

You can use the mouse or special keyboard shortcuts to move the insertion point or to select text in the
document window. Click the left mouse button in the document window to move the position caret.

To select text with the mouse, click in unselected text, then drag over the text to be selected. If you drag
above or below the currently displayed text, the text scrolls, continuing to select while scrolling. You can
also double-click to select a word, or triple-click to select a line.

To initiate a drag-and-drop of selected text, click in the block of selected text, then drag to the destination.
You can drag text from one document window to another. You can also drag text out of the Toolkit into
another application that accepts dragged text, and drag text from another application into a Toolkit
document window.

You can drop files from the Explorer or the Finder onto the Toolkit to open them in a document window.

Keyboard navigation and selection

The Keyboard Shortcuts page in the Preferences dialog (Edit > Preferences) allows you to set or modify
keyboard shortcuts for all menu commands.

In addition to the keyboard shortcuts specified for menu commands, and the usual keyboard input, the
document window accepts these special movement keys. You can also select text by using a movement
key while pressing SHIFT.

ENTER Insert a Line Feed character
Backspace Delete character to the left
DELETE Delete character to the right

Left arrow Move insertion point left one character
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Right arrow

Up arrow

Down arrow

Page up

Page down

CTRL + Up arrow
CTRL + Down arrow
CTRL + Page up
CTRL + page down
CTRL + Left arrow
CTRL + right arrow
Home

END

CTRL + HOME

CTRL + END

Move insertion point right one character

Move insertion point up one line; stay in column if possible
Move insertion point down one ling; stay in column if possible
Move insertion point one page up

Move insertion point one page down

Scroll up one line without moving the insertion point
Scroll down one line without moving the insertion point
Scroll one page up without moving the insertion point
Scroll one page down without moving the insertion point
Move insertion point one word to the left

Move insertion point one word to the right

Move insertion point to start of line

Move insertion point to end of line

Move insertion point to start of text

Move insertion point to end of text

The Script Editor supports extended keyboard input via IME (Windows) or TMS (Mac OS). This is especially
important for Far Eastern characters.

The Script Editor offers a number of visual and editing features that help you navigate in and maintain the
syntactic structure of your JavaScript code, including the following.

Code completion

When you position the cursor in a document and begin typing, the Toolkit offers completion choices from
among keywords, global functions, functions that are defined in the current document, and functions
defined in the object-model dictionary that is currently selected from the flyout menu.

221 B
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You can use the flyout menu at the upper right corner of the document window to choose an
object-model dictionary to use for completion. Available dictionaries depend on which applications are
loaded. See “Inspecting object models” on page 36.
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Brace matching

The Edit menu offers two kinds of brace-matching selection, that operate when the cursor is placed
immediate after an opening brace character, or immediately before a closing brace:

» Edit > Select to Brace: Moves the cursor to the matching bracing, but does not select any text. The
default keyboard shortcut is CTRL O (zero).

» Edit > Select Including Brace: Selects all text between the braces. The default keyboard shortcut is
SHIFT CTRL O (zero).

Brace characters include parentheses, curly braces, and square brackets.

Block indentation

When Word Wrap is off, you can automatically indent or outdent entire blocks of text. To indent a block of
text, select some or all of the text on the line or lines, and press TAB. (Be careful; if Word Wrap is on, this
deletes the selected text.) To outdent, press SHIFT TAB.

Comment and uncomment commands

Use Edit > Comment or Uncomment Selection to temporarily remove parts of a JavaScript program from
the path of execution. This command is a toggle. When you first issue the command, it places the special
comment sequence //~ at the front of any line that is wholly or partially selected. When you next issue the
command with such a line selected, it removes that comment marker.

The command affects only the comment markers it places in the text; it ignores any comment markers that
were already in the selected lines. This allows you to temporarily remove and replace blocks of text that
include both code and comments.

Version comments

A special comment format is reserved for a code versioning statement, which is used internally by Adobe
scripts, but is available to all scripters. Use Edit > Insert Version Tag to insert a comment containing the
file name and current date-time, in this format:
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/**
* @@@BUILDINFO@@@ SnpCreateDialog.jsx !Version! Tue Dec 05 2006 08:03:38 GMT-0800
*/

You are responsible for manually updating the 1version! portion with your own version information.

Undo and redo

Choose Undo or Redo from the Edit menu or from the document window’s right-click context menu to
revoke and reinstate multiple editing changes sequentially. The change history is kept from when afile is
created or loaded, and maintained through file-save operations.

Syntax checking

Before running the new script or saving the text as a script file, use Edit > Check Syntax to check whether
the text contains JavaScript syntax errors. The default keyboard shortcut is F7.

» If the script is syntactically correct, the status line shows “No syntax errors.”

» If the Toolkit finds a syntax error, such as a missing quote, it highlights the affected text, plays a sound,
and shows the error message in the status line so you can fix the error.

Multiline statements

The Script Editor supports triple-quote syntax to allow strings to span several source code lines. When
entering a very long string, you can:

» Enteritall onone line:

var myString = "This very long string might wrap onto a second line visually, but you
typed no CR character when entering it."

» Enter on multiple lines, using a backslash (\) continuation character at the end of each line:

var myString = "This string spans \
two lines."

» Use triple quotes around the entire string on multiple lines:

var myString = """This "quoted" word is inside the
multiline string enclosed by triple quotes."""

The triple-quote option allows the string to contain embedded quotes.

The Toolkit offers a search utility through the Edit > Find and Replace command. This command brings
up the Find and Replace panel. If the panel is not docked, you can hide it by pressing Esc.

The Find and Replace panel allows you to search through multiple documents for text that matches a
specific search string or regular expression. You can choose to search in:

» The current document, or the current selection in the current document

» All open documents
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» All scripts made public by the current target application

» Folders that you have defined as favorite locations; see “The Scripts panel and favorite script locations”

on page 17.
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Search Where: ICurrent document j Pzl e A |
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The results of a search are listed in the Find Results tab; by default, this is stacked with the Find and Replace
panel, but you can drag it to another stack, or display it as an independent floating panel.
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Double-click a result line in the Find Results panel to jump directly to the document and line where the
text was found.

Using regular-expression syntax

The Toolkit supports a limited set of Regular Expression syntax for the Find and Replace dialog:

Matches any character

( Marks the start of a region for capturing a match.
) Marks the end of a capturing region.
\< Matches the start of a word using the editor's current definition of words.

\> Matches the end of a word using the editor's current definition of words.
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\x Escapes a character x that would otherwise have a special meaning. For example, \[ is
interpreted as a left bracket, rather than the start of a character set.

[...] A set of characters; for example, [abc] means any of the characters a, b or ¢. You can also use
ranges, for example [a-z] for any lower case character.

[*...] The complement of the characters in a set. For example, [AA-Za-z] means any character
except an alphabetic character.

Matches the start of a line (unless used inside a set).

$ Matches the end of a line.
* Matches 0 or more times. For example, Sa*m matches Sm, Sam, Saam, Saaam etc.
+ Matches 1 or more times. For example, Sa+m matches Sam, Saam, Saaam and so on.

In a replace operation, you can use the captured regions of a match in the replacement expression by
using the placeholders \ 1 through \ 9, where \ 1 refers to the first captured region, \ 2 to the second, and so
on.

For example, if the search string is Fred\ ( [1-9]\) xxx and the replace string is sam\ 1YYy, when applied to
Fred2xxx the search generates sam2yvy.

The Script Editor offers language-based syntax highlighting to aid in editing code. Although the
debugging features (including syntax checking) are only available for JavaScript, you can choose to edit
other kinds of code, and the syntax is highlighted according to the language. The style of syntax marking is
automatically set to match the file extension, or you can choose the language from the View > Syntax
Highlighting menu.

The style of highlighting is configurable, using the Fonts and Colors page of the Preferences dialog.
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You can debug the code in the currently active document window. Select one of the debugging
commands to either run or to single-step through the program.

When you run code from the document window, it runs in the current target application’s selected
JavaScript engine. The Toolkit itself runs an independent JavaScript engine, so you can quickly edit and
run a script without connecting to a target application.

The Toolkit can debug multiple applications at one time. If you have more than one Adobe application
installed, use the drop-down list at the upper left of a document window to select the target application
for that window. All installed applications that support JavaScript are shown in this list. If you try to run a
script in an application that is not running, the Toolkit prompts for permission to run it.

Some applications use multiple JavaScript engines; all available engines in the selected target application
are shown in a drop-down list to the right of the application list, with an icon that shows the current
debugging status of that engine. A target application can have more than one JavaScript engine, and
more than one engine can be active, although only one is current. An active engine is one that is currently
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executing code, is halted at a breakpoint, or, having executed all scripts, is waiting to receive events. An
icon by each engine name indicates whether it is running, halted, or waiting for input:

| running
E halted

waiting

The current engine is the one whose data and state is displayed in the Toolkit's panes. If an application has
only one engine, its engine becomes current when you select the application as the target. If there is more
than one engine available in the target application, you can select an engine in the list to make it current.

When you open the Toolkit, the Toolkit itself is the default target application. When you select another
target, if the target application that you select is not running, the Toolkit prompts for permission and
launches the application. Similarly, if you run a script that specifies a target application that is not running
(using the #target directive), the Toolkit prompts for permission to launch it. If the application is running
but not selected as the current target, the Toolkit prompts you to switch to it.

If you select an application that cannot be debugged in the Toolkit, an error dialog reports that the Toolkit
cannot connect to the selected application.

The ExtendScript Toolkit is the default editor for JSX files. If you double-click a JSX file in a file browser, the
Toolkit looks for a #target directive in the file and launches that application to run the script; however, it
first checks for syntax errors in the script. If any are found, the Toolkit displays the error in a message box
and quits silently, rather than launching the target application. For example:

| Script Error &l

Error in Ciiphotoshop, jsi
Line 14: #include "Includefile. js"

File or folder does nok exist

The JavaScript console is a command shell and output window for the currently selected JavaScript
engine. It connects you to the global namespace of that engine.

[avascrer consore

myibj = {name : "cats”, number ; 2, color ; "black” ¥; :I
Result: [object Object]

ryiobg;

Result: [object Object]

b, name;

Result: cats

b number;

Resule: 2

rybg, colar;

Result: black




CHAPTER 2: The ExtendScript Toolkit Debugging in the Toolkit 29

The console is a JavaScript listener, that expects input text to be JavaScript code.

You can use the console to evaluate expressions or call functions. Enter any JavaScript statement and
execute it by pressing ENTER. The statement executes within the stack scope of the line highlighted in the
Call Stack panel, and the result appears in the next line.

» You can use the up- and down-arrow keys to scroll through previous entries, or place the cursor with
the mouse. Pressing ENTER executes the line that contains the cursor, or all selected lines.

» The right-click context menu provides the same editing commands as that of the document window.
You can copy, cut, and paste text, and undo and redo previous actions.

» You can select text with the mouse, and use the normal copy and paste shortcuts.
» The flyout menu allows you to clear the current content.

Commands entered in the console execute with a timeout of one second. If a command takes longer than
one second to execute, the Toolkit generates a timeout error and terminates the attempt.

The console is the standard output location for JavaScript execution. If any script generates a syntax error,
the error is displayed here along with the file name and the line number. The Toolkit displays errors here
during its own startup phase.

The debugging commands are available from the Debug menu, from the document window's right-click
context menu, through keyboard shortcuts, and from the toolbar buttons. Use these menu commands
and buttons to control the execution of code when the JavaScript Debugger is active.

Run F5 (Windows) Starts or resumes execution of a script.

* Continue CtrlR (Mac OS)
Disabled when script is executing.

Break Ctrl F5 (Windows)  Halts the currently executing script temporarily and reactivates
il Cmd . (Mac OS) the JavaScript Debugger.

Enabled when a script is executing.

Stop Shift F5 (Windows)  Stops execution of the script and generates a runtime error.
. Ctrl K (Mac O5)
Enabled when a script is executing.
Step F10 (Windows) Halts after executing a single JavaScript line in the script. If the
* Over Ctrl S (Mac OS) statement calls a JavaScript function, executes the function in

its entirety before stopping (do not step into the function).

Stepinto F11 (Windows) Halts after executing a single JavaScript line statement in the
v Ctrl T (Mac OS) script or after executing a single statement in any JavaScript
function that the script calls.
Step Out Shift F11 When paused within the body of a JavaScript function, resumes
A (Windows) script execution until the function returns.

Ctrl U (Mac OS)
When paused outside the body of a function, resumes script

execution until the script terminates.
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When the execution of a script halts because the script reached a breakpoint, or when the script reaches
the next line when stepping line by line, the document window displays the current script with the current

line highlighted in yellow.

File  Edit “iew Debug Profle  Window Help |

|Dl

E AlertBoxBuilder1.jsx [X
JAYASCRIPT CONSOLE

Result: brue

==} IExtendScrlpt Toolkit C55 j 2 Imaln ﬂ b g H ¥V A =
27 <hbr iz =]
28
29 Feonstructor Constructor
20 &
31 function slertBoxBuilder1{}{ } J
32
33 e
34 Functional part of thiz znippet. Creates the Dialog and adds the Scriptl]
35 components and event handlers.
36 *f

37 AlertBoxBuilder 1.prototype.run = function()

T {

———current line

Extend3cript Toolkit C55

SCRIPTS

DATA BEOWSER ﬁ

If the script encounters a runtime error, the Toolkit halts the execution of the script, displays the current
script with the current line highlighted in orange, and displays the error message in the status line. Use the

Data Browser to get further details of the current data

* [R/0] AlertBonBuilderl jsn X

assignments.

=2 | Extendscript Toolkit C54 =] & [main

E oWl @B F VY A

g JAYASCRIPT CONSOLE

33 i
34 Functional part of this snippet. Creates the Dialog
components and event handlers

=)

26
37 AlertBoxBuilder 1.prototype.run = function()
33 B
. 39
error line 40
41
42 [ function createBuilderDialog() {
43 /I Create an empty dialog windaow near the upp|
44 var dig = new Wwindow('dialog’, 'alert Box
45 dig.framelocation = [100, 100];
46 li dd a container panel for the tite and 'messq
47 dig.msgPnl = dig.add('panel’, undefined, ™
45 dig.msgrnl.alignchildren = "right";
49 Il add the panel's child components
50 dlg.msgPnl.title = dig.msgPnl.add('group');
51 dig.msgPnl.msg = dig.msgPnl.add{'group');
A 2 M i b R ngas]

[ undefined

and adds the ScriptlU|

-

=

2§ SCRIPTS

5 BREAKPOINTS

>3 CALLSTACK

DATA BROWSER

builder = undefined
f = undsfined
Friame = undefined
ok = undefined
resspec = undefined
= retval = undefined
-9 this = [object Ohject]

ExtendScript Toolkit €54

()i FUNCTIONS

€rror message— i indefined

Line 32 Column 1

Scripts often use a try/catch clause to execute code that may cause a runtime error, in order to catch the
error programmatically rather than have the script terminate. You can choose to allow regular processing
of such errors using the catch clause, rather than breaking into the debugger. To set this behavior, choose
Debug > Don’t Break On Guarded Exceptions. Some runtime errors, such as out 0of Memory, always

cause the termination of the script, regardless of this s

etting.
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When debugging a script, it is often helpful to make it stop at certain lines so that you can inspect the state
of the environment, whether function calls are nested properly, or whether all variables contain the
expected data.

» To stop execution of a script at a given line, click to the left of the line number to set a breakpoint. A
red dot indicates the breakpoint.

» Click a second time to temporarily disable the breakpoint; the icon changes color.
» Click a third time to delete the breakpoint. The icon is removed.

Some breakpoints need to be conditional. For example, if you set a breakpoint in a loop that is executed
several thousand times, you would not want to have the program stop each time through the loop, but
only on each 1000th iteration.

You can attach a condition to a breakpoint, in the form of a JavaScript expression. Every time execution
reaches the breakpoint, it runs the JavaScript expression. If the expression evaluates to a nonzero number
or true, execution stops.

To set a conditional breakpoint in a loop, for example, the conditional expression could be "i >= 1000",
which means that the program execution halts if the value of the iteration variable i is equal to or greater
than 1000.

Tip: It is often useful to check the boundary conditions for loops; to do this, you can set the condition for a
breakpoint within a loop to trigger on the first and last iterations.

You can set breakpoints on lines that do not contain any code, such as comment lines. When the Toolkit
runs the program, it automatically moves such a breakpoint down to the next line that actually contains
code.

The Breakpoints panel

The Breakpoints panel displays all breakpoints set in the current document window. You can use the
panel’s flyout menu to add, change, or remove a breakpoint.

F == JA¥ASCRIPT CONSOLE
= | ExtendScript Toalkit C54 j | main j oy B p Y A =
164 " alignment:['center’, top'], properties {multiline true} 1 A
165
166 if Define buttans if desired
12; :El :;a(; 2:;5:;?2;{— huilder hasBinsCh.ralue; Elen Scipt Tookil 54
160 var groupAlign = "center”; - | ereaxpoms [JCH
170 . I &lign buttons as specified @ Line 167
i1 if (huilder.alertBmsPrl.alignLefiRb.value) { O Line 168
172 groupdlign = "R @ Line 169 when groupdlign == "center”
L } < Line 170 when groupdlign == "left”
174 H else if (builder.alertBinsPnl.alignRightRb.value) {
175 groupalign = "right';
176 }

You can edit a breakpoint by double-clicking it, or by selecting it and choosing Add or Modify from the
panel menu. A dialog allows you to change the line number, the breakpoint’s enabled state, and the
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condition statement. You can also specify a hit count, which allows you to skip the breakpoint some
number of times before entering the debugger. The default is 1, which breaks at the first execution.

BREAKPOINTS add
@ Line 167 MuodiFy
O Line 168 Femave

& Line 169 when groupdlign == "center
< Line 170 when groupdlign == "left"

Modify Breakpoint ] x|
Line: |15=3 ¥ active

groupAlign = "center”|

Condition:

Hik coumk: I 1

Remove | (04 Cancel |

When execution reaches this breakpoint after the specified number of hits, the debugger evaluates this
condition. If it does not evaluate to true, the breakpoint is ignored and execution continues. This allows
you to break only when certain conditions are met, such as a variable having a particular value.

Breakpoint icons

Each breakpoint is indicated by an icon to the left of the line number in the document window, and an
icon and line number in the Breakpoints panel. Different icons are used in the document window and in
the Breakpoints panel.

2
<t £
fr 2
5T w9
8E ¢§
032 oo

Unconditional breakpoint. Execution stops here.

Unconditional breakpoint, disabled. Execution does not stop.

Conditional breakpoint. Execution stops if the attached JavaScript expression evaluates
to true.

Conditional breakpoint, disabled. Execution does not stop.

® © & @

o & 0O @
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If you let your mouse pointer rest over a variable or function in a document window, the result of
evaluating that variable or function is displayed as a help tip. When you are not debugging the program,
this is helpful only if the variables and functions are already known to the JavaScript engine. During
debugging, however, this is an extremely useful way to display the current value of a variable, along with
its current data type.

The Data Browser panel is your window into the JavaScript engine. It displays all live data defined in the
current context, as a list of variables with their current values. If execution has stopped at a breakpoint, it
shows variables that have been defined using var in the current function, and the function arguments. To
show variables defined in the global or calling scope, use the Call Stack to change the context (see “The
call stack” on page 34).

You can use the Data Browser to examine and set variable values.
» Click a variable name to show its current value in the edit field at the top of the panel.

» To change the value, enter a new value and press ENTER. If a variable is Read only, the edit field is
disabled.

DATA BROWSER [ v Undefined ariables

| [Point] 100,100 > v Functions

EI---@T::uiIder = [object Win Caore JavaScript Elements
il add?) Protatype Elements
EI@ alertBtnsPrl = [object Panel]
EI@ btnPnl = [object Panel]
-6 frameLacation = [Paint] 100,100

P i@ length=2

#-5) hasBtnsCh = [DI:M\ -
LTIEJ msgPnl = [object Panel] Object opene.d to
B1-6) this = [objsct global] show properties

Examine or modify
selected variable’s value

ExtendScripk Toolkic C54

The flyout menu for this panel lets you control the amount of data displayed:
» Undefined Variables toggles the display of variables whose value is undefined (as opposed to null).

» Functions toggles the display of all functions that are attached to objects. Most often, the interesting
data in an object are its callable methods.

» Core JavaScript Elements toggles the display of all data that is part of the JavaScript language
standard, such as the Array constructor or the Math object.

» Prototype Elements toggles the display of the JavaScript object prototype chain.

Each variable has a small icon that indicates the data type. An invalid object (that is, a reference to an
object that has been deleted) shows the object icon crossed out in red. An undefined value has no icon.
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o) Boolean
i Number
) String
Ea Object
i Method
= null

You can inspect the contents of an object by clicking its icon. The list expands to show the object’s
properties (and methods, if Functions display is enabled), and the triangle points down to indicate that
the object is open.

The Call Stack panel is active while debugging a program. When an executing program stops because of a
breakpoint or runtime error, the panel displays the sequence of function calls that led to the current
execution point. The Call Stack panel shows the names of the active functions, along with the actual
arguments passed in to that function.

For example, this panel shows a break occurring at a breakpoint in a function ReBColorpPicker ():

[R/0] ColorPicker.jsx %

JAYASCRIPT CONSOLE

== | Extendscript Toolki: €54 | @ [main = ol 30N S —
201 r =)@ Line 204
202 function RGBColorPicker (container, initialRGB, fontSize) O Line 238
Sgi .D| ! this.initRGBColorPicker {container, initialRGE, fontSize); S A el
20 [ [ColorPicker . jsx]
200 o
runi}
ggg _ ] ColorPicker([Group:[object Group]],[Arra
210
211 r -
212 RGBColorPicker prototype.initRGBCalorPicker = function (container, initialRGE, fonts DATABROWSER
213 3 { | Carray] 1,1,1
214 this.container = container; &) container = [ohject Group]
215 this.rgbvalue = initialRGE; FontSize = 9
216 this.uiFont = ScriptULnewFont ("palette”, fontSize); 2 initislRGB = [Array] 1,1,1
217 this.updatesEnsbled = false; - f7) this = [object Object]
218 Il Create the picker Ul for each RGE component color
219 container.orientation = ‘column';
220 container.alignChildren = [fill','top'];
221 container.spacing = 2;
222 this.redPicker = new RGEPickerComponent {0); -
| | _>|J Extendscript Toolkit €54

| Line 204 Column 1 I

The function containing the breakpoint is highlighted in the Call Stack panel. The line containing the
breakpoint is highlighted in the Document Window.

You can click any function in the call hierarchy to inspect it. In the document window, the line containing
the function call that led to that point of execution is marked with a green background. In the example,
when you select the run () function in the call stack, the Document Window highlights the line in that
function where the ReBColorpPicker () function was called.
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== | Extendscript Tookit C54 |l |main 7 P ou E >V A T

274 war colorPickeryin = new Window {colorPickerRes); -]
275 | colorPickerWiin.rgbPicker = new RGBColorPicker {colorPicker\iinrgbPicker, [1, 1, 11, kFontSize);

276 colorPickeryin.rgbSwatch.bin.onDraw = drawRGBSwatch;

277 colorPickerwin.rgbSwatch.bin.onClick = clickRGESwatch; _
278

70 o [ColorPicker . jsx]

— r RiEBCalarPicker([ Group: [object Group]],[Array:1,1,1],9)

281 colorPickeriin.layout. layvout (true); HerFickerLBroupiLobject GrodplLiAmay: s, & 2

282 B with (colorPickerwinrgbSwatch) {

283 size = bin.size;

284 location = [bin.windowBounds.x, btn.

285 bin.location = [0, 01;

Z86 .

287 initializeDrawingState (colorPickervwin.rgbSwatch.bin);

288 ExtendScript Toolkit C54 .
280 I Mow display the window _ILI
FIF e s S | .

Switching between the functions in the call hierarchy allows you to trace how the current function was
called. The Console and Data Browser panels coordinate with the Call Stack panel. When you select a
function in the Call Stack:

» The Console panel switches its scope to the execution context of that function, so you can inspect and
modify its local variables. These would otherwise be inaccessible to the running JavaScript program
from within a called function.

» The Data Browser panel displays all data defined in the selected context.

The Profiling tool helps you to optimize program execution. When you turn profiling on, the JavaScript
engine collects information about a program while it is running. It counts how often the program
executed a line or function, or how long it took to execute a line or function. You can choose exactly which
profiling data to display.

Because profiling significantly slows execution time, the Profile menu offers these profiling options.

Ooff Profiling turned off. This is the default.

Functions The profiler counts each function call. At the end of execution, displays the total to
the left of the line number where the function header is defined.

Lines The profiler counts each time each line is executed. At the end of execution,
displays the total to the left of the line number.

Consumes more execution time, but delivers more detailed information.

Add Timing Info Instead of counting the functions or lines, records the time taken to execute each
function or line. At the end of execution, displays the total number of
microseconds spent in the function or line, to the left of the line number.

This is the most time-consuming form of profiling.

No Profiler Data When selected, do not display profiler data.
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Show Hit Count When selected, display hit counts.
Show Timing When selected, display timing data.
Erase Profiler Data Clear all profiling data.

Save Data As Save profiling data as comma-separated values in a CSV file that can be loaded
into a spreadsheet program such as Excel.

When execution halts (at termination, at a breakpoint, or due to a runtime error), the Toolkit displays this
information in the Document Window, line by line. The profiling data is color coded:

» Green indicates the lowest number of hits, or the fastest execution time.

» Orange or yellow indicates a trouble spot, such as a line that has been executed many times, or which
line took the most time to execute.

This example shows number-of-hits information:

187 I Ultility string-building function ;I
188 -5 function stringProperty (pname, pval) {

159 return pname + """ + pval + ", "

190 1

191

192 I Dizplaythe generated alert dialog

193 4 function createTestDialog(resource) { -
194 var target = new Window (resource); |

This example displays timing information for the program, in microseconds. The timing might not be
accurate down to the microsecond; it depends on the resolution and accuracy of the hardware timers built
into your computer.

129 &8 testBn.onClick = function ()

130 i

131 $owritein{"Displaying customized alert dialog");

132 createTestDialog{createResource (this.parent.parent));

123 ¥

124

135 I The Build and Cancel buttonz cloze this dialog

136 teaz buildein.onClick = function () { this.parent.parentclose{1); };
137 ] cancelBt.onClick = function () { this.parentparent.close(2); 1;

The ExtendScript Toolkit offers the ability to inspect the object model of any loaded dictionary, using the
Object Model Viewer that you invoke from the Help menu.
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ek ]|

| Objeck Model Yiewer

ExtendScript Toolkit Readte
S0k 3

Updates. ..
About Extend3cript Toolkit, ..

The Object Model Viewer (OMV) comes up as a separate, floating window. The OMV allows you to browse
through the object hierarchy and inspect the type and description of each property, and the description
and parameters for each method.

% Dbject Model Yiewer Y [m]

ExtendScript Toolkit CC | | [search [+ | [ closeail |

Browser Button.text

| » || Data Type: String
SoHotll Clgsses

ScriptUl Classes

1 Dimension

) DrawState

Types

Classes
) Bounds &
) Button Button
1 Checkbox Scriptll Classes

Event

Instance

Properties and Methods

preferredSize: Dimension
properties: Object
shortcutKey: String

size: Dimension

TR E Rl

text: String

=¥ type: String

il Y I R

Euukrnarks

Search Results

The text to display, a localizable string.

& pushbutton elerment containing a mouse-
sensitive text string,

Calls the onClick{) callback if the control is
clicked or if its notify() rmethod is called.

Window

Scriptll Classes

The instance represents a top-level window or
dialog box, which contains user-interface
elements,

The alobally available Window object provides
access to predefined and script-defined windows,

The drop-down menu in the Browser section at the top left allows you to choose from any loaded
dictionary of objects. A dictionary provides access to the object model for one application or subsystem.

» The Core JavaScript Classes dictionary includes Adobe tools and utilities such as File and Folder.

» The ScriptUI Classes dictionary shows the interface elements defined in the ScriptUI JavaScript
module.
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» Each Adobe application defines a dictionary for that application’s Document Object Model (DOM). The
dictionary for a particular application may not be available until you launch that application, or until
you select it as a target in the Toolkit.

Browser I

Scriptll Classes | v I

Core JlavaScript Classes
ScriptUl Classes

To inspect an object model, select the appropriate dictionary from the Browser menu. The classes defined
in that model appear in the Classes panel. Select a class to populate the Types panel with the available
element types (Constructor, Class, Instance, Event). Select the type to populate the Properties and
Methods panel with elements of that type.

Each time you select a class or element, its description appears on the right; descriptions are stacked,
remaining in view until you close them. You can close each description individually, using the mouse-over
menu that appears in the lower right of the description itself, or you can close all open descriptions using
the Close All button at the top left of the OMV window.

% Object Model Yiewer i =]

ExtendScript Toolkit CC | | |search |~ || | Closeall | | g:aii:iar:!cions

LS Button.text
ScriptUl Classes | = || Data Type: String
Scriptll Classes
Classas The text to display, a localizable string,
) Bounds |~
: -
g Buttan Button
) Checkbox Scriptlil Classes
. . & pushbutton element containing a mouse-
1 Dimension sensitive text string.
11 DrawState Calls the onClick() callback if the contral is
o T Y| clicked or if its notify() rmethod is called.
Types a
Event
Window
Insta
nstance Seriptiil Classes
The instance represents a top-level window or
+ | Properties and Mathods dialog box, which contains user-interface
pe elernents.
[=¥| preferredSize: Dimension « N The globally available Window object provides Mouse-over
. . access to predefined and script-defined windows. menu
=¥ properties: Object
=X shartcutiey: String Bookmark CopyText Clos

size: Dimension

1 1
> =

text: String
type: String

Ll i) = 1

n
=

ookmarks

The mouse-over menu also allows you to bookmark an element for easy access, or copy text from the
description. Live links in the descriptions take you to related objects and elements, and you can search for

text in names or descriptions.



File System Access

Adobe ExtendScript defines classes that simplify cross-platform file-system access. These classes are
available to all applications that support a JavaScript interface.

» The first part of this chapter, Using File and Folder objects, describes how to use these classes and
provides details of pathname syntax.

» “File object” on page 47 and “Folder object” on page 56 provide reference details of the objects,
properties, methods, and creation parameters. You can also choose the Core JavaScript Classes
dictionary from the Help menu in the ExtendScript Toolkit to inspect the objects in the Object Model
Viewer.

Because path name syntax is very different on Windows, Mac OS, and UNIX®, Adobe ExendScript defines
the File and Folder objects to provide platform-independent access to the underlying file system. A
File object represents a disk file, a Folder object represents a directory or folder.

» The Folder object supports file system functionality such as traversing the hierarchy; creating,
renaming or removing files; or resolving file aliases.

» The File object supports input/output functions to read or write files.

There are several ways to distinguish between a File and a Folder object. For example:
if (f instanceof File)

if (typeof f.open == "undefined") ...// Folders do not open

File and Folder objects can be used anywhere that a path name is required, such as in properties and
arguments for files and folders.

NoTEe: When you create two File objects that refer to the same disk file, they are treated as distinct
objects. If you open one of them for I/0, the operating system may inhibit access from the other object,
because the disk file already is open.

When creating a File or Folder object, you can specify a platform-specific path name, or an absolute or
relative path in a platform-independent format known as universal resource identifier (URI) notation. The
path stored in the object is always an absolute, full path name that points to a fixed location on the disk.

» Use the tostring method to obtain the name of the file or folder as string containing an absolute
path name in URI notation.

» Use the £sName property to obtain the platform-specific file name.

39
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Absolute and relative path names

An absolute path name in URI notation describes the full path from a root directory down to a specific file
or folder. It starts with one or two slashes (/), and a slash separates path elements. For example, the
following describes an absolute location for the file myFile.jsx:

/dirl/dir2/mydir/myFile.jsx

A relative path name in URI notation is appended to the path of the current directory, as stored in the
globally available current property of the Folder class. It starts with a folder or file name, or with one of
the special names dot (. ) for the current directory, or dot dot (. .) for the parent of the current directory. A
slash (/) separates path elements. For example, the following paths describe various relative locations for
the file myFile.jsx:

myFile.jsx In the current directory.

./myFile.jsx

../myFile.jsx In the parent of the current directory.
../../myFile.jsx In the grandparent of the current directory.

../dirl/myFile.jsx Indir1, which is parallel to the current directory.

Relative path names are independent of different volume names on different machines and operating
systems, and therefore make your code considerably more portable. You can, for example, use an absolute
path for a single operation, to set the current directory in the Folder. current property, and use relative
paths for all other operations. You would then need only a single code change to update to a new platform
or file location.

Character interpretation in paths

There are some platform differences in how pathnames are interpreted:
» On Windows and Mac OS, path names are not case sensitive. In UNIX, paths are case sensitive.

» On Windows, both the slash (/) and the backslash (\) are valid path element separators. Backslash is
the escape character, so you must use a double backslash (\\) to indicate the character.

» On Mac OS, both the slash (/) and the colon (:) are valid path element separators.

If a path name starts with two slashes (or backslashes on Windows), the first element refers to a remote
server. For example, / /myhost /mydir/myfile refers to the path /mydir/myfile on the server myhost.

URI notation allows special characters in pathnames, but they must specified with an escape character (%)
followed by a hexadecimal character code. Special characters are those which are not alphanumeric and
not one of the characters:

/==t~ ()

A space, for example, is encoded as %20, so the file name "my file" isspecified as "mys20file. Similarly,
the character 4 is encoded as $E4, so the file name "Braun" is specified as "Br$E4un".

This encoding scheme is compatible with the global JavaScript functions encodeURI and decodeURI.
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The home directory

A path name can start with a tilde (~) to indicate the user’'s home directory. It corresponds to the platform’s
HOME environment variable.

UNIX and Mac OS assign the HOME environment variable according to the user login. On Mac OS, the
default home directory is /Users/username. In UNIX, it is typically /home /username or /users/username.
ExtendScript assigns the home directory value directly from the platform value.

On Windows, the HOME environment variable is optional. If it is assigned, its value must be a Windows path
name or a path name referring to a remote server (such as \\myhost \mydir). If the HOME environment
variable is undefined, the ExtendScript default is the user’'s home directory, usually the c: \Documents and
Settings\username folder.

NoOTE: A script can access many of the folders that are specified with platform-specific variables through
static, globally available Folder class properties; for instance, appbata contains the folder that stores
application data for all users.

Volume and drive names

A volume or drive name can be the first part of an absolute path in URI notation. The values are interpreted
according to the platform.

Mac OS volumes

When Mac OS X starts, the startup volume is the root directory of the file system. All other volumes,
including remote volumes, are part of the /volumes directory. The File and Folder objects use these
rules to interpret the first element of a path name:

» If the name is the name of the startup volume, discard it.
» Ifthe name is a volume name, prepend /volumes.
» Otherwise, leave the path as is.

Mac OS 9 is not supported as an operating system, but the use of the colon as a path separator is still
supported and corresponds to URI and to Mac OS X paths as shown in the following table. These examples
assume that the startup volume is Macosx, and that there is a mounted volume Remote.

URI path name Mac OS 9 path name Mac OS X path name
/MacOSX/dir/file MacOSX:dir:file /dir/file
/Remote/dir/file Remote:dir:file /Volumes/Remote/dir/file
/root/dir/file Root:dir:file /root/dir/file
~/dir/file /Users/jdoe/dir/file

Windows drives

On Windows, volume names correspond to drive letters. The URI path /c/temp/file normally translates
to the Windows path c: \temp\file.

If a drive exists with a name matching the first part of the path, that part is always interpreted as that drive.
It is possible for there to be a folder in the root that has the same name as the drive; imagine, for example,
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a folder c:\c on Windows. A path starting with /c always addresses the drive c:, so in this case, to access
the folder by name, you must use both the drive name and the folder name, for example /c/c for c:\c.

If the current drive contains a root folder with the same name as another drive letter, that name is
considered to be a folder. That is, if there is a folder p: \ ¢, and if the current drive is D:, the URI path
/c/temp/file translates to the Windows path D: \c\temp\file.In this case, to access drive C, you would
have to use the Windows path name conventions.

To access a remote volume, use a uniform naming convention (UNC) path name of the form
// servername/sharename. These path names are portable, because both Max OS X and UNIX ignore
multiple slash characters. Note that on Windows, UNC names do not work for local volumes.

These examples assume that the current drive is D:

URI path name Windows path name

/c/dir/file c:\dir\file

/remote/dir/file D:\remote\dir\file

/root/dir/file D:\root\dir\file

~/dir/file C:\Documents and Settings\jdoe\dir\file
Aliases

When you access an alias, the operation is transparently forwarded to the real file. The only operations that
affect the alias are calls to rename and remove, and setting properties readonly and hidden. Whena rFile
object represents an alias, the alias property of the object returns true, and the resolve method returns
the File or Folder object for the target of the alias.

On Windows, all file system aliases (called shortcuts) are actual files whose names end with the extension
. 1nk. Never use this extension directly; the File and Folder objects work without it.

For example, suppose there is a shortcut to the file /folderi/some. txt in the folder /folder2. The full
Windows file name of the shortcut file is \folder2\some. txt . 1nk.

To access the shortcut from a File object, specify the path /folder2/some. txt. Calling that File object’s
open method opens the linked file (in /folder1). Calling the File object’s rename method renames the
shortcut file itself (leaving the . 1nk extension intact).

However, Windows permits a file and its shortcut to reside in the same folder. In this case, the File object
always accesses the original file. You cannot create a File object to access the shortcut when it is in the
same folder as its linked file.

A script can create a file alias by creating a File object for a file that does not yet exist on disk, and using its

createAlias method to specify the target of the alias.

Portability issues

If your application will run on multiple platforms, use relative path names, or try to originate path names
from the home directory. If that is not possible, work with Mac OS X and UNIX aliases, and store your files
on a machine that is remote to your Windows machine so that you can use UNC names.
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As an example, suppose you use the UNIX machine myserver for data storage. If you set up an alias share
in the root directory of myserver, and if you set up a Windows-accessible share at share pointing to the
same data location, the path name //myServer/share/file would work for all three platforms.

When doing file I/0, Adobe applications convert 8-bit character encoding to Unicode. By default, this
conversion process assumes that the system encoding is used (code page 1252 on Windows or Mac
Roman on Mac OS). The encoding property of a File object returns the current encoding. You can set the
encoding property to the name of the desired encoding. The File object looks for the corresponding
encoder in the operating system to use for subsequent I/0. The name is one of the standard Internet
names that are used to describe the encoding of HTML files, such as asc11, x-SJ1S, or 1s0-8859-1.Fora
complete list, see File- and Folder-supported encoding names.

A special encoder, BINARY, is provided for binary I/0. This encoder simply extends every 8-bit character it
finds to a Unicode character between 0 and 255. When using this encoder to write binary files, the encoder
writes the lower 8 bits of the Unicode character. For example, to write the Unicode character 1000, which is
0x3E8, the encoder actually writes the character 232 (OxES8).

The data of some of the common file formats (UCS-2, UCS-4, UTF-8, UTF-16) starts with a special byte order
mark (BOM) character (\ureFF). The File.open method reads a few bytes of a file looking for this
character. If it is found, the corresponding encoding is set automatically and the character is skipped. If
there is no BOM character at the beginning of the file, open () reads the first 2 KB of the file and checks
whether the data might be valid UTF-8 encoded data, and if so, sets the encoding to UTF-8.

To write 16-bit Unicode files in UTF-16 format, use the encoding UCS-2. This encoding uses whatever
byte-order format the host platform supports.

When using UTF-8 encoding or 16-bit Unicode, always write the BOM character "\urEFF" as the first
character of the file.

Each object has an error property. If accessing a property or calling a method causes an error, this
property contains a message describing the type of the error. On success, the property contains the empty
string. You can set the property, but setting it only causes the error message to be cleared. If a file is open,
assigning an arbitrary value to the property also resets its error flag.

For a complete list of supported error messages, see “File access error messages” on page 44.
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File access error messages

The following messages can be returned in the error property.
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File or folder does not exist
File or folder already exists
I/0 device is not open

Read past EOF

Conversion error

Partial multibyte character found
Permission denied

Cannot change directory
Cannot create

Cannot rename

Cannot delete

I/0 error

Cannot set size

Cannot open

Cannot close

Read error

Write error

Cannot seek

Cannot execute

The file or folder does not exist, but the parent folder exists.

The file or folder already exists.

An I/0 operation was attempted on a file that was closed.
Attempt to read beyond the end of a file.

The content of the file cannot be converted to Unicode.
The character encoding of the file data has errors.

The OS did not allow the attempted operation.

Cannot change the current folder.

Cannot create a folder.

Cannot rename a file or folder.

Cannot delete a file or folder.

Unspecified I/O error.

Setting the file size failed.

Opening of a file failed.

Closing a file failed.

Reading from a file failed.

Writing to a file failed.

Seek failure.

Unable to execute the specified file.
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The following list of names is a basic set of encoding names supported by the File object. Some of the
character encoders are built in, while the operating system is queried for most of the other encoders.
Depending on the language packs installed, some of the encodings may not be available. Names that refer
to the same encoding are listed in one line. Underlines are replaced with dashes before matching an
encoding name.

The File object processes an extended Unicode character with a value greater that 65535 as a Unicode
surrogate pair (two characters in the range between 0xD700-0xDFFF).

Built-in encodings are:

US-ASCII, ASCII,IS0646-US,I SO-646.IRV:1991, ISO-IR-6,
ANSI-X3.4-1968,CP367,IBM367,US,IS0646.1991-IRV
UCs-2,0UCS2, IS0O-10646-UCS-2

UCS2LE,UCS-2LE, ISO-10646-UCS-2LE

UCS2BE,UCS-2BE, ISO-10646-UCS-2BE

UCS-4,0UCS4, ISO-10646-UCS-4
UCS4LE,UCS-4LE,IS0O-10646-UCS-4LE

UCS4BE,UCS-4BE, ISO-10646-UCS-4BE
UTF-8,UTF8,UNICODE-1-1-UTF-8,UNICODE-2-0-UTF-8,X-UNICODE-2-0-UTF-8
UTF16,UTF-16,1IS0-10646-UTF-16

UTF16LE,UTF-16LE, ISO-10646-UTF-16LE

UTF16BE,UTF-16BE, ISO-10646-UTF-16BE
CP1252,WINDOWS-1252,MS-ANSI
IS0-8859-1,1IS0-8859-1,150-8859-1:1987,ISO-IR-100,LATINL
MACINTOSH, X-MAC-ROMAN

BINARY

The ASCIl encoder raises errors for characters greater than 127, and the BINARY encoder simply converts
between bytes and Unicode characters by using the lower 8 bits. The latter encoder is convenient for
reading and writing binary data.

In Windows, all encodings use code pages, which are assigned numeric values. The usual Western
character set that Windows uses, for example, is the code page 1252. You can select Windows code pages
by prepending the number of the code page with “CP” or “"WINDOWS”: for example, “CP1252" for the code
page 1252. The File object has many other built-in encoding names that match predefined code page
numbers. If a code page is not present, the encoding cannot be selected.

In Mac OS, you can select encoders by name rather than by code page number. The File object queries
Mac OS directly for an encoder. As far as Mac OS character sets are identical with Windows code pages,
Mac OS also knows the Windows code page numbers.

In UNIX, the number of available encoders depends on the installation of the iconv library.
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Common encoding names
The following encoding names are implemented both in Windows and in Mac OS:

UTF-7,UTF7,UNICODE-1-1-UTF-7,X-UNICODE-2-0-UTF-7
ISO-8859-2,I50-8859-2,1I80-8859-2:1987,IS0O-IR-101,LATIN2
ISO-8859-3,I50-8859-3,IS0-8859-3:1988,IS0O-IR-109,LATIN3
ISO-8859-4,I50-8859-4,150-8859-4:1988,ISO-IR-110,LATIN4,BALTIC
ISO-8859-5,IS0-8859-5,1I50-8859-5:1988,ISO-IR-144,CYRILLIC
IS0O-8859-6,IS0-8859-6,150-8859-6:1987,ISO-IR-127,ECMA-114,ASMO-708,ARABIC
IS0O-8859-7,1S0-8859-7,150-8859-7:1987,IS0-IR-126,ECMA-118,ELOT-928, GREEKS8, GREEK
ISO-8859-8,I50-8859-8,1S0-8859-8:1988,IS0O-IR-138,HEBREW
ISO-8859-9,I50-8859-9,1I50-8859-9:1989,IS0-IR-148,LATIN5, TURKISH
ISO-8859-10,IS0-8859-10,IS0-8859-10:1992,ISO-IR-157,LATING
ISO-8859-13,IS0-8859-13,IS0O-IR-179,LATIN7Y
IS0-8859-14,1IS0-8859-14,1IS0-8859-14,150-8859-14:1998,IS0O-IR-199,LATINS
IS0O-8859-15,IS0-8859-15,1IS0-8859-15:1998,IS0O-IR-203
ISO-8859-16,1S0-885,I50-885,MS-EE

CP850, WINDOWS-850, IBM850

CP866, WINDOWS-866, IBM866
CP932,WINDOWS-932,8JIS,SHIFT-JIS,X-SJIS,X-MS-SJIS,MS-SJIS,MS-KANJI
CP936, WINDOWS-936,GBK, WINDOWS-936,GB2312,GB-2312-80, ISO-IR-58, CHINESE
CP949,WINDOWS-949,UHC,KSC-5601,KS-C-5601-1987,KS-C-5601-1989,IS0O-IR-149, KOREAN
CP950, WINDOWS-950,BIG5,BIG-5,BIG-FIVE,BIGFIVE,CN-BIG5, X-X-BIG5
CP1251,WINDOWS-1251,MS-CYRL

CP1252,WINDOWS-1252,MS-ANSI

CP1253,WINDOWS-1253,MS-GREEK

CP1254 ,WINDOWS-1254,MS-TURK

CP1255,WINDOWS-1255, MS-HEBR

CP1256,WINDOWS-1256,MS-ARAB

CP1257,WINDOWS-1257, WINBALTRIM

CP1258, WINDOWS-1258

CP1361,WINDOWS-1361, JOHAB

EUC-JP, EUCJP,X-EUC-JP

EUC-KR, EUCKR, X-EUC-KR

HZ,HZ-GB-2312

X-MAC-JAPANESE

X-MAC-GREEK

X-MAC-CYRILLIC

X-MAC-LATIN

X-MAC-ICELANDIC

X-MAC-TURKISH

Additional Windows encoding names

CP437,IBM850, WINDOWS-437
CP709,WINDOWS-709,ASMO-449, BCONV4
EBCDIC

KOI-8R

KOI-8U

ISO0-2022-JP

ISO-2022-KR

46
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Additional Mac OS encoding names
These names are alias names for encodings that Mac OS might know.

TIS-620,TIS620,TIS620-0,TIS620.2529-1,TIS620.2533-0,TIS620.2533-1,IS0O-IR-166
CP874 ,WINDOWS-874

JP,JIS-C6220-1969-R0O,I1IS0646-JP,ISO-IR-14
JIS-X0201,JISX0201-1976,X0201
JIS-X0208,JIS-X0208-1983,JIS-X0208-1990,JI50208,X0208,ISO-IR-87
JIS-X0212,JI5-X0212.1990-0,JIS-X0212-1990,X0212,ISO-IR-159
CN,GB-1988-80,150646-CN, ISO-IR-57

ISO-IR-16,CN-GB-ISOIR165
KSC-5601,KS-C-5601-1987,KS-C-5601-1989,ISO-IR-149
EUC-CN, EUCCN, GB2312,CN-GB

EUC-TW, EUCTW, X-EUC-TW

UNIX encodings

In UNIX, the File object looks for the presence of the iconv library, and uses whatever encoding it finds
there. If you need a special encoding in UNIX, make sure that there is an iconv encoding module installed
that converts between UTF-16 (the internal format that the rFile object uses) and the desired encoding.

Represents a file in the local file system in a platform-independent manner. All properties and methods
resolve file system aliases automatically and act on the original file unless otherwise noted.

To create a File object, use the File function or the new operator. The constructor accepts full or partial
path names, and returns the new object. The CRLF sequence for the file is preset to the system default, and
the encoding is preset to the default system encoding.

File ([path]); //can return a Folder object
new File ([path]); //always returns a File object

path Optional. The absolute or relative path to the file associated with this object, specified in
platform-specific or URI format; see “Specifying paths” on page 39. The value stored in the
object is the absolute path.

The path need not refer to an existing file. If not supplied, a temporary name is generated.
If the path refers to an existing folder:
» The File function returns a Folder object instead of a File object.

» The new operator returns a File object for a nonexisting file with the same name.
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This property is available as a static property of the File class. It is not necessary to create an instance to
accessiit.

fs  String  The name of the file system. Read only. One of windows, Macintosh, Or Unix.

These functions are available as static methods of the File class. Itis not necessary to create an instance to
call them.

decode ()
File.decode (uri)

uri String. The encoded string to decode. All special characters must be encoded in
UTF-8 and stored as escaped characters starting with the percent sign followed by
two hexadecimal digits. For example, the string "my%20file" is decoded as "my
file"

Special characters are those with a numeric value greater than 127, except the
following:
/o= _ o b~ x ()

Decodes the specified string as required by RFC 2396.

Returns the decoded string.

encode ()
File.encode (name)

name String. The string to encode.

Encodes the specified string as required by RFC 2396. All special characters are encoded in UTF-8
and stored as escaped characters starting with the percent sign followed by two hexadecimal digits.
For example, the string "my file" is encoded as "my%20file".

Special characters are those with a numeric value greater than 127, except the following:

/-~ ()

Returns the encoded string.

isEncodingAvailable ()
File.isEncodingAvailable (name)

name String. The encoding name. Typical values are “ASCII,” “binary,” or “UTF-8.” See “File-
and Folder-supported encoding names” on page 45.

Checks whether a given encoding is available.

Returns true if your system supports the specified encoding, false otherwise.
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openDialog ()

File.openDialog ([prompt, filter, multiSelect])

prompt

filter

multiSelect

Optional. A string containing the prompt text, if the dialog allows a prompt.
Optional. A filter that limits the types of files displayed in the dialog.
» InWindows, afilter expression, such as "JavaScript:*.jsx;A1l files:*.*"

» In Mac OS, afilter function that takes a File instance and returns true if the file
should be included in the display, false if it should not.

Optional. Boolean. When true, the user can select multiple files and the return
value is an array. Default is false.

Opens the built-in platform-specific file-browsing dialog in which a user can select an existing file or
multiple files, and creates new File objects to represent the selected files.

If the user clicks OK, returns a File object for the selected file, or an array of objects if multiple files
are selected. If the user cancels, returns null.

saveDialog()

File.saveDialog (prompt[, preset])

prompt

filter

A string containing the prompt text, if the dialog allows a prompt.

Optional, in Windows only. A filter that limits the types of files displayed in the
dialog. A filter expression, such as "JavaScript:*.jsx;All files:*.*"

Not used in Mac OS.

Opens the built-in platform-specific file-browsing dialog in which a user can select an existing file
location to which to save information, and creates a new File object to represent the selected file

location.

If the user clicks OK, returns a File object for the selected file location. If the user cancels, returns

null.

These properties are available for File objects.

absoluteURI
alias

created

creator

displayName

String The full path name for the referenced file in URI notation. Read only.
Boolean When true, the object refers to a file system alias or shortcut. Read only.

Date The creation date of the referenced file, or nul1 if the object does not
refer to a file on disk. Read only.

String In Mac OS, the file creator as a four-character string. In Windows or UNIX,
value is "?222". Read only.

String The localized name of the referenced file, without the path. Read only.
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encoding

eof

error

exists

fsName

fullName

hidden

length

lineFeed

localizedName

modified

name

parent

path

readonly

String

Boolean

String

Boolean

String
String
Boolean

Number

String

String

Date

String

Folder

String

Boolean

Gets or sets the encoding for subsequent read/write operations. One of
the encoding constants listed in “File- and Folder-supported encoding
names” on page 45. If the value is not recognized, uses the system
default encoding.

A special encoder, BINARY, is used to read binary files. It stores each byte
of the file as one Unicode character regardless of any encoding. When
writing, the lower byte of each Unicode character is treated as a single
byte to write.

When true, a read attempt caused the current position to be at the end of
the file, or the file is not open. Read only.

A message describing the last file system error; see “File access error
messages” on page 44. Typically set by the file system, but a script can set
it. Setting this value clears any error message and resets the error bit for
opened files. Contains the empty string if there is no error.

When true, this object refers to a file or file-system alias that actually
exists in the file system. Read only.

The platform-specific full path name for the referenced file. Read only.
The full path name for the referenced file in URI notation. Read only.

When true, the file is not shown in the platform-specific file browser.
Read/write. If the object references a file-system alias or shortcut, the flag
is altered on the alias, not on the original file.

The size of the file in bytes. Can be set only for a file that is not open, in
which case it truncates or pads the file with 0-bytes to the new length.

How line feed characters are written in the file system. One of:

Windows — Windows style
Macintosh — Mac OS style
Unix — UNIX style

A localized version of the file name portion of the absolute URI for the
referenced file, without the path specification. Read only.

The date of the referenced file's last modification, or nu11 if the object
does not refer to a file on disk. Read only.

The file name portion of the absolute URI for the referenced file, without
the path specification. Read only.

The rolder object for the folder that contains this file. Read only.

The path portion of the absolute URI for the referenced file, without the
file name. Read only.

When true, prevents the file from being altered or deleted. If the
referenced file is a file-system alias or shortcut, the flag is altered on the
alias, not on the original file.
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relativeURI String The path name for the referenced file in URI notation, relative to the
current folder. Read only.

type String The file type as a four-character string.

» In Mac OS, the Mac OS file type.

» InWindows, "appl" for .EXE files, "shib" for .DLL files and "TExT"
for any other file.

If the file does not exist, the value is "2222". Read only.

These functions are available for rFile objects.

changePath ()
fileObj.changePath (path)

path A string containing the new path, absolute or relative to the current folder.

Changes the path specification of the referenced file.

Returns true on success.

close()
fileObj.close ()

Closes this open file.

Returns true on success, false if there are 1/0O errors.

copy ()
fileObj.copy (target)

target A string with the URI path to the target location, or a File object that references the
target location.

Copies this object’s referenced file to the specified target location. Resolves any aliases to find the
source file. If a file exists at the target location, it is overwritten.

Returns true if the copy was successful, false otherwise.

createAlias ()
fileObj.createAlias (path])

path A string containing the path of the target file.

Makes this file a file-system alias or shortcut to the specified file. The referenced file for this object
must not yet exist on disk.

Returns true if the operation was successful, false otherwise.
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execute ()
fileObj.execute ()
Opens this file using the appropriate application, as if it had been double-clicked in a file browser.
You can use this method to run scripts, launch applications, and so on.
Returns true immediately if the application launch was successful.
getRelativeURI ()
fileObj.getRelativeURI ([basePath])
basePath Optional. A string containing the base path for the relative URI. Default is the current
folder.
Retrieves the URI for this file, relative to the specified base path, in URI notation. If no base path is
supplied, the URI is relative to the path of the current folder.
Returns a string containing the relative URI.
open ()
fileObj.open (model, typel [, creator])
mode A string indicating the read/write mode. One of:
» 1:(read) Opens for reading. If the file does not exist or cannot be found, the call
fails.
» w: (write) Opens a file for writing. If the file exists, its contents are destroyed. If
the file does not exist, creates a new, empty file.
» e:(edit) Opens an existing file for reading and writing.
» a:(append) Opens the file in Append mode, and moves the current position to
the end of the file.
type Optional. In Mac OS, the type of a newly created file, a 4-character string. Ignored in
Windows and UNIX.
creator Optional. In Mac OS, the creator of a newly created file, a 4-character string. Ignored

in Windows and UNIX.

Opens the referenced file for subsequent read/write operations. The method resolves any aliases to
find the file.

Returns true if the file has been opened successfully, false otherwise.

The method attempts to detect the encoding of the open file. It reads a few bytes at the current
location and tries to detect the Byte Order Mark character oxFFFE. If found, the current position is
advanced behind the detected character and the encoding property is set to one of the strings
UCS-2BE, UCS-2LE, UCS4-BE, UCS-4LE, or UTF- 8. If the marker character is not found, it checks for
zero bytes at the current location and makes an assumption about one of the above formats (except
UTF-8). If everything fails, the encoding property is set to the system encoding.

NoTE: Be careful about opening a file more than once. The operating system usually permits you to

do so, but if you start writing to the file using two different File objects, you can destroy your data.
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openDlg ()

fileObj.OpenDlg ([prompt] [, filter] [,multiSelect])
prompt Optional. A string containing the prompt text, if the dialog allows a prompt.
filter Optional. A filter that limits the types of files displayed in the dialog.

» In Windows, a filter expression, such as "JavaScript:*.jsx;A11l files:*.*"

» In Mac OS, a filter function that takes a File instance and returns true if the file
should be included in the display, false if it should not.

multiSelect Optional. Boolean. When true, the user can select multiple files and the return value
is an array. Default is false.

Opens the built-in platform-specific file-browsing dialog, in which the user can select an existing file
or files, and creates new File objects to represent the selected files. Differs from the class method
openDialog () inthatit presets the current folder to this rile object’s parent folder and the current
file to this object’s associated file.

If the user clicks OK, returns a File or Folder object for the selected file or folder, or an array of
objects. If the user cancels, returns nu11.

read ()
fileObj.read ([chars])

chars Optional. An integer specifying the number of characters to read. By default, reads
from the current position to the end of the file. If the file is encoded, multiple bytes
might be read to create single Unicode characters.

Reads the contents of the file starting at the current position.

Returns a string that contains up to the specified number of characters.

readch ()
fileObj.readch ()

Reads a single text character from the file at the current position. Line feeds are recognized as Cr, L.F,
CRLF, Or LFCR pairs. If the file is encoded, multiple bytes might be read to create single Unicode
characters.

Returns a string that contains the character.

readln ()
fileObj.readln ()

Reads a single line of text from the file at the current position, and returns it in a string. Line feeds
are recognized as CR, LF, CRLF, or LFCR pairs. If the file is encoded, multiple bytes might be read to
create single Unicode characters.

Returns a string that contains the text.
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remove ()
fileObj.remove ()

Deletes the file associated with this object from disk, immediately, without moving it to the system
trash. Does not resolve aliases; instead, deletes the referenced alias or shortcut file itself.

NoTEe: Cannot be undone. It is recommended that you prompt the user for permission before
deleting.

Returns true if the file is deleted successfully.

rename ()
fileObj.rename (newName)

newName The new file name, with no path.

Renames the associated file. Does not resolve aliases, but renames the referenced alias or shortcut
file itself.

Returns true on success.

resolve()
fileObj.resolve ()

If this object references an alias or shortcut, this method resolves that alias and returns a new rile
object that references the file-system element to which the alias resolves.

Returns the new File object, or null if this object does not reference an alias, or if the alias cannot
be resolved.

saveDlg()
fileObj.saveDlg ([prompt] [, preset])

prompt Optional. A string containing the prompt text, if the dialog allows a prompt.

preset Optional, in Windows only. A filter that limits the types of files displayed in the
dialog. A filter expression, such as "JavaScript:*.jsx;All files:*.*"

Not used in Mac OS.

Opens the built-in platform-specific file-browsing dialog, in which the user can select an existing file
location to which to save information, and creates a new File object to represent the selected file.

Differs from the class method saveDialog () inthat it presets the current folder to this File object’s
parent folder and the file to this object’s associated file.

If the user clicks OK, returns a File object for the selected file. If the user cancels, returns nu11.
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seek ()
fileObj.seek (pos[, model)

pos The new current position in the file as an offset in bytes from the start, current
position, or end, depending on the mode.

mode Optional. The seek mode, one of:

» 0:Seek to absolute position, where pos=0 is the first byte of the file. This is the
default.

» 1:Seek relative to the current position.

» 2:Seek backward from the end of the file.

Seeks to the specified position in the file. The new position cannot be less than 0 or greater than the
current file size.

Returns true if the position was changed.

tell()
fileObj.tell ()

Retrieves the current position as a byte offset from the start of the file.

Returns a number, the position index.

write()
fileObj.write (text[, text...]...)

text One or more strings to write, which are concatenated to form a single string.

Writes the specified text to the file at the current position. For encoded files, writing a single
Unicode character may write multiple bytes.

NoOTE: Be careful not to write to a file that is open in another application or object, as this can
overwrite existing data.

Returns true on success.

writeln ()
fileObj.writeln (text[, text...]l...)

text One or more strings to write, which are concatenated to form a single string.

Writes the specified text to the file at the current position, and appends a Line Feed sequence in the
style specified by the 1inefeed property.For encoded files, writing a single Unicode character may
write multiple bytes.

NoTE: Be careful not to write to a file that is open in another application or object, as this can
overwrite existing data.

Returns true on success.
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Represents a file-system folder or directory in a platform-independent manner. All properties and
methods resolve file system aliases automatically and act on the original file unless otherwise noted.

To create a Folder object, use the Folder function or the new operator. The constructor accepts full or
partial path names, and returns the new object.

Folder ([pathl); //can return a File object
new Folder ([pathl); //always returns a Folder object

path  Optional. The absolute or relative path to the folder associated with this object, specified in URI
format; see “Specifying paths” on page 39. The value stored in the object is the absolute path.

The path need not refer to an existing folder. If not supplied, a temporary name is generated.
If the path refers to an existing file:
» The Folder function returns a File object instead of a Folder object.

» The new operator returns a Folder object for a nonexisting folder with the same name.

These properties are available as static properties of the Folder class. It is not necessary to create an
instance to access them.

appData Folder A Folder objectforthe folder that contains application data for all users. Read
only.

» In Windows, the value of saprpPDATAS (by default, ¢: \Documents and
Settings\All Users\Application Data)

» InMacOS, /Library/Application Support

appPackage String  In Mac OS, the Folder object for the folder that contains the bundle of the
running application. Read only.

commonFiles Folder A Folder object for the folder that contains files common to all programs.
Read only.

» InWindows, the value of $commonProgramFiless (by default,
C:\Program Files\Common Files)

» InMacOS,/Library/Application Support

current Folder A rolder object for the current folder. Assign either a Folder objectora
string containing the new path name to set the current folder.
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desktop

fs

myDocuments

startup

system

temp

trash

userData

Folder

String
Folder

Folder

Folder

Folder
Folder

Folder

A Folder object for the folder that contains the user’s desktop. Read only.

» InWindows, C:\Documents and Settings\username\Desktop

» InMacOS, ~/Desktop

The name of the file system. Read only. One of windows, Macintosh, Or Unix.
A Folder object for the user’s default document folder. Read only.

» InWindows, C:\Documents and Settings\username\My Documents
» In MacOS, ~/Documents

A Folder object for the folder containing the executable image of the running
application. Read only.

A Folder object for the folder containing the operating system files. Read
only.

» In Windows, the value of swindir$ (by default, ¢: \Windows)

» InMacOS, /system

A Folder object for the default folder for temporary files. Read only.

» In Mac OS, a Folder object for the folder containing deleted items.

» InWindows, where the Recycle Bin is a database rather than a folder, value
isnull.

Read only.

A Folder object for the folder that contains application data for the current
user. Read only.

» In Windows, the value of suserDATA% (by default, ¢: \Documents and
Settings\username\Application Data)

» InMacOS, ~/Library/Application Support
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These functions are available as a static methods of the Folder class. It is not necessary to create an
instance in order to call them.

decode ()
Folder.decode (uri)

uri String. The encoded string to decode. All special characters must be encoded in UTF-8
and stored as escaped characters starting with the percent sign followed by two
hexadecimal digits. For example, the string "my%20file" is decoded as "my file".

Special characters are those with a numeric value greater than 127, except the following:
/- _ b~ ()
Decodes the specified string as required by RFC 2396.

Returns the decoded string.

encode ()
Folder.encode (name)

name String. The string to encode.

Encodes the specified string as required by RFC 2396. All special characters are encoded in UTF-8
and stored as escaped characters starting with the percent sign followed by two hexadecimal digits.
For example, the string "my file" is encoded as "my%$20file".

Special characters are those with a numeric value greater than 127, except the following:
/- _ b~ ()

Returns the encoded string.

isEncodingAvailable ()
Folder.isEncodingAvailable (name)

name String. The encoding name. Typical values are “ASCIl,” “binary,” or “UTF-8.” See “File- and
Folder-supported encoding names” on page 45.

Checks whether a given encoding is available.

Returns true if your system supports the specified encoding, false otherwise.

selectDialog ()
Folder.selectDialog ([prompt])

prompt  QOptional. A string containing the prompt text, if the dialog allows a prompt.

Opens the built-in platform-specific file-browsing dialog, and creates a new File or Folder object
for the selected file or folder. Differs from the object method selectdlg () in that it does not
preselect a folder.

If the user clicks OK, returns a File or Folder object for the selected file or folder. If the user
cancels, returns null.



CHAPTER 3: File System Access

Folder object

These properties are available for Folder objects.

59

absoluteURI
alias

created

displayName

error

exists

fsName

fullName

localizedName

modified

name

parent

path

relativeURI

String
Boolean

Date

String
String

Boolean

String

String
String

Date

String

Folder

String

String

The full path name for the referenced folder in URI notation. Read only.
When true, the object refers to a file system alias or shortcut. Read only.

The creation date of the referenced folder, or nu11 if the object does not
refer to a folder on disk. Read only.

The localized name of the referenced folder, without the path. Read only.

A message describing the most recent file system error; see “File access
error messages” on page 44. Typically set by the file system, but a script
can set it. Setting this value clears any error message and resets the error
bit for opened files. Contains the empty string if there is no error.

When true, this object refers to a folder that currently exists in the file
system. Read only.

The platform-specific name of the referenced folder as a full path name.
Read only.

The full path name for the referenced folder in URI notation. Read only.

A localized version of the folder name portion of the absolute URI for the
referenced file, without the path specification. Read only.

The date of the referenced folder’s last modification, or nu11 if the object
does not refer to a folder on disk. Read only.

The folder name portion of the absolute URI for the referenced file,
without the path specification. Read only.

The Folder object for the folder that contains this folder, or nu11 if this
object refers to the root folder of a volume. Read only.

The path portion of the absolute URI for the referenced folder, without the
folder name. Read only.

The path name for the referenced folder in URI notation, relative to the
current folder. Read only.

These functions are available for Folder objects.

changePath ()

folderObj.changePath (path)

path

A string containing the new path, absolute or relative to the current parent folder.

Changes the path specification of the referenced folder.

Returns true on success.
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create()
folderObj.create ()

Creates a folder at the location given by this object’s path property.

Returns true if the folder was created successfully.

execute ()
folderObj.execute ()

Opens this folder in the platform-specific file browser (as if it had been double-clicked in the file
browser).

Returns true immediately if the folder was opened successfully.

getFiles ()
folderObj.getFiles ([mask])

mask Optional. A search mask for file names. A string that can contain question mark (?) and
asterisk (*) wild cards. Default is "+, which matches all file names.

Can also be the name of a function that takes a File or Folder object as its argument.
Itis called for each file or folder found in the search; if it returns true, the object is added
to the return array.

NoTE: In Windows, all aliases end with the extension . 1nk; ExtendScript strips this from
the file name when found, in order to preserve compatibility with other operating
systems. You can search for all aliases by supplying the search mask "* . 1nk", but note
that such code is not portable.

Retrieves the contents of this folder, filtered by the supplied masx.

Returns an array of File and Folder objects, or null if this object’s referenced folder does not exist.

getRelativeURI ()
folderObj.getRelativeURI ([basePath])

basepath Optional. A string containing the base path for the relative URI. Default is the current
folder.

Retrieves the path for this folder relative to the specified base path or the current folder, in URI
notation.

Returns a string containing the relative URI.

remove ()
folderObj.remove ()

Deletes the empty folder associated with this object from disk, immediately, without moving it to
the system trash. Folders must be empty before they can be deleted. Does not resolve aliases;
instead, deletes the referenced alias or shortcut file itself.

NoTE: Cannot be undone. It is recommended that you prompt the user for permission before
deleting.

Returns true if the folder is deleted successfully.
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rename ()
folderObj.rename (newName)

newName  The new folder name, with no path.

Renames the associated folder. Does not resolve aliases; instead, renames the referenced alias or
shortcut file itself.

Returns true on success.

resolve()
folderObj.resolve ()

If this object references an alias or shortcut, this method resolves that alias

Returns a new Folder object that references the file-system element to which the alias resolves, or
null if this object does not reference an alias, or if the alias cannot be resolved.

selectDlg()
folderObj.selectDlg (prompt)

prompt A string containing the prompt text, if the dialog allows a prompt.

Opens the built-in platform-specific file-browsing dialog, and creates a new File or Folder object
for the selected file or folder. Differs from the class method selectbDialog () in that it preselects
this folder.

If the user clicks OK, returns a File or Folder object for the selected file or folder. If the user
cancels, returns null.



User-Interface Tools

Adobe provides the ScriptUl component, which works with the ExtendScript JavaScript interpreter to
provide JavaScript scripts with the ability to create and interact with user interface elements. It provides an
object model for windows and user-interface control elements within an Adobe application.

» The first part of this chapter describes the features and programming model, with details of how you
can use JavaScript to build a user interface with ScriptUl objects.

» “ScriptUl object reference” on page 105 provides reference details of the objects, properties, methods,
and creation parameters. You can also choose the ScriptUI Classes dictionary from the Help menu in
the ExtendScript Toolkit to inspect the objects in the Object Model Viewer.

The sample code distributed with the Adobe ExtendScript SDK includes code examples that specifically
demonstrate different ways of building and populating a ScriptUl dialog.

Building ScriptUI dialogs

SnpCreateDialog.jsx Creates a very simple, modeless dialog (a palette) with OK
and Cancel button behavior.

SnpCreateUIAddMethod. jsx Shows how to add controls to a dialog using the add
method.

SnpCreateUIResourceSpec.jsx Shows how to define a resource string that creates the

control hierarchy in a dialog.

SnpCreateTreeView.jsx Shows how to create a hierarchical list with subitems.
SnpCreateProgressBar.jsx Shows how to create, initialize, and update a progress bar.
SnpCreateSlider.jsx Shows how to create and handle input from a slider control.
UsingFlashPlayer.jsx Shows how to create a Flash® Player, and use it to load a play

back a movie defined in an SWF file.

ActionScriptDemo.jsx Shows how to communicate between the Adobe
application scripting environment and the ActionScript™
scripting environment of the Flash Player.

ColorSelector.jsx Shows how to use the graphics objects to change colorsin a
window.

ColorPicker.jsx A more complex version of the color-selection dialog shows
how to use additional graphics objects, including fonts and
paths.

SnpAlignElements.jsx Shows how to align elements along two dimensions in order
to control the relative positions of controls within rows and
columns.
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SnpCreateDynamicScriptUI. jsx Shows how to use automatic layout, switching component
layout between “row” and “stack” orientation.

AlertBoxBuilderl.jsx Shows a way to use resource specifications. Uses the add ()
method to build a dialog that collects values from the user,
and creates a resource string from those values. Saves the

string to a file, then uses it to build a new dialog. See “Using
resource strings” on page 79.

AlertBoxBuilder2.jsx Shows another way to use a resource specification, building
the same user-input dialog itself from a resource string. See
“Using resource strings” on page 79.

SnpCustomLayoutManager . jsx Shows how to create a customized layout manager. See
“Custom layout-manager example” on page 95.

ScriptUl defines window objects that represent platform-specific windows, and various control elements
such as Button and staticText, that represent user-interface controls. These objects share a common set
of properties and methods that allow you to query the type, move the element around, set the title,
caption or content, and so on. Many element types also have properties unique to that class of elements.

ScriptUl defines the following types of windows:

» Modal dialog box: Holds focus when shown, does not allow activity in other application windows until
dismissed.

» Floating palette: Also called modeless dialog, allows activity in other application windows. (Adobe
Photoshop’ does not support script creation of palette windows.)

» Main window: Suitable for use as an application’s main window. (Main windows are not normally
created by script developers for Adobe applications. Photoshop does not support script creation of
main windows.)

To create a new window, use the window constructor function. The constructor takes the desired type of
the window. The type is "dialog" for a modal dialog, or "palette" for a modeless dialog or floating
palette. You can supply optional arguments to specify an initial window title and bounds; or you can set
the location and size separately.

The following example creates an empty dialog with the variable name d1g, which is used in subsequent
examples:

// Create an empty dialog window near the upper left of the screen
var dlg = new Window (’dialog’, 'Alert Box Builder’) ;
dlg.frameLocation = [100,100];

Initially, new windows are hidden. The show method makes them visible and responsive to user
interaction; for example:

dlg.show () ;
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Allwindows are containers—that is, they contain other elements within their bounds. Within a window, you
can create other types of container elements: Panels and Groups. These can contain control elements,
and can also contain other Panel and Group containers. However, a window cannot be added to any
container.

» Acroupisthe simplest container used to visually organize related controls. You would typically define
a group and populate it with related elements, for instance an edittext box and its descriptive
statictext label.

» Apranelisaframe object, also typically used to visually organize related controls. It has a text property
to specify a title, and can have a border to visually separate the collection of elements from other
elements of a dialog.

» A TabbedPanel is aframe that contains only Tab elements. Each Tab is a frame with a localizable title
in the selection tab, which contains a set of controls. When a tab is active, the Tab object is the value of
the TabbedPanel .selection property.

You might create a panel and populate it with several Groups, each with their own elements. You can
create nested containers, with different layout properties for different containers, in order to define a
relatively complex layout without any explicit placement.

You can add elements to any container using the add method (see “Adding elements to containers” on
page 65). An element added to a container is considered a child of that container. Certain operations on a
container apply to its children; for example, when you hide a container, its children are also hidden.

When a script creates a window and adds various user-interface elements to it, the locations and sizes of
elements and spacing between elements is known as the layout of the window. Each user-interface
element has properties which define its location and dimensions: 1ocation, size, and bounds. These
properties are initially undefined, and a script that employs Automatic layout should leave them
undefined for the main window as well as its contained elements, allowing the automatic layout
mechanism to set their values.

Your script can access these values, and (if not using auto-layout) set them as follows:

» The location of a window is defined by a Point object containing a pair of coordinates (x and y) for
the top left corner (the origin), specified in the screen coordinate system. The 1location of an element
within a window or other container is defined as the origin point specified in the container’s
coordinate system. That is, the x and y values are relative to the origin of the container.

The following examples show equivalent ways of placing the content region of an existing window at
screen coordinates [10, 50]:

win.location [10, 501;
win.location = {x:10, y:50};
win.location = "x:10, y:50";

» The size of an element’s region is defined by a Dimension object containing a width and height in
pixels.
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The following examples show equivalent ways of changing an existing window’s width and height to
200 and 100:

win.size = [200, 100];
win.size = {width:200, height:100};
win.size = "width:200, height:100";

This example shows how to change a window’s height to 100, leaving its location and width
unchanged:

win.size.height = 100;

» The bounds of an element are defined by a Bounds object containing both the origin point (x, y) and
size (width, height) To define the size and location of windows and controls in one step, use the
bounds property.

The value of the bounds property can be a string with appropriate contents, an inline JavaScript
Bounds object, or a four-element array. The following examples show equivalent ways of placing a 380
by 390 pixel window near the upper left corner of the screen:

var dlg = new Window(’dialog’, ’'Alert Box Builder’, [100,100,480,490]);
dlg.bounds = [100,100,480,490];

dlg.bounds = {x:100, y:100, width:380, height:390};

dlg.bounds = {left:100, top:100, right:480, bottom:490};

dlg.bounds = "left:100, top:100, right:480, bottom:490";

The window dimensions define the size of the content region of the window, or that portion of the window
that a script can directly control. The actual window size is typically larger, because the host platform'’s
window system typically adds title bars and borders. The bounds property for a window refers only to its
content region. To determine the bounds of the frame surrounding the content region of a window, use
the window. frameBounds property.

To add elements to a window, panel, or group, use the container’s add method. This method accepts the
type of the element to be created and some optional parameters, depending on the element type. It
creates and returns an object of the specified type.

In additions to windows, ScriptUl defines the following user-interface elements and controls:
» Panels (frames) and groups, to collect and organize other control types

Push buttons with text or icons, radio buttons, checkbox buttons

Static text or images, edit text

Progress bars, scrollbars, sliders

vV v v Vv

Lists, which include list boxes, drop-down (also called popup) lists, and tree views. Each item in a list is
a control of type item, and the parent list’s i tems property contains an array of child items. Tree views
can also have collapsible node-type items, which contain child items. You can add list items with the
parent’s add method.

You can specify the initial size and position of any new element relative to the working area of the parent
container, in an optional bounds parameter. Different types of elements have different additional
parameters. For elements which display text, for example, you can specify the initial text. See the ScriptUI
Classes dictionary in the ExtendScript Toolkit's Object Model Viewer for details.
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The order of optional parameters must be maintained. Use the value undefined for a parameter you do
not wish to set. For example, if you want to use automatic layout to determine the bounds, but still set the
title and text in a panel and button, the following creates panel and But ton elements with an initial text
value, but no bounds value:

dlg.btnPnl = dlg.add(’'panel’, undefined, ’'Build it’);
dlg.btnPnl.testBtn = dlg.btnPnl.add(’'button’, undefined, ’'Test’);

Tip: This example creates a dynamic property, btnpPnl, on the parent window object, which contains the
returned reference to the child control object. This is not required, but provides a useful way to access your
controls.

A new element is initially set to be visible, but is not shown unless its parent object is shown.

Creation properties

Some element types have attributes that can only be specified when the element is created. These are not
normal properties of the element, in that they cannot be changed during the element’s lifetime, and they
are only needed once. For these element types, you can supply an optional creation-properties
argument to the add method. This argument is an object with one or more properties that control aspects
of the element’s appearance, or special functions such as whether an edit text element is editable or Read
only. See “Control object constructors” on page 123 for details.

You can also specify the creation properties for new objects using the resource specification format; for
details, see “Resource specifications” on page 78.

All user-interface elements have an optional creation property called name, which assigns a name for
identifying that element. For example, the following creates a new But ton element with the name ok:

dlg.btnPnl.buildBtn = dlg.btnPnl.add(‘button’, undefined, ‘Build’, {name:’ok’});

NoTE: In Photoshop CS, panel coordinates were measured from outside the frame (including the title bar),
but in Photoshop CS2, panel coordinates are measured from the inside the frame (the content area). This
means that if you use the same values to set the vertical positions of child controls in a panel, the positions
are slightly different in the two versions. When you add a panel to a window, you can choose to set a
creation property (sulPanelCoordinates), which causes that panel to automatically adjust the positions
of its children; see the add method for panel. When automatic adjustment is enabled, you provide
position values that were correct for Photoshop CS, and the result is the same in Photoshop CS2, CS3, CS4,
CS5, or CC. You can also set automatic adjustment for a window; in this case, it applies to all child panels of
that window unless it is explicitly disabled in the child panel. See window object constructor.

Accessing child elements

A reference to each element added to a container is appended to the container’s children property. You
can access the child elements through this array, using a 0-based index. For controls that are not
containers, the children collection is empty.

In this example, the msgPn1 panel was the first element created in d1g, so the script can access the panel
object at index 0 of the parent’s children property to set the text for the title:

var dlg = new Window ('dialog', 'Alert Box Builder');
dlg.msgPnl = dlg.add('panel') ;
dlg.children[0] .text = 'Messages';
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If you use a creation property to assign a name to a newly created element, you can access that child by its
name, either in the children array of its parent, or directly as a property of its parent. For example, the
Button in a previous example was named ok, so it can be referenced as follows:

dlg.btnPnl.children['ok'] .text = "Build";
dlg.btnPnl.ok.text = "Build";

You can also access named elements through the parent window’s findElement () method:
var myOkButton = dlg.findElement ("ok") ;

For list controls (type 1ist and dropdown), you can access the child list-item objects through the items
array.

To remove elements from a window, Panel, Or Group, Use the container’s remove method. This method
accepts an object representing the element to be removed, or the name of the element, or the index of the
element in the container’s children collection (see “Accessing child elements” on page 66).

The specified element is removed from view if it was currently visible, and it is no longer accessible from
the container or window. The results of any further references by a script to the object representing the
element are undefined.

To remove listitems from a list, use the parent list control’s remove method in the same way. It removes the
item from the parent’s items list, hides it from view, and deletes the item object.

The following sections introduce the types of controls you can add to a window or other container element
(panel or group). For details of the properties and functions, and of how to create each type of element,
see “Control object constructors” on page 123.

These are types of control objects which are contained in windows, and which contain and group other
controls.

Panel Typically used to visually organize related controls.
» Setthe text property to define a title that appears at the top of the panel.

» Anoptional borderstyle creation property controls the appearance of the border
drawn around the panel.

You can use panels as separators: those with width of 0 appear as vertical lines and
those with height of 0 appear as horizontal lines.

var dlg = new Window(’dialog’, ‘Alert Box Builder’);
dlg.msgPnl = dlg.add(’panel’, [25,15,355,130], 'Messages’);
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Group

TabbedPanel

Tab

Used to visually organize related controls. Unlike Panels, Groups have no title or
visible border. You can use them to create hierarchies of controls, and for fine control
over layout attributes of certain groups of controls within a larger panel. For examples,
see “Creating more complex arrangements” on page 92.

A panel that contains only Tab objects as its immediate children. It has a selection
property that contains the currently active Tab child. When the value of the selection
property changes, either by a user selecting a different tab, or by a script setting the
property, the Tabbedpanel receives an onChange notification.

The title property provides an optional label; the titleLayout property places the
label within the panel.

A general container whose parent is a TabbedPanel, with a selectable tab showing a
localizable text value. Its size and position are determined by the parent.

These are types of control objects that are contained in windows, panels, and groups, and that provide
specific kinds of display and user interaction. Control instances are created by passing the corresponding
type keyword to the add () method of a window or container; see “Control types and creation parameters”

on page 124.

These examples do not set bounds explicitly on creation, because it is often more useful to set a preferred
size, then allow the layout manager to set the bounds; see “Automatic layout” on page 86.

Button

IconButton

Typically used to initiate some action from a window when a user clicks the button;
for example, accepting a dialog’s current settings, canceling a dialog, bringing up a
new dialog, and so on.

P Setthe text property to assign a label to identify a Button's function.
» The onclick callback method provides behavior.

var dlg = new Window(‘dialog’, ‘Alert Box Builder’) ;

dlg.btnPnl = dlg.add(‘panel’, undefined, ‘Build it’);

dlg.btnPnl.testBtn = dlg.btnPnl.add(‘button’, undefined, ‘Test’);

dlg.btnPnl.buildBtn = dlg.btnPnl.add(‘button’, undefined, ‘Build’,
{name:'ok"’});

dlg.btnPnl.cancelBtn = dlg.btnPnl.add(‘button’, undefined, ‘Cancel’,
{name:’cancel’});

dlg.show () ;

A button that displays an icon, with or without a text label. Like a text button, typically
initiates an action in response to a click.

» The image property identifies the icon image; see “Displaying images” on
page 72.

> Thetitle or text property provides an optional label; the titleLayout property
places the label with respect to the image.

» The onclick callback method provides behavior.
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Image

StaticText

EditText

Displays an iconic image.

» The image property identifies the icon image; see “Displaying images” on
page 72.

» The title property provides an optional label; the titleLayout property places
the label with respect to the image.

Typically used to display text strings that are not intended for direct manipulation by
a user, such as informative messages or labels.

This example creates a Panel and adds several staticText elements:

var dlg = new Window (‘dialog’, ‘Alert Box Builder’);

dlg.msgPnl = dlg.add(‘panel’, undefined, ‘Messages’);

dlg.msgPnl.titleSt = dlg.msgPnl.add(‘'statictext’, undefined,
‘Alert box title:’);

dlg.msgPnl.msgSt = dlg.msgPnl.add(‘statictext’, undefined,
‘Alert message:’);

dlg.show () ;

Allows users to enter text, which is returned to the script when the dialog is
dismissed. Text in EditText elements can be selected, copied, and pasted.

P> Setthe text property to assign the initial displayed text in the element, and read
it to obtain the current text value, as entered or modified by the user.

P Setthe textselection property to replace the current selection with new text,
or to insert text at the cursor (insertion point). Read this property to obtain the
current selection, if any.

This example adds some EditText elements, with initial values that a user can accept
or replace:

var dlg = new Window(‘'dialog’, ‘Alert Box Builder’);

dlg.msgPnl = dlg.add(‘panel’, undefined, ‘Messages’);

dlg.msgPnl.titleSt = dlg.msgPnl.add(‘'statictext’, undefined,
‘Alert box title:’);

dlg.msgPnl.titleEt = dlg.msgPnl.add(‘edittext’, undefined,
‘Sample Alert’);

dlg.msgPnl.msgSt = dlg.msgPnl.add(‘statictext’, undefined,
‘Alert message:’);

dlg.msgPnl.msgEt = dlg.msgPnl.add(‘edittext’, undefined,
‘<your message here>’, {multiline:true});

dlg.show () ;

Note the creation property on the second EditText field, where multiline:true
indicates a field in which a long text string can be entered. The text wraps to appear
as multiple lines.



CHAPTER 4: User-Interface Tools

Types of controls 70

Checkbox

RadioButton

Progressbar

Slider

Allows the user to set a boolean state.

P> Setthe text property to assign an identifying text string that appears next to the
clickable box.

» The user can click to select or deselect the box, which shows a checkmark when
selected. The value is true when it is selected (checked) and false when it is not.

When you create a Checkbox, you can set its value property to specify its initial state
and appearance.

// Add a checkbox to control the buttons that dismiss an alert box
dlg.hasBtnsCb = dlg.add(‘'checkbox’, undefined,

‘Should there be alert buttons?’) ;
dlg.hasBtnsCb.value = true;

Allows the user to select one choice among several.

P Setthe text property to assign an identifying text string that appears next to the
clickable button.

» The valueis true when the button is selected. The button shows the state in a
platform-specific manner, with a filled or empty dot, for example.

You group a related set of radio buttons by creating all the related elements one after
another. When any button’s value becomes true, the value of all other buttons in the
group becomes false. When you create a group of radio buttons, you should set the
state of one of them true:

var dlg = new Window (‘dialog’, ‘Alert Box Builder’);

dlg.alertBtnsPnl = dlg.add(‘panel’, undefined, ‘Button alignment’) ;

dlg.alertBtnsPnl.alignLeftRb = dlg.alertBtnsPnl.add(‘radiobutton’,
undefined, ‘Left’);

dlg.alertBtnsPnl.alignCenterRb = dlg.alertBtnsPnl.add(‘radiobutton’,
undefined, ‘Center’);

dlg.alertBtnsPnl.alignRightRb = dlg.alertBtnsPnl.add(‘'radiobutton’,
undefined, ‘Right’);

dlg.alertBtnsPnl.alignCenterRb.value = true;

dlg.show () ;

Typically used to display the progress of a time-consuming operation. A colored bar
covers a percentage of the area of the control, representing the percentage
completion of the operation. The value property reflects and controls how much of
the visible area is colored, relative to the maximum value (maxvalue). By default the
range is 0 to 100, so the value=50 when the operation is half done.

Typically used to select within a range of values. The slider is a horizontal bar with a
draggable indicator, and you can click a point on the slider bar to jump the indicator
to that location. The value property reflects and controls the position of the indicator,
within the range determined by minvalue and maxvalue. By default the range is 0 to
100, so setting value=50 moves the indicator to the middle of the bar.
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Scrollbar

ListBox
DropDownList
TreeView

Like a slider, the scrollbar is a bar with a draggable indicator. It also has “stepper”
buttons at each end, that you can click to jump the indicator by the amount in the
stepdelta property. If you click a point on the bar outside the indicator, the indicator
jumps by the amount in the jumpdelta property.

You can create scrollbars with horizontal or vertical orientation; if width is greater
than height, it is horizontal, otherwise it is vertical. Arguments to the add method
that creates the scrollbar define values for the value, minvalue and maxvalue
properties.

Scrollbars are often created with an associated EditText field to display the current
value of the scrollbar, and to allow setting the scrollbar’s position to a specific value.
This example creates a scrollbar with associated staticText and EditText elements
within a panel:

dlg.sizePnl = dlg.add(‘panel’, undefined, ‘Dimensions’) ;

dlg.sizePnl.widthSt = dlg.sizePnl.add(‘'statictext’, undefined,

‘Width: ") ;

dlg.sizePnl.widthScrl = dlg.sizePnl.add(‘'scrollbar’, undefined,
300, 300, 800);

dlg.sizePnl.widthEt = dlg.sizePnl.add(‘edittext’) ;

These controls display lists of items, which are represented by List Item objects in
the items property. You can access the items in this array using a 0-based index.

» AListBox control displays a list of choices. When you create the object, you
specify whether it allows the user to select only one or multiple items. If a list
contains more items than can be displayed in the available area, a scrollbar may
appear that allows the user to scroll through all the list items. A list box can
display items in multiple columns; see “Creating multi-column lists” on page 73.

» AbDropbownList control displays a single visible item. When you click the control,
a list drops down and allows you to select one of the other items in the list.
Drop-down lists can have nonselectable separator items for visually separating
groups of related items, as in a menu.

» A Treeview controlis similar to a ListBox, except that the items can have child
items. Items with children can be expanded or collapsed to show or hide the child
items. Child items can in turn contain children.

» The title property provides an optional label; the titleLayout property places
the label with respect to the list.

You can specify the choice items on creation of the list object, or afterward using the
list object’s add () method. You can remove items programmatically with the list
object’s remove () and removeall () methods.
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ListItem Items added to or inserted into any type of list control are List Item objects, with
properties that can be manipulated from a script. List Item elements can be of the
following types:

> item: the typical item in any type of list. It displays text or an image, and can be
selected. To display an image, set the item object’s image property; see
“Displaying images” on page 72.

P separator:a separator is a nonselectable visual element in a drop-down list.
Although it has a text property, the value is ignored, and the item is displayed as
a horizontal line.

P node: adisplayable and selectable item in a Treeview control which can contain
other ListItem objects, including other items of type node.

FlashPlayer Runs a Flash movie within a ScriptUl window. Its control’s methods allow you to load a
movie from an SWF file and control the playback. See “FlashPlayer control functions”
on page 145.

You can also use the control object to communicate with the Flash application, calling
ActionScript methods, and making JavaScript methods defined in your Adobe
application script available to the Flash ActionScript code. See “Calling ActionScript
functions from a ScriptUI script” on page 86.

The title property provides an optional label; the titleLayout property places the
label with respect to the player.

You can display icon images in Tmage or IconButton controls, or display images in place of strings or in
addition to strings as the selectable items in a Listbox or DropdownList control. In each case, the image
is defined by setting the element’s image property. You can set it to a ScriptUlimage object; a named icon
resource; a File object; or the pathname of a file containing the iconic image, or of an alias or shortcut to
that file (see “Specifying paths” on page 39).

The image data for an icon can be in Portable Network Graphics (PNG) format, or in Joint Photographic
Experts Group (JPEG) format. See http://www.libpng.org and http://www.jpeg.org/ for detailed
information on these formats.

You can set or reset the image property at any time to change the image displayed in the element.

The scripting environment can define icon resources, which are available to scripts by name. To specify an
icon resource, set a control’s image property to the resource’s JavaScript name, or refer to the resource by
name when creating the control. For example, to create a button with an application-defined icon
resource:

myWin.upBtn = myWin.add ("iconbutton", undefined, "SourceFolderIcon");

Photoshop CC, for example, defines these icon resources:

SteplIcon

Step2Icon

Step3Icon

Step4Icon
SourceFolderIcon
DestinationFolderIcon


http://www.libpng.org
http://www.jpeg.org/
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If a script does not explicitly set the preferredsize or size property of an element that displays a icon
image, the value of preferredsize is determined by the dimensions of the iconic image. If the size values
are explicitly set to dimensions smaller than those of the actual image graphic, the displayed image is
clipped. If they are set to dimensions larger than those of the image graphic, the displayed image is
centered in the larger space. An image is never scaled to fit the available space.

In list controls (ListBox, DropDownlList, TreeView), a set of Listltem objects represents the individual
choices in the list. Each choice can be labeled with a localizable string, an image, or both, as specified by
the text and image properties of the Listltem (see “Displaying images” on page 72).

You can define a ListBox to have multiple columns, by specifying the numberofcolumns creation
parameter. By default, the number of columns is 1. If you specify multiple columns, you can also use the
creation parameters to specify whether headers are shown, and the header text for each column.

If you specify more than one column, each Listltem object that you add to the box specifies one selectable
row. The text and image of the Listltem object specifies the label in the first column, and the subitems
property specifies labels that appear in that row for the remaining columns.

The subitems value is an array, whose length is one less than the number of columns. That is, the first
member, ListTtem. subitems [0], specifies the label in the second column. Each member specifies one
label, as a JavaScript object with two properties:

{ text : displayString , image : imageFileReference }

For example, the following fragment defines a list box with two columns, and specifies the labels in each
column for the two choices:

// create list box with two titled columns

var list = dlg.add ('ListBox', [0, 0, 150, 75], 'asd',
{numberOfColumns: 2, showHeaders: true,
columnTitles: ['First Name', 'Last Name']});

// add an item for the first row, with the label value for the first column
var iteml = list.add ('item',6 'John');

// add the label value for the second column in that row.
iteml.subItems[0] .text = 'Doe’;

// add an item for the second row, with the text for the first column label
var item2 = list.add ('item',6 'Jane');

// add the label text and image for the second column in the second row
item2.subItems [0] .text = 'Doe';

item2.subItems[0] .image = File ("~/Desktop/Stepl.png") ;

This creates a control that looks like this:
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: X

Firsk Mame  Last Mame

Johin Doe
Jane Doe

Notice that the columns have headers, and the label in the second column of the second row has both text
and an image.

Static functions on the window class are globally available to display short messages in standard dialogs.
The host application controls the appearance of these simple dialogs, so they are consistent with other
alert and message boxes displayed by the application. You can often use these standard dialogs for simple
interactions with your users, rather than designing special-purpose dialogs of your own.

Use the static functions alert, confirm, and prompt on the window class to invoke these dialogs with your
own messages. You do not need to create a window object to call these functions.

A modal dialog is initially invisible. Your script invokes it using the show method, which does not return
until the dialog has been dismissed. The user can dismiss it by using a platform-specific window gesture,
or by using one of the dialog controls that you supply, typically an OK or Cancel button. The onclick
method of such a button must call the close or hide method to close the dialog. The close method
allows you to pass a value to be returned by the show method.

For an example of how to define such buttons and their behavior, see “Defining behavior with event
callbacks and listeners” on page 80.

Creating and using modal dialogs

A dialog typically contains some controls that the user must interact with, to make selections or enter
values that your script will use. In some cases, the result of the user action is stored in the object, and you
can retrieve it after the dialog has been dismissed. For example, if the user changes the state of a checkbox
or RadioButton, the new state is found in the control’s value property.

However, if you need to respond to a user action while the dialog is still active, you must assign the control
a callback function for the interaction event, either onclick or onChange. The callback function is the
value of the onclick or onChange property of the control.

For example, if you need to validate a value that the user enters in a edittext control, you can do soin an
onChange callback handler function for that control. The callback can perform the validation, and perhaps
display an alert to inform the user of errors.

Sometimes, a modal dialog presents choices to the user that must be correct before your script allows the
dialog to be dismissed. If your script needs to validate the state of a dialog after the user clicks OK, you can
define an onclose event handler for the dialog. This callback function is invoked whenever a window is
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closed. If the function returns true, the window is closed, but if it returns false, the close operation is
cancelled and the window remains open.

Your oncClose handler can examine the states of any controls in the dialog to determine their correctness,
and can show alert messages or use other modal dialogs to alert the user to any errors that must be
corrected. It can then return true to allow the dialog to be dismissed, or false to allow the user to correct
any errors.

Dismissing a modal dialog

Every modal dialog should have at least one button that the user can click to dismiss the dialog. Typically
modal dialogs have an OK and a Cancel button to close the dialog with or without accepting changes that
were made in it.

You can define onc1ick callbacks for the buttons that close the parent dialog by calling its c1ose method.
You have the option of sending a value to the c1ose method, which is in turn passed on to and returned
from the show method that invoked the dialog. This return value allows your script to distinguish different
closing events; for example, clicking OK can return 1, clicking Cancel can return 2. However, for this typical
behavior, you do not need to define these callbacks explicitly; see “Default and cancel elements” on

page 75.

For some dialogs, such as a simple alert with only an OK button, you do not need to return any value. For
more complex dialogs with several possible user actions, you might need to distinguish more outcomes. If
you need to distinguish more than two closing states, you must define your own closing callbacks rather
than relying on the default behavior.

If, by mistake, you create a modal dialog with no buttons to dismiss it, or if your dialog does have buttons,
but their onc1ick handlers do not function properly, a user can still dismiss the dialog by typing ESC. In this
case, the system will execute a call to the dialog’s c1ose method, passing a value of 2. This is not, of course,
arecommended way to design your dialogs, but is provided as an escape hatch to prevent the application
from hanging in case of an error in the operations of your dialog.

Default and cancel elements

The user can typically dismiss a modal dialog by clicking an OK or Cancel button, or by typing certain
keyboard shortcuts. By convention, typing ENTER is the same as clicking OK or the default button, and
typing Esc is the same as clicking Cancel. The keyboard shortcut has the same effect as calling not i fy for
the associated button control.

To determine which control is notified by which keyboard shortcut, set the bialog object’s
defaultElement and cancelElement properties. The value is the control object that should be notified
when the user types the associated keyboard shortcut.

» For buttons assigned as the defaultElement, if there is no onclick handler associated with the
button, clicking the button or typing ENTER calls the parent dialog’s c1ose method, passing a value of 1
to be returned by the show call that opened the dialog.

» For buttons assigned as the cancelElement, if there is no onclick handler associated with the
button, clicking the button or typing Esc calls the parent dialog’s c1ose method, passing a value of 2
to be returned by the show call that opened the dialog.

If you do not set the defaultElement and cancelElement properties explicitly, ScriptUl tries to choose
reasonable defaults when the dialog is about to be shown for the first time. For the default element, it
looks for a button whose name or text value is "ox" (disregarding case). For the cancel element, it looks for
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a button whose name or text value is "cancel" (disregarding case). Because it looks at the name value first,
this works even if the text value is localized. If there is no suitable button in the dialog, the property value
remains null, which means that the keyboard shortcut has no effect in that dialog.

To make this feature most useful, it is recommended that you always provide the name creation property
for buttons meant to be used in this way.

ScriptUl defines objects to represent the complex values of properties that place and size windows and
user-interface elements. These objects cannot be created directly, but are created when you set the
corresponding property. That property then returns that object. For example, the bounds property returns
a Bounds object.

You can set these properties as objects, strings, or arrays.

» e.prop = Object — The object must contain the set of properties defined for this type, as shown in
the table below. The properties have integer values.

» e.prop = String— The string must be an executable JavaScript inline object declaration,
conforming to the same object description.

» e.prop = Array — The array must have integer coordinate values in the order defined for this type,
as shown in the table below. For example:

The following examples show equivalent ways of placing a 380 by 390 pixel window near the upper left
corner of the screen:

var dlg = new Window (’dialog’, 'Alert Box Builder’) ;

dlg.bounds = {x:100, y:100, width:380, height:390}; //object
dlg.bounds = {left:100, top:100, right:480, bottom:490}; //object
dlg.bounds = "x:100, y:100, width:380, height:390"; //string
dlg.bounds = "left:100, top:100, right:480, bottom:490"; //string
dlg.bounds = [100,100,480,490]; //array

You can access the resulting object as an array with values in the order defined for the type, or as an object
with the properties supported for the type.

The following table shows the property-value object types, the element properties that create and contain
them, and their array and object-property formats.
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Bounds

Dimension

Margins

Point

Defines the boundaries of a window within the screen’s coordinate space, or of a
user-interface element within the container’s coordinate space. Contains an array, [left,
top, right, bottom], that defines the coordinates of the upper left and lower right
corners of the element.

A Bounds object is created when you set an element’s bounds property, and this property
returns a Bounds object.

» An object must contain properties named left, top, right, bottom, Or %, y, width,
height.

» Anarray must have values in the order [1eft, top, right, bottom].

Defines the size of a window or user-interface element. Contains an array, [width,
height], that defines the element’s size in pixels.

A Dimension object is created when you set an element’s size or preferredSize
property. (A preferredsize of -1 causes the size to be calculated automatically.)

» An object must contain properties named width and height.
» Anarray must have values in the order [width, height].

Defines the number of pixels between the edges of a container and its outermost child
elements. Contains an array [left, top, right, bottom] whose elements define the
margins between the left edge of a container and its leftmost child element, and so on.

A Margins object is created when you set an element’s margins property.
» An object must contain properties named left, top, right, and bottom.
» Anarray must have values in the order [left, top, right, bottom].

You can also set the margins property to a number; all of the array values are then set to
this number.

Defines the location of a window or user-interface element. Contains an array, [x, yI,
whose values represent the origin point of the element as horizontal and vertical pixel
offsets from the origin of the element's coordinate space.

A Point object is created when you set an element’s 1ocation property.
» Anobject must contain properties named x and y.

» Anarray must have values in the order [x, yI.

ScriptUl allows you to draw directly on controls to customize their appearance. You do this by calling
methods of the ScriptUIGraphics object in response to the onDraw event (see “Defining behavior with
event callbacks and listeners” on page 80). These methods take as parameters a number of helper objects

that encapsulate drawing information, including the following:
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ScriptUIGraphics Encapsulates the drawing methods. The graphics object is associated with each
control is found in the control object’s graphics property.

ScriptUIBrush Describes the brush used to paint textures in a control.
ScriptUIFont Describes the font used to write text into a control.
ScriptUIImage Describes an image to be drawn in a control.

ScriptUIPath Describes a drawing path for a figure to be drawn into a control.
ScriptUIPen Describes the pen used to draw lines in a control.

For details of these objects, see “Graphic customization objects” on page 155.

The scriptUIGraphics object contains methods that create the other graphics objects; for example,
ScriptUIGraphics.newBrush () creates a ScriptUIBrush instance with a specific color. These graphic
objects are then used as property values in the scriptUIGraphics object, which controls how a
user-interface element is drawn on the screen. For example, if you put the new Brush object in the
backgroundColor property, the element is drawn using that color for the background.

To make the background of a window light gray, you could use this code:
g = myWindow.graphics;
myBrush = g.newBrush(g.BrushType.SOLID COLOR, [0.75, 0.75, 0.75, 1]);

g.backgroundColor = myBrush;

These examples in the Adobe ExtendScript SDK demonstrates how to use graphic customization objects:

ColorSelector.jsx  Uses graphic objects to change the background color of a window as the user
selects the color value with a slider.

ColorPicker.jsx A more complex version of the color-selection dialog shows how to use
additional graphics objects, including fonts and paths.

In addition, the Custom element class allows you to define completely customized elements of several
types (ranges, buttons, lists), whose appearance is rendered entirely by your onDraw implementation.

You can create one or more user-interface elements at a time using a resource specification. This specially
formatted string provides a simple and compact means of creating an element, including any container
element and its component elements. The resource-specification string is passed as the type parameter to
the window () oradd () constructor function.

The general structure of a resource specification is an element type specification (such as dialog),
followed by a set of braces enclosing one or more property definitions.

var myResource = "dialog{ control specs }";
var myDialog = new Window ( myResource ) ;

Controls are defined as properties within windows and other containers. For each control, give the class
name of the control, followed by the properties of the control enclosed in braces. For example, the
following specifies a button:
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testBtn: Button { text: ’'Test’ }
The following resource string specifies a panel that contains grouped staticText and EditText controls:

"msgPnl: Panel { orientation:’column’, alignChildren: [’right’, ’top’],\
text: 'Messages’, \
title: Group { \
st: StaticText { text:’Alert box title:’ }, \
et: EditText { text:’Sample Alert’, characters:35 } \
}

msg: Group { \
st: StaticText { text:’Alert message:’ }, \
et: EditText { properties:{multiline:true}, \
text:’<your message here>’ \
P

}ll

The property with name properties specifies creation properties; see “Creation properties” on page 66.

A property value can be specified as nu11, true, false, a string, a number, an inline array, or an object.
» Aninline array contains one or more values in the form:

[value, value,...]
» Anobject can be an inline object, or a named object, in the form:

{classname inlineObject}

In this case, the classname must be one of the control class names list in “Types of controls” on
page 67.

» Aninline object contains one or more properties, in the form:

{propertyName:propertyvalue,propertyName:propertyValue,... }

These examples in the Adobe ExtendScript SDK demonstrate how to use resource specification strings:

AlertBoxBuilderl.jsx Demonstrates one way to use resource strings, creating a dialog that allows
the user to enter some values, and then using those values to construct the
resource string for a customizable alert dialog.

AlertBoxBuilder2.jsx Constructs the same dialog, using a resource string (rather than the add ()
method) to specify all of the dialog contents for the user-input dialog.

The two Alert Box Builder examples create the same dialog to collect values from the user.
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Alert Box Builder

— Messages
Alert box title: Sample Alert

<your message here>
Alert message:

Message width: & 150

Message height: 20

E Has alert buttons?

— Button alignment
‘ () Left @ Center Right

L &

Build it
( Test ) € Build ) ( Cancel )

The Build button event handler builds a resource string from the collected values, and returns it from the
dialog invocation function; the script then saves the resource string to a file. That resource string can later
be used to create and display the user-configured alert box.

The resource specification format can also be used to create a single element or container and its child
elements. For instance, if the alertBuilderResource in the example did not contain the panel
btnPnlResource, you could define that resource separately, then add it to the dialog as follows:

var btnPnlResource =
"btnPnl: Panel { orientation:’row’, \
text: ‘Build it’, \
testBtn: Button { text:’Test’ }, \
buildBtn: Button { text:’Build’, properties:{name:’'ok’} }, \
cancelBtn: Button { text:’Cancel’, properties:{name:’cancel’} } \
|
dlg = new Window (alertBuilderResource) ;
dlg.btnPnl = dlg.add(btnPnlResource) ;
dlg.show () ;

You must define the behavior of your controls in order for them to respond to user interaction. You can do
this by defining event-handling callback functions as part of the definition of the control or window. To
respond to a specific event, define a handler function for it, and assign a reference to that function in the
corresponding property of the window or control object. Different types of windows and controls respond
to different actions, or events:

» Windows generate events when the user moves or resizes the window. To handle these events, define
callback functions for onMove, onMoving, onResize, and onResizing. To respond to the user opening
or closing the window, define callback functions for onShow and onClose.
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» Button, RadioButton, and Checkbox controls generate events when the user clicks within the control
bounds. To handle the event, define a callback function for onClick.

» EditText, Scrollbar, and Slider controls generate events when the content or value changes—that is,
when the user types into an edit field, or moves the scroll or slider indicator. To handle these events,
define callback functions for onChange and onChanging.

» ListBox, DropDownlList, and TreeView controls generate events whenever the selection in the list
changes. To handle the event, define a callback function for onChange. The TreeView control also
generates events when the user expands or collapses a node, handled by the onExpand and
onCollapse callback functions.

» The ListBox also generates an event when the user double-clicks an item. To handle it, define a
callback function for the onDoubleClick event.

» Both containers and controls generate events just before they are drawn, that allow you to customize
their appearance. To handle these events, define callback functions for onDraw. Your handler can
modify or control how the container or control is drawn using the methods defined in the control’s
associated ScriptUIGraphics object.

» In Windows only, you can register a key sequence as a shortcutKey for a window or for most types of
controls. To handle the key sequence, define a callback function for onShortcutKey in that control.

Your script can define an event handler as a named function referenced by the callback property, or as an
unnamed function defined inline in the callback property.

» If you define a named function, assign its name as the value of the corresponding callback property.
For example:

function hasBtnsCbOnClick () { /* do something interesting */ }
hasBtnsCb.onClick = hasBtnsCbOnClick;

» Forasimple, unnamed function, set the property value directly to the function definition:
UI-element.callback-name = function () { handler-definition};
Event-handler functions take no arguments.

For example, the following sets the onclick property of the hasBtnscb checkbox to a function that
enables another control in the same dialog:

hasBtnsCb.onClick = function ()
{ this.parent.alertBtnsPnl.enabled = this.value; };

The following statements set the onc1ick event handlers for buttons that close the containing dialog,
returning different values to the show method that invoked the dialog, so the calling script can tell which
button was clicked:

buildBtn.onClick = function () { this.parent.parent.close(l); };
cancelBtn.onClick = function () { this.parent.parent.close(2); };
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You can simulate user actions by sending an event notification directly to a window or control with the
notify method. A script can use this method to generate events in the controls of a window, as if a user
was clicking buttons, entering text, or moving the window. If you have defined an event-handler callback
for the element, the not i fy method invokes it.

The not i fy method takes an optional argument that specifies which event it should simulate. If a control
can generate only one kind of event, notification generates that event by default.

The following controls generate the onclick event:

Button
Checkbox
IconButton
RadioButton

The following controls generate the onchange event:

DropDownList
EditText
ListBox
Scrollbar
Slider
TreeView

The following controls generate the onchanging event:

EditText
Scrollbar
Slider

In the ListBox, double-clicking an item generates the onDoubleclick event.

In RadioButton and Checkbox controls, the boolean value property automatically changes when the
user clicks the control. If you use notify () to simulate a click, the value changes just as if the user had
clicked. For example, if the value of a checkbox hasBtnscCb is true, this code changes the value to false:

if (dlg.hasBtnsCb.value == true) dlg.hasBtnsCb.notify() ;
// dlg.hasBtnsCb.value is now false

Another way to define the behavior of your windows and controls is register a handler function that
responds to a specific type of event in that window or control. This technique allows you to respond to the
cascading of an event through a hierarchy of containers and controls.

Use windowob;j .addEventListener() or controlobj.addEventListener() to register a handler. The function
you register receives an event object (from the UIEvent base class) that encapsulates the event
information. As an event cascades down through a hierarchy and back up through the hierarchy, your
handler can respond at any level, or use the UTEvent object’s stopPropagation() method to stop the event
propagation at some level.

You can register:

» The name of a handler function defined in the extension that takes one argument, the event object.
For example:
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myButton.addEventListener( ’‘click’, myFunction ) ;

» Alocally defined handler function that takes one argument, the event object. For example:

myButton.addEventListener ( ‘click’, ’function(e){/*handler code*/}');

The handler or registered code statement is executed when the specified event occurs in the target. A
script can programmatically simulate an event by creating an event objects with
ScriptUI.events.events.createEvent(), and passing it to an event target’s dispatchEvent() function.

You can remove a handler that has been previously registered by calling the event target'’s
removeEventListener() function. The parameters you pass to this function must be identical to those

passed to the addEventListener() call that registered the handler. Typically, a script would register all event

handlers during initialization, and unregister them during termination; however, unregistering handlers
on termination is not required.

You can register for an event in a parent or ancestor object of the actual target; see the following section.

The predefined types of uEvent correspond to the event callbacks, as follows:

Callback UlEvent type
onChange change

onChanging changing

onClick click (detail = 1)
onDoubleClick click (detail = 2)
onEnterKey enterKey

onMove move

onMoving moving

onResize resize

onResizing resizing

onShow show

onActivate focus
onDeactivate blur

In addition, ScriptUl implements all types of W3C events according to the W3C DOM level 3 functional
specification (http://www.w3.0rg/TR/DOM-Level-3-Events/events.html), with these modifications and

exceptions:

» ScriptUl does not implement the hasFeature () method of the boMImplementation interface; there
is no way to query whether a given W3C DOM feature is implemented in ScriptUI.

» In ScriptUIl, the W3C EventTarget interface is implemented by Ul element objects (such as Button,

Window, and so on).

» In ScriptUIl, the W3C abstractview object is a Ul element (such as Button, Window, and so on).

» None of the "namespace" properties or methods are supported (such as initEventNs and

initMouseEventNs).


http://www.w3.org/TR/DOM-Level-3-Events/events.html
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The ScriptUl implementation of W3C mouse events follows the W3C DOM level 3 functional specification
(http://www.w3.0rg/TR/DOM-Level-3-Events/events.html#Events-eventgroupings-mouseevents), with
these differences:

» To create a MouseEvent instance, call ScriptUI.events.createEvent ('MouseEvent '), rather than
DocumentEvent .createEvent ('MouseEvent').

» ThegetModifierstate method of the MouseEvent interface is not supported.

The ScriptUl implementation of W3C keyboard events follows the W3C DOM level 3 functional
specification {http://www.w3.0rg/TR/DOM-Level-3-Events/events.ntml#Events-KeyboardEvent).

When an event occurs in a target, all handlers that have been registered for that event and target are
called. Multiple event handlers can be registered for the same event in different targets, even in targets of
the same type. For example, if there is a dialog with two checkboxes, you might want to register a click
handler for each checkbox object. You would do this, for example, if each checkbox reacts differently to
the click.

You can also register events for child objects with a parent object. If both checkboxes should react the
same way to a mouse click, they require the same handler. In this case, you can register the handler with
the parent window or container instead. When the c11ick event occurs in either child control, the handler
registered for the parent window is called.

You can combine these two techniques, so that more than one action occurs in response to the event. That
is, you can register a general event handler with the parent, and register a different, more specific handler
for the same event with the child object that is the actual target.

The rules for how multiple event handlers are called depend on three phases of event propagation, as
follows:

» Capture phase — When an event occurs in an object hierarchy, it is captured by the topmost ancestor
object at which a handler is registered (the window, for example). If no handler is registered for the
topmost ancestor, ScriptUl looks for a handler for the next ancestor (the dialog, for example), on down
through the hierarchy to the direct parent of actual target. When ScriptUI finds a handler registered for
any ancestor of the target, it executes that handler then proceeds to the next phase.

> At-target phase — ScriptUI calls any handlers that are registered with the actual target object.

» Bubble phase — The event bubbles back out through the hierarchy; ScriptUl again looks for handlers
registered for the event with ancestor objects, starting with the immediate parent, and working back
up the hierarchy to the topmost ancestor. When ScriptUI finds a handler, it executes it and the event
propagation is complete.

For example, suppose a dialog window contains a group which contains a button. A script registers an
event handler function for the c1ick event at the window object, another handler at the group object, and
a third handler at the but ton object (the actual target).

When the user clicks the button, the window object’s handler is called first (during the capture phase), then
the button object’s handler (during the at-target phase). Finally, ScriptUI calls the handler registered with
the group object (during the bubble phase).

If you register a handler at an ancestor object of the actual event target, you can specify the third
argument to addEventListener(), so that the ancestor’s handler responds only in the capture phase, notin
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the bubbling phase. For example, the following click handler, registered with the parent dialog object,
responds only in the capture phase:

myDialog.addEventListener ("click", handleAllItems, true);

This value is false by default, so if it is not supplied, the handler can respond only in the bubbling phase
when the object’s descendent is the target, or when the object is itself the target of the event (the
at-target phase).

To distinguish which of multiple registered handlers is being executed at any given time, the event object
provides the eventPhase property, and the currentTarget property, which In the capture and bubbling
phases contains the ancestor of the target object at which the currently executing handler was
registered.

ScriptUl supports a Flash Player, which runs the Flash application within a window in an Adobe
application. The Flash application runs ActionScript, a different implementation of JavaScript from the
ExtendScript version of JavaScript that Adobe applications run.

To open a Flash Player, add a control of type flashplayer to your ScriptUl window. A control object of this
type contains functions that allow your script to load SWF files and control movie playback. It also contains
functions that allow your Adobe application script to communicate with the ActionScript environment of
the Flash application. See “FlashPlayer control functions” on page 145.

A limited set of data types can be passed between the two scripting environments:

Number
String
Boolean
Null
undefined
Object
Array

The ActionScript c1ass and date objects are not supported as parameter values.

In the ActionScript script for your Flash application, you must prepare for two-way communication by
providing access to the External API. Do this by importing the ExternalInterface class into your Flash
application:

import flash.external.ExternallInterface;

Calling ExtendScript functions from ActionScript

The ActionScript ExternalInterface class allows you to call an ExtendScript function that has been
defined in the FlashPlayer element in the Adobe application script, and run it in the ActionScript
environment. You must define the method in your FlashPlayer element with a matching function name.

For example, in order for the SWF code to call an ExtendScript function named myExtendScriptFunction,
define a function with the name myExtendScriptFunction as a method of your Flashplayer control
object. There are no special requirements for function names, but the function must take and return only
data of the supported types.
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You do not need to register the ExtendScript function in the ActionScript environment. Your ActionScript
script can simply call the external function using the ExternalInterface.call () method:

var res = ExternalInterface.call ("myJavaScriptFunction") ;

When the Flash Player executes the ExternalInterface call, ScriptUl looks for a function with the same
name as a method of the F1ashpPlayer element, and invokes it with the specified arguments. In the
context of the function, the JavaScript this object refers to the F1ashplayer object.

Calling ActionScript functions from a ScriptUlI script

From the ExtendScript side, use the FlashPlayer method invokePlayerFunction() to call ActionScript
methods that have been defined within the Flash application:

result = flashElement.invokePlayerFunction ("ActionScript_function_name",
[argl, ..., argN] );

You can use the optional arguments to pass data (of supported types) to the ActionScript method.

Before you can call any ActionScript function from your Adobe application script, your Flash application
must register that function with the ExternalInterface object, as a callback from the Flash container. To
register a function, use the ExternalInterface.addCallback () method:

public static addCallback (methodName:String, instance:0bject, method:Function) ;
This registers a function defined in your Adobe application script named getActionScriptArray ():

ExternalInterface.addCallback ("getActionScriptArray", this, getActionScriptArray) ;

Flash Examples

These examples in the Adobe ExtendScript SDK demonstrate how to use the Flash Player:

UsingFlashPlayer.jsx Shows how to create a Flash Player, and use it to load a play back a
movie defined in an SWF file.

ActionScriptDemo. jsx Shows how to communicate between the Adobe application scripting
environment and the ActionScript scripting environment of the Flash
Player.

When a script creates a window and its associated user-interface elements, it can explicitly control the size
and location of each element and of the container elements, or it can take advantage of the automatic
layout capability provided by ScriptUl. The automatic layout mechanism uses certain available information
about user-interface elements, along with a set of layout rules, to establish a visually pleasing layout of the
controls in a dialog, automatically determining the proper sizes for elements and containers.

Automatic layout is easier to program than explicit layout. It makes a script easier to modify and maintain,
and easier to localize for different languages. It also makes the script automatically adapt to the default
font and font size used by the host application for ScriptUl windows.
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The script programmer has considerable control over the automatic layout process. Each container has an
associated layout manager object, specified in the 1ayout property. The layout manager controls the sizes
and positions of the contained elements, and also sizes the container itself.

There is a default layout manager object, or you can create a new one:

myWin.layout = new AutoLayoutManager (myWin) ;

By default, the autoLayoutManager object implements the default layout behavior. A script can modify
the properties of the default layout manager object, or create a new, custom layout manager if it needs
more specialized layout behavior. See “Custom layout-manager example” on page 95.

Child elements of a container can be organized in a single row or column, or in a stack, where the elements
overlap one other in the same region of the container, and only the top element is fully visible. This is
controlled by the container’s orientation property, which can have the value row, column, or stack.

You can nest Panel and Group containers to create more complex organizations. For example, to display
two columns of controls, you can create a panel with a row orientation that in turn contains two groups,
each with a column orientation.

Containers have properties to control inter-element spacing and margins within their edges. The layout
manager provides defaults if these are not set.

The alignment of child elements within a container is controlled by the alignchildren property of the
container, and the alignment property of the individual controls. The alignchildren property
determines an overall strategy for the container, which can be overridden by a particular child element’s
alignment value.

A layout manager can determine the best size for a child element through the element’s preferredsize
property. The value defaults to dimensions determined by ScriptUl based on characteristics of the control
type and variable characteristics such as a displayed text string, and the font and size used to display text.
A value of -1 for either the width or height in the preferredsize value causes the layout manager to
calculate that dimension, while using the specified value for the other.

For details of how you can set these property values to affect the automatic layout, see “Automatic layout
properties” on page 87.

NorTE: The default font and font size are chosen differently on different platforms, and by different
applications on the same platform, so ScriptUl windows that are created the same way can appear
different in different contexts.

Your script establishes rules for the layout manager by setting the values of certain properties, both in the
container object and in the child elements. The following examples show the effects of various
combinations of values for these properties. The examples are based on a simple window containing a
StaticText, Button and EditText element, created (using Resource specifications) as follows:

var w = new Window (
"window { \
orientation: ‘row’, \
st: StaticText { }, \
pb: Button { text: 'OK’ }, \
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et: EditText { characters:4, justify:’right’ } \
P

w.show () ;

Each example shows the effects of setting particular layout properties in various ways. In each window, w.
text is set so that the window title shows which property is being varied, and w. st . text is set to display
the particular property value being demonstrated.

Container orientation

The orientation property of a container specifies the organization of child elements within it. It can have
these values:

» row— Child elements are arranged next to each other, in a single row from left to right across the
container. The height of the container is based on the height of the tallest child element in the row,
and the width of the container is based on the combined widths of all the child elements.

» column — Child elements are arranged above and below each other, in a single column from top to
bottom across the container. The height of the container is based on the combined heights of all the
child elements, and the width of the container is based on the widest child element in the column.

» stack — Child elements are arranged overlapping one another, as in a stack of papers. The elements
overlie one another in the same region of the container. Only the top element is fully visible. The
height of the container is based on the height of the tallest child element in the stack, and the width of
the container is based on the widest child element in the stack.

The following figure shows the results of laying out the sample window with each of these orientations:

emn orientation & O () orientation & O () orientation

orientation=column

orientation=row [ OK orientation=stack

(oK )

Aligning children

The alignment of child elements within a container is controlled by two properties: alignChildren in the
parent container, and alignment in each child. The alignchildren value in the parent container controls
the alignment of all children within that container, unless it is overridden by the alignment value set on an
individual child element.

These properties use the same values, which specify alignment along one axis, depending on the
orientation of the container. You can specify an array of two of these strings, to specify alignment along
both axes. The first string specifies the horizontal value, the second specifies the vertical value. The
property values are not case-sensitive; for example, the strings F11.1, Fi11, and £i11 are all valid.

You can also set the value using the corresponding constants from the Alignment property of the ScriptUI
class; for example:

myGroup.alignment = [ScriptUI.Alignment.LEFT,
ScriptUI.Alignment.TOP]
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If you set the alignment value using a constant and then query the property, it returns an index number
corresponding to the constant, rather than a string value.

Elements in a row can be aligned along the vertical axis, in these ways:

» top — The element’s top edge is located at the top margin of its container.

» bottom — element’s bottom edge is located at the bottom margin of its container.

» center — The element is centered within the top and bottom margins of its container.

» £ill — The element’s height is adjusted to fill the height of the container between the top and
bottom margins.

Elements in a column can be aligned along the horizontal axis, in these ways:

» left — The element’s left edge is located at the left margin of its container.

» right — The element’s right edge is located at the right margin of its container.

» center — The element is centered within the right and left margins of its container.

» £ill — The element’s width is adjusted to fill the width of the container between the right and left
margins.

Elements in a stack can be aligned along either the vertical or the horizontal axis, in these ways:

» top — The element’s top edge is located at the top margin of its container, and the element is
centered within the right and left margins of its container.

» bottom— element’s bottom edge is located at the bottom margin of its container, and the element is
centered within the right and left margins of its container.

» left — element’s left edge is located at the left margin of its container, and the element is centered
within the top and bottom margins of its container.

» right — The element’s right edge is located at the right margin of its container, and the element is
centered within the top and bottom margins of its container.

» center — The element is centered within the top, bottom, right and left margins of its container.

» fill — The element’s height is adjusted to fill the height of the container between the top and
bottom margins., and the element’s width is adjusted to fill the width of the container between the
right and left margins.

The following figure shows the results of creating the sample window with row orientation and the
bottomand top alignment settings in the parent’s alignchildren property:
enn alignChildren ® O 7 alignChildren

pEn——— alignChildren=top (oK
alignChildren=bottom (__ OK ) i . I

The following figure shows the results of creating the sample window with column orientation and the
right, left, and £i11 alignment settings in the parent’s alignchildren property. Notice how in the
£i11 case, each element is made as wide as the widest element in the container:
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® O O alignChild... & O O alignChild... & O O alignChil...
alignChildren=left alignChildren=right alignChildren=fill

You can override the container’s child alignment, as specified by alignchildren, by setting the
alignment property of a particular child element. The following diagram shows the result of setting
alignment to right for the EditText element, when the parent’s alignchildren value is left:

& O ) alignment=right

override alignChildren=left

Alignment in two dimensions

You can set the alignment property with a two-string array instead of a single string, where the first string
is the horizontal alignment and the second is the vertical alignment. This allows you to control the
horizontal placement of children in a container with row orientation, and the vertical placement of
children in a container with column orientation.

The following figures show the results of the sample script snpalignElements. jsx, that demonstrates
how to specify alignment in two dimensions.

» Inthe first, each control is centered vertically within its row, and placed at a specific horizontal
position, using an alignment value such as ['1eft', 'center'] foreach element:

8a0aAa Horizontal alignment in rows

Demonstrate horizontal placement of elements within
groups with row orientation

H center right
EE right
E right right
left fill right

» The vertical alignment example creates four columns, and places the controls within each column
along the vertical axis. It uses alignment values suchas ['£i11', 'top'] todistribute controls within
the column, while still controlling the relative vertical positions:
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O 0 O Vertical alignment in columns

Demonstrate top top top top
vertical placement — -
of elements within top fill
groups with

column orientation || center

bottom

bottom  bottom  bottom  bottom

Setting margins

The margins property of a container specifies the number of pixels between the edges of a container and
the outermost edges of the child elements. You can set this property to a simple number to specify equal
margins, or using a Margins object, which allows you to specify different margins for each edge of the
container.

The following figure shows the results of creating the sample window with row orientation and margins of
5and 15 pixels:

& O O margins een margins
margins=5 (__OK ) margins=15 ( OK ) [ ]

This figure shows the results of creating the sample window with column orientation, a top margin of 0
pixels, a bottom margin of 20 pixels, and left and right margins of 15 pixels:

® O ) margins
margins=15,0,15,20

Spacing between children
The spacing property of a container specifies the number of pixels separating one child element from its

adjacent sibling element.

This figure shows the results of creating the sample window with row orientation, and spacing of 15and 5
pixels, respectively:

een spacing ® O 7 spacing

spacing=15 ( OK ) spacing=5 (  OK )

This figure shows the results of creating the sample window with column orientation, and spacing of 20
pixels:
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86 0spa..
spacing=20

a3

Determining a preferred size

Each element has a preferredsize property, which is initially defined with reasonable default
dimensions for the element. The default value is calculated by ScriptUl, and is based on constant
characteristics of each type of element, and variable characteristics such as the text string to be displayed
in a button or text element.

If an element’s size property is not defined, the layout manager uses the value of preferredsize to
determine the dimensions of each element during the layout process. Generally, you should avoid setting
the preferredsize property explicitly, and let ScriptUl determine the best value based on the state of an
element at layout time. This allows you to set the text properties of your user-interface elements using
localizable strings (see “Localization in ScriptUl objects” on page 103). The width and height of each
element are calculated at layout time based on the chosen language-specific text string, rather than
relying on the script to specify a fixed size for each element.

However, a script can explicitly set the preferredsize property to give hints to the layout manager about
the intended sizes of elements for which a reasonable default size is not easily determined, such as an
IconButton element that has no initial image to measure.

You can set just one of the dimensions using the preferredsize; a value of -1 for either width or height
causes the layout manager to calculate that dimension, while using the supplied value for the other.

You can also set a maximum and/or minimum size value for a control, that limit how it can be resized.
There is a default maximum size that prevents automatic layout from creating elements larger than the
screen.

You can explicitly resize the controls in a window to fit the current text contents, or after the window is
resized by the user, using the resize() method of the layout object.

Creating more complex arrangements

You can easily create more complex arrangements by nesting Group containers within panel containers
and other Group containers.

Many dialogs consist of rows of information to be filled in, where each row has columns of related types of
controls. For instance, an edit field is typically in a row next to a static text label that identifies it, and a
series of such rows are arranged in a column. This example (created using Resource specifications) shows a
simple dialog in which a user can enter information into two EditText fields, each arranged in a row with
its staticText label. To create the layout, a Pane1 with a column orientation contains two Group elements
with row orientation. These groups contain the control rows. A third Group, outside the panel, contains the
row of buttons.

res =
"dialog { \
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info: Panel { orientation: ’‘column’, \

text: 'Personal Info’, \

name: Group { orientation: ’‘row’, \
s: StaticText { text:’Name:’ }, \
e: EditText { characters: 30 } \

oA

addr: Group { orientation: ’‘row’, \
s: StaticText { text:’Street / City:’ }, \
e: EditText { characters: 30 } \

buttons: Group { orientation: ‘row’, \

okBtn: Button { text:’OK’, properties:{name:’ock’} }, \

cancelBtn: Button { text:’Cancel’, properties:{name:’cancel’} } \
A

IRF

win = new Window (res) ;

win.center () ;

win.show () ;

Personal Info

Name:

Street / City:

(‘—ﬁ*—')k Cancel J

In this simplest example, the columns are not vertically aligned. When you are using fixed-width controls
in your rows, a simple way to get an attractive alignment of the staticText labels for your EditText

fields is to align the child rows in the Pane1 to the right of the panel. In the example, add the following to
the panel specification:

info: Panel { orientation: ‘column’, alignChildren:’right’, \

This creates the following result:

Personal Info

Name:

Street [ City:

(—9*'—)( Cancel )

Suppose now that you need two panels, and want each panel to have the same width in the dialog. You
can specify this at the level of the dialog window object, the parent of both panels. Specify
alignChildren='£i11', which makes each child of the dialog match its width to the widest child.

res =
"dialog { alignChildren: ’£i11’, \
info: Panel { orientation: ‘column’, alignChildren:’right’, \
text: 'Personal Info’, \
name: Group { orientation: ’‘row’, \
s: StaticText { text:’Name:’ }, \
e: EditText { characters: 30 } \
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P
oA
workInfo: Panel { orientation: ‘column’, \
text: 'Work Info’, \
name: Group { orientation: ‘row’, \
s: StaticText { text:’Company name:’ }, \
e: EditText { characters: 30 } \
A
b
buttons: Group { orientation: 'row’, alignment: ’‘right’, \
okBtn: Button { text:’OK’, properties:{name:’ok’} }, \
cancelBtn: Button { text:’Cancel’, properties:{name:’cancel’} } \
P
1

win = new Window (res); win.center(); win.show() ;

Personal Info

Name:

Work Info
( Company name:

(—0&—) ( Cancel )

To make the buttons to appear at the right of the dialog, the but tons group overrides the £111 alignment
of its parent (the dialog), and specifies alignment="right'.

Creating dynamic content

Many dialogs need to present different sets of information based on the user selecting some option within
the dialog. You can use the stack orientation to present different views in the same region of a dialog.

A stack orientation of a container places child elements so they are centered in a space which is wide
enough to hold the widest child element, and tall enough to contain the tallest child element. If you
arrange groups or panels in such a stack, you can show and hide them in different combinations to display
a different set of controls in the same space, depending on other choices in the dialog.

For example, this dialog changes dynamically according to the user’s choice in the broppownList.

Personal Info |¢] Work Info |¢]

Name: Company name:

€ ok ) ( cancel ) € ok ) ( cancel )

The following script creates this dialog. It compresses the “Personal Info” and “Work Info” panels from the
previous example into a single panel that has two Groups arranged in a stack. A DropbownList allows the
user to choose which set of information to view. When the user makes a choice in the list, its onchange
function shows one group, and hides the other.
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res =
"dialog { \
whichInfo: DropDownList { alignment:’left’ }, \
allGroups: Panel { orientation:’stack’, \
info: Group { orientation: ‘column’, \
name: Group { orientation: ’‘row’, \
s: StaticText { text:’'Name:’ }, \
e: EditText { characters: 30 } \
A
b
workInfo: Group { orientation: ’‘column’, \
name: Group { orientation: ’‘row’, \
s: StaticText { text:’Company name:’ }, \
e: EditText { characters: 30 } \

oA
buttons: Group { orientation: ‘row’, alignment: ‘right’, \
okBtn: Button { text:’OK’, properties:{name:’ock’} }, \
cancelBtn: Button { text:’Cancel’, properties:{name:’cancel’} } \
A
R
win = new Window (res);
win.whichInfo.onChange = function () {
if (this.selection != null) {
for (var g = 0; g < this.items.length; g++)
this.items[g] .group.visible = false; //hide all other groups
this.selection.group.visible = true;//show this group

}
}

var item = win.whichInfo.add (’item’, ’‘Personal Info’);
item.group = win.allGroups.info;
item = win.whichInfo.add (’item’, ’'Work Info’);

item.group = win.allGroups.workInfo;
win.whichInfo.selection = win.whichInfo.items[0];
win.center() ;

win.show () ;

This script creates a dialog almost identical to the one in the previous example, except that it defines a
layout-manager subclass, and assigns an instance of this class as the 1ayout property for the last cGroup in
the dialog. (The example also demonstrates the technique for defining a reusable class in JavaScript.)

This script-defined layout manager positions elements in its container in a stair-step fashion, so that the
buttons are staggered rather than in a straight line.
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/* Define a custom layout manager that arranges the children
*% of ’'container’ in a stair-step fashion.*/
function StairStepButtonLayout (container) { this.initSelf (container); }
// Define its '‘method’ functions
function SSBL_initSelf (container) { this.container = container; }
function SSBL layout () {
var top = 0, left = 0;
var width;
var vspacing = 10, hspacing = 20;
for (i = 0; 1 < this.container.children.length; i++) {
var child = this.container.children[i];
if (typeof child.layout != "undefined")
// If child is a container, call its layout method
child.layout.layout () ;
child.size = child.preferredSize;
child.location = [left, top];
width = left + child.size.width;
top += child.size.height + vspacing;
left += hspacing;
}
this.container.preferredSize = [width, top - vspacing];
}
// Attach methods to Object’s prototype
StairStepButtonLayout.prototype.initSelf = SSBL initSelf;
StairStepButtonLayout.prototype.layout = SSBL layout;
// Define a string containing the resource specification for the controls
res = "dialog { \
whichInfo: DropDownList { alignment:’left’ }, \
allGroups: Panel { orientation:’stack’, \
info: Group { orientation: ‘column’, \
name: Group { orientation: ‘row’, \
s: StaticText { text:’Name:’ }, \
e: EditText { characters: 30 } \
A
oA
workInfo: Group { orientation: ‘column’, \
name: Group { orientation: ‘row’, \
s: StaticText { text:’Company name:’ }, \
e: EditText { characters: 30 } \

P
buttons: Group { orientation: 'row’, alignment: ’‘right’, \
okBtn: Button { text:’OK’, properties:{name:’ok’} }, \
cancelBtn: Button { text:’Cancel’, properties:{name:’cancel’} } \
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// Create window using resource spec
win = new Window (res) ;
// Create list items, select first one
win.whichInfo.onChange = function () {
if (this.selection != null)
for (var g = 0; g < this.items.length; g++)
this.items[g] .group.visible = false;
this.selection.group.visible = true;

}
}

var item = win.whichInfo.add (’item’, ’'Personal Info’);
item.group = win.allGroups.info;
item = win.whichInfo.add (’item’, ’'Work Info’);

item.group = win.allGroups.workInfo;

win.whichInfo.selection = win.whichInfo.items[0];

// Override the default layout manager for the ’'buttons’ group
// with custom layout manager

win.buttons.layout = new StairStepButtonLayout (win.buttons) ;
win.center () ;

win.show () ;

When a script creates a window object and its elements and shows it the first time, the visible
user-interface-platform window and controls are created. At this point, if no explicit placement of controls
was specified by the script, all the controls are located at [0, 0] within their containers, and have default
dimensions. Before the window is made visible, the layout manager’s 1ayout method is called to assign
locations and sizes for all the elements and their containers.

The default autoLayoutManager’'s 1ayout method performs these steps when invoked during the initial
call to a window object’s show method:

1. Read the bounds property for the managed container; if undefined, proceed with auto layout. If
defined, assume that the script has explicitly placed the elements in this container, and cancel the
layout operation (if both the 1ocation and size property have been set, this is equivalent to setting
the bounds property, and layout does not proceed).

2. Determine the container’s margins and inter-element spacing from its margins and spacing
properties, and the orientation and alignment of its child elements from the container’'s orientation
and alignChildren properties. If any of these properties are undefined, use default settings obtained
from platform and user-interface framework-specific default values.

3. Enumerate the child elements, and for each child:

D> Ifthe child is a container, call its layout manager (that is, execute this entire algorithm again for the
container).

D> Read its alignment property; if defined, override the default alignment established by the parent
container with its alignchildren property.

D> Read its size property: if defined, use it to determine the child’s dimensions. If undefined, read its
preferredSize property to get the child’s dimensions. Ignore the child’s 1ocation property.

All the per-child information is collected for later use.

4. Based on the orientation, calculate the trial location of each child in the row or column, using
inter-element spacing and the container’s margins.
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5. Determine the column, row, or stack dimensions, based on the dimensions of the children.

6. Using the desired alignment for each child element, adjust its trial location relative to the edges of its
container.

7. Set the bounds property for each child element.

8. Setthe container's preferredsize property, based on the margins and dimensions of the row or
column of child elements.

The following restrictions apply to the automatic layout mechanism:

» The default layout manager does not attempt to lay out a container that has a defined bounds
property. The script programmer can override this behavior by defining a custom layout manager for
the container.

» The layout mechanism does not track changes to element sizes after the initial layout has occurred.
The script can initiate another layout by calling the layout manager’s 1ayout method, and can force
the manager to recalculate the sizes of all child containers by passing the optional argument as true.

User interface elements often need a title or label to identify their purpose, with the title placed near the
element it identifies. As shown by examples in “Automatic layout” on page 86, you can use a statictext
element as a title or label, and use the automatic layout mechanism to control the placement of such a title
relative to the element it identifies.

The title-layout mechanism provides a simpler way to accomplish this task for many common cases. It
allows you to define an element's title and its spacial relationship with the graphic representation of the
object it identifies, without the need for additional statictext and container elements. Title layout
operates on an element's optional title and titleLayout properties. It treats this title and the element's
graphic representation as two separate objects whose relative positions are controlled according to layout
rules within a virtual container that encloses both objects. This is similar to the operation of the automatic
layout mechanism, but within a more limited scope.

Title layout is available for these types of Ul elements:

DropDownlList
FlashPlayer

IconButton

Image
TabbedPanel

vV v v v Vv

For most of these element types, the title typically appears outside the element itself, and the virtual
container is an imaginary line surrounding the title and the separate element. For the IconButton, the title
appears inside the bounds of the button, and the virtual container is defined by the outer bounds of the
element. The same principles apply in both cases.
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» Thetitle property is a String that defines a text label for a Ul element. The title can appear to the left or
right of the graphic element, above or below it, or superimposed over the center of the graphic
element; the placement is controlled by the titleLayout property.

» ThetitleLayout property is an Object containing properties that specify:
D> The title's character width;

The title's justification within the character width;

How the title should be truncated if necessary;

The orientation, alignment, and spacing of the title with respect to the object it identifies;

v Vv Vv V

The margins within the virtual container that surrounds the title and its related object.

All titleLayout properties are optional; the element types that use this mechanism have default values
for each property. Complete details are provided in the reference section; see “titleLayout” on page 141.

The following sections provide examples that show how to use title layout to achieve many different
layouts.

Unlike automatic layout, title layout uses the alignment property to specify the orientation of the title and
graphic element, and how the title aligns to the graphic element. This property contains a 2-element array,
where the first element specifies horizontal alignment and the second specifies vertical alignment. The
allowed values for these are the same as those used by automatic layout (see “Aligning children” on

page 88), except that the £111 value is not allowed.

» To achieve a row orientation where the title appears to the left or right of the graphic element, define
horizontal alignment as 1eft or right and vertical alignment as center, top, Or bottom:

button.titleLayout = { alignment: ['right',6 'center'] };

e Te

Row orientation: title aligned right

B Play
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» To achieve a column orientation where the title appears above or below the graphic element, define
vertical alignment as top or bottom, and horizontal alignment as center:

image.titleLayout = { alignment: ['center',6 'bottom'] };

e Te

Column crientation: center / bottom alignment

B

Folder is empty

» Toachieve astack orientation where the title appears superimposed upon the graphic element, define
both vertical and horizontal alignment as center. This orientation is mainly useful with the
iconbutton Or image element types; it does not make sense to superimpose a title over a
dropdownlist, for instance. In this example, the button's title is centered over its iconic image:

button.title = 'Get information';
button.titlelLayout = { alignment: ['center', 'center'] };

Stack orientation: center [ center alignment

Get inf8Bation

» With row orientation, you can control whether the title aligns to the top, center, or bottom of the
graphic element. In this example, the title is placed to the left of the image, aligned at the top edge:

image.titleLayout = { alignment: ['left', 'top'] };

P YoTe

Row orientation: top left alignment

Folder is empty
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» Use spacing to override the default number of pixels separating the title from the graphic element. In
this example, titleLayout is configured to place the title 15 pixels above the panel:

panel.title = 'Image format';
panel.titlelLayout = { alignment: ['center',6 'top'l, spacing: 15 };
' YoTe

Column orientation: title offset by 15 pixels

Image format

JPEG | PNG |

- :
! Progressive?

» To override the automatically calculated title width, define a positive non-zero value for the
characters property. This reserves enough space in the title area to hold the specified number of "X"
characters. This is useful when an element's title can change (for localized values, for instance) and you

want to reserve enough space to fit all the expected values without truncation or affecting the overall
layout.

droplist.titleLayout = { alignment: ['left', 'center'], characters: 20 };

P YoTe

Wider character width: left justified

Image format: [ ?I

» When a characters value specifies a width greater than the default title width, you can set the
justify property to control how the text of the title is justified within the space reserved for it. The
value 1eft places the text at the left end of the space, leaving blank space on the right; right places
the text at the right end of the space, leaving blank space on the left; and center places the text in the
middle of the space, dividing any blank space evenly on both sides of the text.

droplist.titleLayout = { alignment: ['left', 'center'],

characters: 20,
justify: 'right' };

P YoTe

Wider character width: right justified

Image format: | a
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» This example demonstrates using characters and justify to vertically align the colons at the ends
of all the dropdownlist control titles in a group. The same characters value is used for each
element's title, and all are right-justified:

w.dd1l1l = w.add ("dropdownlist { title: 'Image format:' }");

w.ddl2 = w.add ("dropdownlist { title: 'Background color:' }");

w.dd1l3 = w.add("dropdownlist { title: 'Text color:' }");

w.ddll.titleLayout = { alignment: ['left', 'center'], spacing: 3,
characters: 16, justify: 'right' };

w.ddl2.titleLayout = { alignment: ['left', 'center'], spacing: 3,
characters: 16, justify: 'right' };

w.ddl3.titleLayout = { alignment: ['left', 'center'], spacing: 3,
characters: 16, justify: 'right' };

e

Using characters and justify to align titles

Background color: |

Image format: |

Text color: |

+
B
-+

If the space reserved for a title is not wide enough to display its entire text, set the truncate property to
control the appearance of the truncated text. If truncate is middle, characters are removed from the
middle of the text and replaced with an ellipsis (. . .). For the value end, characters are removed from the
end of the text and replaced with an ellipsis. If truncate is none or is not defined, characters are removed
from the end, without any replacement ellipsis character.

This example demonstrates the effect of all three options on the same title string:

.btnl
.btn2
.btn3

£ £ £ £ £ g

o

.btnl.
.btn2.
.btn3.

titleLayout
titleLayout
titleLayout

w.add ("iconbutton { title: 'Start 123456 End', image: 'SystemWarningIcon' }");
w.add ("iconbutton { title: 'Start 123456 End', image: 'SystemWarningIcon' }");
w.add ("iconbutton { title: 'Start 123456 End', image: 'SystemWarningIcon' }");

{ characters: 8, truncate: 'middle' };
{ characters: 8, truncate: 'end' };
{ characters: 8, truncate: 'none' };

Show effect of truncate options

Star... End

Start 12...

Start 123
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The margins property specifies the number of pixels separating each edge of an element from the visible
content within that element. This value overrides the default margin settings (no margins for most
element types, 6 pixels at each edge for iconbutton).

» For iconbutton, the margins value controls the padding between the button's frame and its title and
icon image.

» For other element types, margins controls the padding between the imaginary border surrounding
the union of the bounding boxes of the title and graphic object, which makes the space occupied by
an element larger than its default measurements.

This example demonstrates overriding the default margins for i conbutton and dropdownlist elements.
The lists are enclosed in panels to create artificial borders around them:

w.btnl w.add ("iconbutton { title: 'Default margins', image: 'SystemWarningIcon' }");
w.btn2 = w.add ("iconbutton { title: 'Extra T/B margins',
image: 'SystemWarningIcon' }");

var defaultBtnMargins = w.btn2.titleLayout.margins;
w.btn2.titleLayout = { margins: [defaultBtnMargins[0], 15, defaultBtnMargins[2], 15] };
w.panell = w.add ("panel { margins: 0, ddll: DropDownList

{ title: 'Default margins' } }");
w.panel2 = w.add ("panel { margins: 0, ddl2: DropDownList

{ title: 'Extra L/R margins' } }");
w.panel2.ddl2.titlelayout = { margins: [15, 0, 15, 0] };

8N N

Show effect of changing default margins

Default margins

Extra T/B margins

Default margins | ?I

Extra L/R margins | ?]

For portions of your user interface that are displayed on the screen, you may want to localize the displayed
text. You can localize the display strings in any ScriptUl object simply and efficiently, using the global
localize function. This function takes as its argument a localization object containing the localized
versions of a string.

For complete details of this ExtendScript feature, see “Localizing ExtendScript strings” on page 224.

A localization object is a JavaScript object literal whose property names are locale names, and whose
property values are the localized text strings. The locale name is an identifier as specified in the ISO 3166
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standard. In this example, a btnText object contains localized text strings for several locales. This object
supplies the text for a But ton to be added to a window w:

btnText = { en: "Yes", de: "Ja", fr: "Oui" };
bl = w.add ("button", undefined, localize (btnText)) ;

The 1ocalize function extracts the proper string for the current locale. It matches the current locale and
platform to one of the object’s properties and returns the associated string. On a German system, for
example, the property de provides the string "ga".

When your script uses localization to provide language-appropriate strings for user-interface elements, it
should also take advantage of the Automatic layout feature. The layout manager can determine the best
size for each user-interface element based on its localized text value, automatically adjusting the layout
of your script-defined dialogs to allow for the varying widths of strings for different languages.

The localize function allows you to include variables in the string values. Each variable is replaced with
the result of evaluating an additional argument. For example:

today = {
en: "Today is %1/%2.",
de: "Heute ist der %2.%1."

i
d = new Date() ;
Window.alert (localize (today, d.getMonth()+1, d.getDate())) ;

If you do not need variable replacement, you can use automatic localization. To turn on automatic
localization, set the global value:

$.localization=true

When it is enabled, you can specify a localization object directly as the value of any property that takes a
localizable string, without using the 1ocalize function. For example:

btnText = { en: "Yes", de: "Ja", fr: "Oui" };
bl = w.add ("button", undefined, btnText) ;

The localize function always performs its translation, regardless of the setting of the $.1ocalize
variable. For example:

//Only works if the $.localize=true

bl = w.add ("button", undefined, btnText) ;

//Always works, regardless of $.localize value

bl = w.add ("button", undefined, localize (btnText)) ;

If you need to include variables in the localized strings, use the 1ocalize function.
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ScriptUl is a component that works with the ExtendScript JavaScript interpreter to provide JavaScript
programs with the ability to create and interact with user interface elements. It provides an object model
for windows and user-interface control elements within an application.

This section provides the details of the ScriptUI classes and objects with their properties, methods, and

creation parameters.

ScriptUI class

Common properties

Window class

Window object
Control objects

UlEvent base class

Graphic customization objects

vV v v v v v v Vv

LayoutManager object

The globally available scriptur class provides central information about the ScriptUl module. This object

is not instantiable.

Alignment Object

applicationFonts Object

Collects the enumerated values that can be used in the alignment and
alignChildren properties of controls and containers, and in the alignment
property used to set a control’s titleLayout property. Read only.

Use these constants to set the alignment. For example:

myGroup.alignment = [ScriptUI.Alignment.LEFT,
ScriptUI.Alignment.TOP]

When you query the alignment property, it returns index values that
correspond to the constants as shown. Constant values are:

ScriptUI.Alignment.TOP
ScriptUI.Alignment .BOTTOM
ScriptUI.Alignment.LEFT
ScriptUI.Alignment .RIGHT
ScriptUI.Alignment.FILL
ScriptUI.Alignment .CENTER

Collects the enumerated values that specify the default application fonts.
The available fonts vary according to the application and system
configuration.
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compatability

coreVersion

environment

events

FontStyle

frameworkName

version

Object

String
Object

Object

String

String

String

An object whose properties are the names of compatibility modes
supported by the host application. For example, the presence of
ScriptUI.compatability.sulPanelCoordinates means thatthe
application allows backward compatibility with the coordinate system of
Panel elements in ScriptUl version 1.

The internal core version number of the ScriptUl components. Read only.

A JavaScript object that provides access to attributes of the ScriptUl
environment; contains a Keyboard state object that reports the active
state of the keyboard at any time, independent of the event-handling
framework.

A JavaScript object that contains one function, events.createEvent(),
which allows you to create event objects in order to simulate
user-interaction events.

Collects the enumerated values that can be used as the style argument
to the scriptur.newFont() method. For example:

var font = ScriptUI.newFont ('Helvetica",
ScriptUI.FontStyle.BOLD)

Read only. Values are:

REGULAR
BOLD
ITALIC
BOLDITALIC

The name of the user-interface framework with which this ScriptUI
component is compatible. Read only.

The main version number of the ScriptUl component framework. Read
only.
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events.createEvent ()
ScriptUi.events.createEvent (eventType)

eventType The type of event, one of:

UIEvent
KeyboardEvent
MouseEvent

This function is in the JavaScript object contained in the events property. It returns an event object
of the appropriate type:

» A UlEvent base class encapsulates input event information for an event that propagates
through a container and control hierarchy. This is a base class for the more specialized keyboard
and mouse event types.

» A KeyboardEvent object encapsulates information about keyboard input events.

» A MouseEvent object encapsulates information about mouse events.

This object is passed to a function that you register to respond to events of a certain type that occur
in a window or control. Use windowob7 .addEventListener() or controlobj.addEventListener() to
register a handler function. See “Registering event listeners for windows or controls” on page 82.

getResourceText ()
ScriptUI.getResourceText (text)

text The text to match.

Finds and returns the resource for a given text string from the host application’s resource data. If no
string resource matches the given text, the text itself is returned.

Returns a String.

newFont ()
ScriptUI.newFont ( name, style, size );

name The font or font family name string.
style The font style string or an enumerated value from scriptUI . FontStyle.
size The font size in points, a number.

Creates a new font object for use in text controls and titles.

Returns a ScriptUIFont object.
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newImage ()
ScriptUI.newlImage ( normal, disabled, pressed, rollover );

normal The resource name or path to the image to use for the normal or default state.

disabled  The resource name or path to the image to use for the disabled state, shown when the
control containing the image is disabled (enabled=false).

pressed The resource name or path to the image to use for the pressed state, shown when the
user clicks on the image.

rollover  The resource name or path to the image to use for the rollover state, which is shown
when the cursor moves over the image.

Creates a new image object for use in controls that can display images, loading the associated
images from the specified resources or image files.

Returns a ScriptUllmage object.

This global object is available through the scriptuI.environment property. It defines attributes of the
ScriptUl environment. In the current release, it contains one property:

keyboardstate Object A Keyboard state object that reports the active state of the keyboard at
any time, independent of the event-handling framework.

All types of user-interface elements, including windows, containers, and controls, share many of the same
properties, although some have slightly different meanings for different types of objects. The following
table summarizes which properties are used in which object types.
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active X X X X X X X X X X X X X X
alignChildren X X X X X
alignment X X X X X X X X X X X X X X X X X X X
bounds X X X X X X X X X X X X X X X X X X X
cancelElement X
characters X X X X

checked X
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children X X X X X X X X X X X X X X X X X X X
columns X
defaultElement X
enabled X X X X X X X X X X X X X X X X X X X X
expanded X
frameBounds X
frameLocation X
frameSize X
graphics X X X X X X X X X X X X X X X X X X X
helpTip X X X X X X X X X X X X X X X X X X X
icon X X X
image X X X
index X
items X X X
itemSize X X X
jumpdelta X
justify X X X X X
layout X X X X X
location X X X X X X X X X X X X X X X X X X X
margins X X X X X
maximumSize X X X X X X X X X X X X X X X X X X X
maxvalue X X X
minimumSize X X X X X X X X X X X X X X X X X X X
minvalue X X X
orientation X X X X X
parent X X X X X X X X X X X X X X X X X X X X
preferredsize X X X X X X X X X X X x X X X X X X X

properties X X X X X X X X X X X X X X X X X X X X
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resizeable X
selected X
selection X X X X
shortcutKey X X X X X X X X X X X X X X
size X X X X X X X X X X X X X X X X X X X
spacing X X X X X
stepdelta X
subitems X
text X X X X X X X X X X X X X
textselection X X
title X
titleLayout X X X X X
type X X X X X X X X X X X X X X X X X X X X
value X X X X X X
visible X X X X X X X X X X X X X X X X X X X
window X X X X X X X X X X X X X X X X X X X
windowBounds X X X X X X X X X X X X X X X X X X X

The window class defines these static properties and functions. Window instances created with new
Window () do not have these properties and functions defined.

frameworkName String Deprecated. Use scriptul.frameworkName instead.

version String Deprecated. Use scriptUI.version instead.
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Access these function through the class. For example:

Window.alert (“Notification to user”) ;

alert ()
Window.alert (messagel, title, errorIcon]) ;

message The string for the displayed message.

title Optional. A string to appear as the title of the dialog, if the platform supports a
title. Mac OS does not support titles for alert dialogs. The default title string is
“Script Alert.”

errorIcon Optional. When true, the platform-standard alert icon is replaced by the

platform-standard error icon in the dialog. Default is false.
Displays a platform-standard dialog containing a short message and an OK button.

Returns undefined

confirm()
Window.confirm (messagel,noAsDflt ,title ]);

message The string for the displayed message.

noAsDf1t Optional. When true, the No button is the default choice, selected when the user
types ENTER. Default is false, meaning that Yes is the default choice.

title Optional. A string to appear as the title of the dialog, if the platform supports a
title. Mac OS does not support titles for confirmation dialogs. The default title
string is “Script Alert.”

Displays a platform-standard dialog containing a short message and two buttons labeled Yes and
No.

Returns true if the user clicked Yes, false if the user clicked No.

£ind ()
Window.find (resourceName)
Window.find (type, title)

resourceName The name of a predefined resource available to JavaScript in the current

application.

type Optional. The window type (see “Window object constructor” on page 112) used if
there is more than one window with the same title. Can be nu11 or the empty
string.

title The window title.

Use this method to find an existing window. This includes windows already created by a script, and
windows created by the application (if the application supports this case).

NorTE: Not supported in all ScriptUl implementations.

Returns a window object found or generated from the resource, or nul1 if no such window or
resource exists.
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prompt ()
Window.prompt (message, preset[, title 1);
message The string for the displayed message.
preset The initial value to be displayed in the text edit field.
title Optional. A string to appear as the title of the dialog. In Windows, this appears in

the window’s frame; in Mac OS it appears above the message. The default title
string is “Script Prompt.”

Displays a modal dialog that returns the user’s text input.

Returns the value of the text edit field if the user clicked OK, nul1 if the user clicked Cancel.

The constructor creates and returns a new window object, or nul1 if window creation failed.

new Window (type [, title, bounds, {creation properties}]) ;

type

title
bounds

creation properties

The window type. The value is:

>
>

dialog — Creates a modal dialog.

palette — Creates a modeless dialog, also called a floating palette. (Not
supported by Photoshop CC.)

window — Creates a simple window that can be used as a main window for
an application. (Not supported by Photoshop CC.)

This argument can be a ScriptUI resource specification; in this case, all other
arguments are ignored. See “Resource specifications” on page 78.

Optional. The window title. A localizable string.

Optional. The window’s position and size.

Optional. An object that can contain any of these properties:

>

resizeable — When true, the window can be resized by the user. Default
is false.

sulPanelCoordinates — Photoshop only. When true, the child panels of
this window automatically adjust the positions of their children for
compatability with Photoshop CS (in which the vertical coordinate was
measured from outside the frame). Default is false. Individual panels can
override the parent window’s setting.

closeButton — When true, the title bar includes a button to close the
window, if the platform and window type allow it. When false, it does not.
Default is true. Not used for dialogs.
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maximizeButton — When true, the title bar includes a button to expand
the window to its maximum size (typically, the entire screen), if the
platform and window type allow it. When false, it does not. Default is false
for type palette, true for type window. Not used for dialogs.

minimizeButton — When true, the title bar includes a button to minimize
or iconify the window, if the platform and window type allow it. When
false, it does not. Default is false for type palette, true for type window.
Main windows cannot have a minimize button in Mac OS. Not used for
dialogs.

independent — When true, a window of type window is independent of
other application windows, and can be hidden behind them in Windows.
In Mac OS, has no effect. Default is false.

borderless — When true, the window has no title bar or borders.
Properties that control those features are ignored.

The following element properties apply specifically to window elements:

active

cancelElement

defaultElement

frameBounds

frameLocation

frameSize

Boolean When true, the object is active, false otherwise. Set to true to make a

Object

Object

Bounds

Point

given control or dialog active.
» A modaldialog that is visible is by definition the active dialog.
» An active palette is the front-most window.

» An active control is the one with focus—that is, the one that
accepts keystrokes, or in the case of a Button, be selected when
the user types RETURN or ENTER.

For a window of type dialog, the control to notify when a user types
the Esc key. By default, looks for a but ton whose name or text is
"cancel" (case disregarded).

For a window of type dialog, the control to notify when a user types
the ENTER key. By default, looks for a but ton whose name or text is
"ok" (case disregarded).

A Bounds object for the boundaries of the Window's frame in screen
coordinates. The frame consists of the title bar and borders that
enclose the content region of a window, depending on the
windowing system. Read only.

A Point object for the location of the top left corner of the Window’s
frame. The same as [frameBounds.x, frameBounds.y].Set this
value to move the window frame to the specified location on the
screen. The frameBounds value changes accordingly.

Dimension A Dimension object for the size and location of the Window’s frame

in screen coordinates. Read only.
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maximized
minimized

opacity

shortcutKey

Boolean
Boolean

Number

String

When true, the window is expanded.
When true, the window is minimized or iconified.

The opacity of the window, in the range [0..1]. A value of 1.0 (the
default) makes the window completely opaque, a value of 0 makes it
completely transparent. Intermediate values make it partially
transparent to any degree.

The key sequence that invokes this window’s onShortcutKey callback
(in Windows only).
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The following table shows properties that apply to window objects and container objects (controls of type
panel,tabbedpanel,tab,andggroup)

alignChildren  String, or Array  Tells the layout manager how unlike-sized children of a container
of 2 Strings should be aligned within a column or row. Order of creation
determines which children are at the top of a column or the left of
a row; the earlier a child is created, the closer it is to the top or left
of its column or row.

If defined, alignment for a child element overrides the
alignChildren setting for the parent container.

For a single string value, allowed values depend on the
orientation value.Fororientation=row:

top

bottom

center (default)
£fill

For orientation=column:

left
right
center (default)
fill

For orientation=stack:

top

bottom

left

right

center (default)
fill

For an array value, the first string element defines the horizontal
alignment and the second element defines the vertical
alignment. The horizontal alignment value must be one of left,
right, center or £i11. The vertical alignment value must be one
of top, bottom, center, or £i11.

Values are not case sensitive.
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alignment

bounds

children

graphics

layout

location

String, or Array
of 2 Strings

Bounds

Array of Object

Graphics

LayoutManager

Point

Applies to child elements of a container. If defined, this value
overrides the alignChildren setting for the parent container.

For a single string value, allowed values depend on the
orientation value. Fororientation=row:

top center (default)
bottom fill

For orientation=column:

left center (default)
right fill

For orientation=stack:

top right
bottom center (default)
left £fill

For an array value, the first string element defines the horizontal
alignment and the second element defines the vertical
alignment. The horizontal alignment value must be one of 1eft,
right, center or £i11. The vertical alignment value must be one
of top, bottom, center, Or £i11.

Values are not case sensitive.

A Bounds object for the boundaries of the window’s drawable
area in screen coordinates. Compare frameBounds. Does not
apply to containers of type tab, whose bounds are determined
by the parent tabbedpanel container. Read only.

The collection of user-interface elements that have been added
to this window or container. An array indexed by number or by a
string containing an element’s name. The 1ength property of this
array is the number of child elements for container elements, and
is zero for controls. Read only.

A ScriptUIGraphics object that can be used to customize the
window’s appearance, in response to the onDraw event.

A LayoutManager object for a window or container. The first time
a container object is made visible, ScriptUl invokes this layout
manager by calling its 1ayout function. Default is an instance of
the LayoutManager class that is automatically created when the
container element is created.

A Point object for the location of the top left corner of the
Window's drawable area, or the top left corner of the frame for a
panel. The same as [bounds.x, bounds.y].
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margins Margins A Margins object describing the number of pixels between the
edges of this container and the outermost child elements. You
can specify different margins for each edge of the container. The
default value is based on the type of container, and is chosen to
match the standard Adobe user-interface guidelines.

maximumSize Dimension A Dimension object for the largest rectangle to which the
window can be resized, used in automatic layout and resizing.

minimumSize Dimension A Dimension object for the smallest rectangle to which the
window can be resized, used in automatic layout and resizing.

orientation String How elements are organized within this container. Interpreted by
the layout manager for the container. The default LayoutManager
object accepts the (case-insensitive) values:

row
column
stack

The default orientation depends on the type of container. For
Window and Panel, the default is column, and for Group the
default is row.

The allowed values for the container’s alignchildren and its
children’s alignment properties depend on the orientation.

parent Object The immediate parent object of this element, a window or
container element. The value is nu11 for window objects. Read
only.

preferredsize  Dimension A Dimension object for the preferred size of the window, used in

automatic layout and resizing. To set a specific value for only one
dimension, specify other dimension as -1.

properties Object An object that contains one or more creation properties of the
container (properties used only when the element is created).

selection Tab For a TabbedPanel only, the currently active Tab child. Setting
this property changes the active tab. The value can only be nu11
when the panel has no children; setting it to null is an error.
When the value changes, either by a user selecting a different tab,
or by a script setting the property, the onChange callback for the
panel is called.

size Dimension A Dimension object for the current size and location of a group or
panel element, or of the content area of a window.

spacing Number The number of pixels separating one child element from its
adjacent sibling element. Because each container holds only a
single row or column of children, only a single spacing value is
needed for a container. The default value is based on the type of
container, and is chosen to match standard Adobe user-interface
guidelines.
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text String The title, label, or displayed text. Does not apply to containers of

type group or tabbedpanel. This is a localizable string: see
“Localization in ScriptUl objects” on page 103.

visible Boolean When true, the element is shown, when false it is hidden.

When a container is hidden, its children are also hidden, but they
retain their own visibility values, and are shown or hidden
accordingly when the parent is next shown.

window Window The top-level parent window of this container, a Window object.
windowBounds Bounds A Bounds object for the size and location of this container relative

to its top-level parent window.

These functions are defined for window instances, and as indicated for container objects of type panel and

Group.
add ()
windowOrContainerObj.add (type [, bounds, text, { creation props> } 1);
type The control type. See “Control types and creation parameters” on page 124.
bounds Optional. A bounds specification that describes the size and position of the new
control or container, relative to its parent. See Bounds object for specification
formats.
If supplied, this value creates a new Bounds object which is assigned to the new
object’s bounds property.
text Optional. String. Initial text to be displayed in the control as the title, label, or

creation props

contents, depending on the control type. If supplied, this value is assigned to
the new object’s text property.

Optional. Object. The properties of this object specify creation parameters,
which are specific to each object type. See “Control types and creation
parameters” on page 124.

Creates and returns a new control or container object and adds it to the children of this window or

container.

Returns the new object, or nul1 if unable to create the object.
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addEventListener ()

windowObj.addEventListener (eventName, handler|[, capturePhase]) ;

eventName The event name string. Predefined event names include:
change changing
move moving
resize resizing
show enterKey
focus blur
mousedown mouseup
mousemove mouseover
mouseout

click (detail =1 for single, 2 for double)

handler The function to register for the specified event in this target. This can be the
name of a function defined in the extension, or a locally defined handler

function to be executed when the event occurs. A handler function takes one

argument, the UIEvent base class. See “Registering event listeners for windows

or controls” on page 82.

capturePhase Optional. When true, the handler is called only in the capturing phase of the
event propagation. Default is false, meaning that the handler is called in the
bubbling phase if this object is an ancestor of the target, or in the at-target
phase if this object is itself the target.

Registers an event handler for a particular type of event occurring in this window.

Returns undefined.

center ()
windowObj.center ([window])

window Optional. A Window object.

Centers this window on the screen, or with respect to another specified window.

Returns undefined.

close()
windowObj.close ([result])

result Optional. A number to be returned from the show method that invoked this
window as a modal dialog.

Closes this window. If an onClose callback is defined for the window, calls that function before

closing the window.

Returns undefined.

dispatchEvent ()
windowObj.dispatchEvent (eventObj)

eventObj A UlEvent base class.

Simulates the occurrence of an event in this target. A script can create a UlEvent base class for a
specific event and pass it to this method to start the event propagation for the event.

Returns false if any of the registered listeners that handled the event called the event object’s

preventDefault() method, true otherwise.
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findElement ()
windowOrContainerObj.findElement (name)

name The name of the element, as specified in the name creation property.

Searches for the named element among the children of this window or container, and returns the
object if found.

Returns the control object or null.

hide ()
windowObj.hide ()

Hides this window. When a window is hidden, its children are also hidden, but when it is shown
again, the children retain their own visibility states.

For a modal dialog, closes the dialog and sets its result to 0.

Returns undefined

notify ()
windowObj.notify ([event])
event Optional. The name of the window event handler to call. One of:
onClose onResize
onMove onResizing
onMoving onShow

Sends a notification message, simulating the specified user interaction event. For example, to
simulate a dialog being moved by a user:

myDlg.notify ("onMove")

Returns undefined

remove ()
windowOrContainerObj.remove (index)
windowOrContainerObj.remove (text)
windowOrContainerObj.remove (child)

index The child control to remove, specified by 0-based index, the contained text
text value, or as a control object.
child

Removes the specified child control from this window’s or container’s children array. No error
results if the child does not exist.

Returns undefined.
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removeEventListener ()
windowObj.removeEventListener (eventName, handler[, capturePhasel) ;

eventName The event name string.
handler The function that was registered to handle the event.
capturePhase Optional. Whether the handler was to respond only in the capture phase.

Unregisters an event handler for a particular type of event occurring in this window. All arguments
must be identical to those that were used to register the event handler.

Returns undefined.

show ()
windowOb7j .show ()

Shows this window, container, or control. If an onShow callback is defined for a window, calls that
function before showing the window.

When a window or container is hidden, its children are also hidden, but when it is shown again, the
children retain their own visibility states.

For a modal dialog, opens the dialog and does not return until the dialog is dismissed. If it is
dismissed via the close() method, this method returns any result value passed to that method.
Otherwise, returns 0.

update ()
windowObj.update ()

Allows a script to run a long operation (such as copying a large file) and update Ul elements to show
the status of the operation.

Normally, drawing updates to Ul elements occur during idle periods, when the application is not
doing anything and the OS event queue is being processed, but during a long scripted operation,
the normal event loop is not running. Use this method to perform the necessary synchronous
drawing updates, and also process certain mouse and keyboard events in order to allow a user to
cancel the current operation (by clicking a Cancel button, for instance).

During the update () operation, the application is put into a modal state, so that it does not handle
any events that would activate a different window, or give focus to a control outside the window
being updated. The modal state allows drawing events for controls in other windows to occur (as is
the case during a modal show () operation), so that the script does not prevent the update of other
parts of the application's Ul while in the operation loop.

Itis an error to call the update () method for a window that is not currently visible.
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The following callback functions can be defined to respond to events in windows. To respond to an event,
define a function with the corresponding name in the window instance. These callbacks are not available
for other container types (controls of type panel or group).

Callback Description

onActivate Called when the user make the window active by clicking it or otherwise making it
the keyboard focus.

onClose Called when a request is made to close the window, either by an explicit call to the
close() function or by a user action (clicking the OS-specific close icon in the title
bar).
The function is called before the window actually closes; it can return false to cancel
the close operation.

onDeactivate Called when the user makes a previously active window inactive; for instance by
closing it, or by clicking another window to change the keyboard focus.

onDraw Called when a container or control is about to be drawn. Allows the script to modify
or control the appearance, using the control’s associated ScriptUlGraphics object.
Handler takes one argument, a DrawState object.

onMove Called when the window has been moved.

onMoving Called while a window in being moved, each time the position changes. A handler
can monitor the move operation.

onResize Called when the window has been resized.

onResizing Called while a window is being resized, each time the height or width changes. A
handler can monitor the resize operation.

onshortcutkey  (In Windows only) Called when a shortcut-key sequence is typed that matches the
shortcutKey value for this window.

onShow Called when a request is made to open the window using the show() method, before

the window is made visible, but after automatic layout is complete. A handler can
modify the results of the automatic layout.
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Ul elements that belong to windows can be containers or controls. Containers share some aspects of
top-level windows, and some aspects of controls, and so are described here with controls.

Use the add method to create new containers and controls. The add method is available on window and
container (panel and group) objects. (See also add() for dropdownlist and listbox controls.)

add ()
containerObj. (type [, bounds, text, { creation props> } 1);
type The control type. See “Control types and creation parameters” on page 124.
bounds Optional. A bounds specification that describes the size and position of the new
control or container, relative to its parent. See Bounds object for specification
formats.
If supplied, this value creates a new Bounds object which is assigned to the new
object’s bounds property.
text Optional. String. Initial text to be displayed in the control as the title, label, or

contents, depending on the control type. If supplied, this value is assigned to
the new object’s text property.

creation props Optional. Object. The properties of this object specify creation parameters,
which are specific to each object type. See “Control types and creation
parameters” on page 124.

Creates and returns a new control or container object and adds it to the children of this window or
container.

Returns the new object, or nul1 if unable to create the object.
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The following keywords can be used in string literals as the type specifier for the adda method, available on
Window and container (Panel and Group) objects. The class names can be used in resource specifications
to define controls within a container element (Window, Panel, or Group).

All types of controls, including containers, have an optional creation parameter name that allows you to
give the object a unique name.

Type keyword Class name Description

button Button A pushbutton containing a mouse-sensitive text string. Calls the
onClick callback if the control is clicked or if its notify() method is
called.

To add to a window w:

w.add (“button” [, bounds, text, creation properties}]) ;
bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control. For a modal dialog, the
special name “ok” makes this defaultElement, and the
special name “cancel” makes this the cancelElement of the
parent dialog.

checkbox Checkbox A dual-state control showing a box with a checkmark when value is
true, empty when value is false. Calls the onClick callback if the
control is clicked or if its notify() method is called.

To add to a window w:

w.add (“checkbox” [, bounds, text,
{creation properties}]);

bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.
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Type keyword Class name Description

dropdownlist  DropDownList A drop-down list with zero or more items. Calls the onChange
callback if the item selection is changed by a script or the user, or if
the object’s notify() method is called.

To add to a window w:

w.add ("dropdownlist", bounds [, items,
{creation properties}]);

bounds: The control’s position and size.

items: Optional. Supply this argument or the

creation propertiesargument, not both. An array of strings
for the text of each list item. A List Item object is created for
each item. An item with the text string " - " creates a separator
item.

creation properties: Optional. Supply this argument or the
items argument, not both. This form is most useful for elements
defined using Resource specifications. An object that contains
the following property:

name: A unique name for the control.

items: An array of strings for the text of each list item. A
ListItem object is created for each item. An item with the
text string " - " creates a separator item.

edittext EditText An editable text field that the user can change. Calls the onChange
callback if the text is changed and the user types ENTER or the control
loses focus, or if its notify() method is called. Calls the onChanging
callback when any change is made to the text. The textselection
property contains currently selected text.

To add to a window w:

w.add (“edittext” [, bounds, text,
{creation properties}]);

bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.

readonly: When false (the default), the control accepts text
input. When true, the control does not accept input but only
displays the contents of the text property.

noecho: When false (the default), the control displays input
text. When true, the control does not display input text
(used for password input fields).
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Type keyword Class name

Description

edittext (cont'd)

flashplayer

FlashPlayer

enterKeySignalsonchange: When false (the default), the
control signals an onChange event when the editable text is
changed and the control loses the keyboard focus (that is,
the user tabs to another control, clicks outside the control, or
types ENTER). When true, the control only signals an
onChange event when the editable text is changed and the
user types ENTER; other changes to the keyboard focus do
not signal the event.

borderless: When true, the control is drawn with no
border. Default is false.

multiline: When false (the default), the control accepts a
single line of text. When true, the control accepts multiple
lines, in which case the text wraps within the width of the
control.

scrollable: (For multiline elements only) When true (the
default), the text field has a vertical scrollbar that is enabled
when the element contains more text than fits in the visible
area. When false, no vertical scrollbar appears; if the element
contains more text than fits in the visible area, the arrow
keys can be used to scroll the text up and down.

A control that contains a Flash Player, which can load and play Flash
movies stored in SWF files.

The ScriptUl FlashPlayer element runs the Flash application within an
Adobe application. The Flash application runs ActionScript, a
different implementation of JavaScript from the ExtendScript
version of JavaScript that Adobe applications run.

A control object of this type contains functions that allow your script
to load SWFfiles, control movie playback, and communicate with the
ActionScript environment. See “FlashPlayer control functions” on

page 145.

To add to a window w:

w.add (“flashplayer” [, bounds, movieToLoad,
{creation properties}]) ;

bounds: Optional. The control’s position and size.

movieToLoad: Optional. A path or URL string or File object for
the SWF file to load into the player.

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.
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Type keyword Class name

Description

group

iconbutton

Group

IconButton

A container for other controls. Containers have additional properties
that control the children; see “Container properties” on page 115.
Hiding a group hides all its children. Making it visible makes visible
those children that are not individually hidden.

To add to a window w:
w.add (“group” [, bounds, {creation properties}]);
bounds: Optional. The element’s position and size.

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.

A mouse-sensitive pushbutton containing an icon. Calls the onClick
callback if the control is clicked or if its notify() method is called.

To add to a window w:

w.add (“iconbutton” [, bounds, icon,
{creation properties}]);

bounds: Optional. The control’s position and size.

icon: Optional. The named resource for the icon or family of
icons displayed in the button control, or a pathname or File
object for an image file. Images must be in PNG format.

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

style: A string for the visual style, one of:

button: Has a visible border with a raised or 3D
appearance.

toolbutton: Has a flat appearance, appropriate for
inclusion in a toolbar

toggle: For a but ton-style control, a value of true causes it
to get a button-pressed appearance the first time it is
clicked, and alternate with the unpressed appearance each
time it is clicked. The toggle state is reflected in the control’s
value property.
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Type keyword

Class name

Description

image

item

listbox

Image

Array of
ListItem

ListBox

Displays an icon or image.

To add to a window w:

w.add (“image” [, bounds, icon, {creation_properties}]);
bounds: Optional. The control’s position and size.

icon: Optional. The named resource for the icon or family of
icons displayed in the image control, or a pathname or File
object for an image file. Images must be in PNG format.

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

The choice items in a list box or drop-down list. The objects are
created when items are specified on creation of the parent list
object, or afterward using the list control’s add() method.

[tems in a drop-down list can be of type separator, in which case
they cannot be selected, and are shown as a horizontal line.

Item objects have these properties which are not found in other
controls:

checked
expanded
image
index
selected

A list box with zero or more items. Calls the onChange callback if the
item selection is changed by a script or the user, or if the object’s
notify() method is called. A double click on an item selects that item
and calls the onDoubleClick callback.

To add to a window w:
w.add ("listbox", bounds [, items, {creation_properties}]);
bounds: Optional. The control’s position and size.

items: Optional. An array of strings for the text of each list item.
A ListItem Objectis created for each item. Supply this
argument, or the items property in creation properties, not
both.
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Type keyword Class name Description

listbox (cont'd) creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.

multiselect: When false (the default), only one item can be
selected. When true, multiple items can be selected.

items: An array of strings for the text of each list item. A
Listltem object is created for each item. An item with the
text string - creates a separator item. Supply this
property, or the items argument, not both. This form is most
useful for elements defined using Resource specifications.

numberOfColumns: A number of columns in which to display
the items; default is 1. When there are multiple columns,
each Listltem object represents a single selectable row. Its
text and image values supply the label for the first column,
and the subitems property specifies labels for additional
columns.

showHeaders: True to display column titles.

columnwidths: An array of numbers for the preferred width
in pixels of each column.

columnTitles: A corresponding array of strings for the title
of each column, to be shown if showHeaders is true.

panel Panel A container for other types of controls, with an optional frame.
Containers have additional properties that control the children; see
“Container properties” on page 115. Hiding a panel hides all its
children. Making it visible makes visible those children that are not
individually hidden.

To add to a window w:
w.add (“panel” [, bounds, text, {creation_properties}] ) ;

bounds: Optional. The element’s position and size. A panel
whose width is 0 appears as a vertical line. A panel whose height
is 0 appears as a horizontal line.

text: Optional. The text displayed in the border of the panel.
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Type keyword Class name

Description

panel(confd)

progressbar

Progressbar

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

bordersStyle: A string that specifies the appearance of the
border drawn around the panel. One of black, etched,
gray, raised, sunken. Default is et ched.

sulPanelCoordinates: When true, this panel automatically
adjusts the positions of its children for compatability with
Photoshop CS. Default is false, meaning that the panel does
not adjust the positions of its children, even if the parent
window has automatic adjustment enabled.

A horizontal rectangle that shows progress of an operation. All
progressbar controls have a horizontal orientation. The value
property contains the current position of the progress indicator; the
defaultis 0. There is a minvalue property, but it is always 0; attempts
to set it to a different value are silently ignored.

To add to a window w:

w.add (“progressbar” [, bounds, value, minvalue,
maxvalue, creation_properties}] ) ;

bounds: Optional. The control’s position and size.

value: Optional. The initial position of the progress indicator.
Default is 0.

minvalue:Optional. The minimum value that the value
property can be set to. Default is 0. Together with maxvalue,
defines the scrolling range.

maxvalue:Optional. The maximum value that the value
property can be set to. Default is 100. Together with minvalue,
defines the scrolling range.

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.
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Type keyword Class name

Description

radiobutton

scrollbar

RadioButton

Scrollbar

A dual-state control, grouped with other radiobuttons, of which only
one can be in the selected state. Shows the selected state when
value is true, empty when value is false. Calls the onClick callback if
the control is clicked or if its notify() method is called.

All radiobuttons in a group must be created sequentially, with no
intervening creation of other element types. Only one radiobutton
in a group can be set at a time; setting a different radiobutton
unsets the original one.

To add to a window w:

w.add (“radiobutton” [, bounds, text,
{creation properties}]) ;

bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

A scrollbar with a draggable scroll indicator and stepper buttons to
move the indicator. The scrollbar control has a horizontal
orientation if the width is greater than the height at creation time,
or vertical if its height is greater than its width.

Calls the onChange callback after the position of the indicator is
changed or if its notify() method is called. Calls the onChanging
callback repeatedly while the user is moving the indicator.

» The value property contains the current position of the
scrollbar’s indicator within the scrolling area, within the range of
minvalue and maxvalue.

» The stepdelta property determines the scrolling unit for the up
or down arrow; default is 1.

» The jumpdelta property determines the scrolling unit for a
jump (as when the bar is clicked outside the indicator or arrows);
default is 20% of the range between minvalue and maxvalue.
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scrollbar (cont'd) To add to a window w:

w.add (“scrollbar” [, bounds, value, minvalue, maxvalue,
{creation properties}]) ;

bounds: Optional. The control’s position and size.

value: Optional. The initial position of the scroll indicator.
Default is 0.

minvalue:Optional. The minimum value that the value
property can be set to. Default is 0. Together with maxvalue,
defines the scrolling range.

maxvalue:Optional. The maximum value that the value
property can be set to. Default is 100. Together with minvalue,
defines the scrolling range.

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

slider Slider A slider with a moveable position indicator. All s1ider controls have
a horizontal orientation. Calls the onChange callback after the
position of the indicator is changed or if its notify() method is called.
Calls the onChanging callback repeatedly while the user is moving
the indicator.

The value property contains the current position of the indicator
within the range of minvalue and maxvalue.

To add to a window w:

w.add (“slider” [, bounds, value, minvalue, maxvalue,
{creation properties}]) ;

bounds: Optional. The control’s position and size.
value: Optional. The initial position of the indicator. Default is 0.

minvalue:Optional. The minimum value that the value
property can be set to. Default is 0. Together with maxvalue,
defines the range.

maxvalue:Optional. The maximum value that the value
property can be set to. Default is 100. Together with minvalue,
defines the range

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.
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statictext StaticText A text field that the user cannot change.
To add to a window w:

w.add (“statictext” [, bounds, text,
{creation properties}l) ;

bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.

multiline: When false (the default), the control displays a
single line of text. When true, the control displays multiple
lines, in which case the text wraps within the width of the
control.

scrolling: When false (the default), the displayed text
cannot be scrolled. When true, the displayed text can be
vertically scrolled using scrollbars; this case implies
multiline is true.

truncate: If middle or end, defines where to remove
characters from the text and replace them with an ellipsis if
the specified title does not fit within the space reserved for
it. If none, and the text does not fit, characters are removed
from the end, without any replacement ellipsis character.

tab Tab A container for other types of controls. Differs from a panel element
in that is must be a direct child of a TabbedPanel element, the title is
shown in the selection tab, and it does not have a script-definable
border. The currently active tab is the value of the parent’s
selection property.

Containers have additional properties that control the children; see
“Container properties” on page 115. Hiding a panel hides all its
children. Making it visible makes visible those children that are not
individually hidden.

To add a tab to a tabbed panel t in window w:

w.t.add ("tab" [, bounds, text,
{creation properties}]) ;

bounds: Not used, pass undefined. The size and position is
determined by the parent.

text: Optional. The text displayed in the tab.
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tab (cont'd) creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

tabbedpanel TabbedPanel A container for selectable Tab containers. Differs from a panel
element in that it can contain only Tab elements as direct children.

Containers have additional properties that control the children; see
“Container properties” on page 115. Hiding a panel hides all its
children. Making it visible makes visible those children that are not
individually hidden.

The selected tab child is the value of the parent’s selection
property. One and only one of the tab children must be selected;
selecting one deselects the others. When the value of the selection
property changes, either by a user selecting a different tab, or by a
script setting the property, the tabbedpanel receives an onChange
notification.

To add to a window w:

w.add ("tabbedpanel" [, bounds, text,
{creation properties}]) ;

bounds: Optional. The element’s position and size. This
determines the sizes and positions of the tab children.

text: Ignored.

creation properties:Optional. An object that contains the
following property:

name: A unique name for the control.

treeview TreeView A hierarchical list whose items can contain child items. ltems at any
level of the tree can be individually selected. Calls the onChange
callback if the item selection is changed by a script or the user, or if
the object’s notify() method is called.

To add to a window w:

w.add (“treeview” [, bounds, items,
{creation properties}])

bounds: Optional. The control’s position and size.

items: Optional. An array of strings for the text of each top-level
listitem. A ListItem object is created for each item. An item
with the type node can contain child items. Supply this
argument, or the items property in creation properties, not
both.
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treeview (cont’'d)

creation properties:Optional. An object that contains any of
the following properties:

name: A unique name for the control.

items: An array of strings for the text of each top-level list
item. A ListItem object is created for each item. An item
with the type node can contain child items. Supply this
property, or the items argument, not both. This form is most
useful for elements defined using Resource specifications.

The following table shows the properties of ScriptUl control elements. Some values apply only to controls
of particular types, as indicated. See Container properties for properties that apply to container elements
(controls of type panel, tabbedpanel, tab, and group).

active Boolean

alignment String or
Array of 2
Strings

When true, the object is active, false otherwise. Set to true to make a
given control or dialog active.

» A modal dialog that is visible is by definition the active dialog.
» An active palette is the front-most window.

» An active control is the one with focus—that is, the one that
accepts keystrokes, or in the case of a Button, be selected when
the user types ENTER in Windows, or presses the spacebar in Mac
Os.

Applies to child elements of a container. If defined, this value
overrides the alignchildren setting for the parent container.

For a single string value, allowed values depend on the orientation
value in the parent container. For orientation=row:

top center (default)
bottom £fi11

For orientation=column:

left center (default)
right £ill

For orientation=stack:

top right
bottom center (default)
left £i1ll
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alignment (cont’d)

bounds

characters

checked

columns

enabled

expanded

graphics

helpTip

icon

Bounds

Number

Boolean

Object

Boolean

Boolean

Object

String

String or
File

For an array value, the first string element defines the horizontal
alignment and the second element defines the vertical alignment.
The horizontal alignment value must be one of 1eft, right, center
or £i11. The vertical alignment value must be one of top, bottom,
center,Or £ill.

Values are not case sensitive.

A Bounds object describing the boundaries of the element, in screen
coordinates for window elements, and parent-relative coordinates for
child elements (compare windowBounds). For windows, the bounds
refer only to the window’s content region.

Setting an element’s size or location changes its bounds property,
and vice-versa.

Used by the LayoutManager object to determine the default
preferredSize for a StaticText or EditText control. The control will be
made wide enough to display the given number of 'X' characters in
the font used by the control. Setting this property is the best way to
reserve space in a control for a maximum number of characters to
display.

For Listltem objects only. When true, the item is marked with the
platform-appropriate checkmark. When false, no checkmark is drawn,
but space is reserved for it in the left margin, so that the item lines up
with other checkable items. When undefined, no space is reserved
for a checkmark.

For ListBox objects only. A JavaScript object with two read-only
properties whose values are set by the creation parameters:

titles — Anarray of column title strings, whose length matches
the number of columns specified at creation.

preferredWidths — An array of column widths, whose length
matches the number of columns specified at creation.

When true, the control is enabled, meaning that it accepts input.
When false, control elements do not accept input, and all types of
elements have a dimmed appearance. A disabled Listltem is not
selectable in a ListBox, DropDownList or TreeView list.

For Listltem objects of type node in TreeView list controls. When true,
the item is in the expanded state and its children are shown, when
false, it is collapsed and children are hidden.

A ScriptUIGraphics object that can be used to customize the control’s
appearance, in response to the onDraw event.

A brief help message (also called a tool tip) that is displayed in a small
floating window when the mouse cursor hovers over a user-interface
control element. Set to an empty string or null to remove help text.

Deprecated. Use image instead.
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image

indent

index

items

itemSize

jumpdelta

justify

Object

Number

Number

Array of
Object

Dimension

Number

String

A ScriptUllmage object, or the name of an icon resource, or the
pathname or File object for a file that contains a platform-specific
image in PNG or JPEG format, or for a shortcut or alias to such a file.

» Foran lconButton, the icon appears as the content of the button.

» Foranlmage, the image is the entire content of the image
element.

P For a Listltem, the image is displayed to the left of the text.

If the parent is a multi-column ListBox, this is the display image
for the label in the first column, and labels for further columns are
specified in the subitems array. See “Creating multi-column lists”

on page 73.

A number of pixels by which to indent the element during automatic
layout. Applies for column orientation and 1eft alignment, or row
orientation and top alignment.

For Listltem objects only. The index of this item in the items
collection of its parent list control. Read only.

For a list object (ListBox, DropDownList or TreeView list), a collection
of Listltem objects for the items in the list. Access by 0-based index. To
obtain the number of items in the list, use items.length. Read only.

For a list object (ListBox, DropDownlList or TreeView list), a Dimension
object describing the widt